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Chapter 1: Overview

Over the last four decades, the biggest challenge of IT departments in many organizations was
moving to a paperless work environment. Seemingly, there was tremendous success in this regard.
Today, most transactions in the business world are performed electronically:

¢ Documents are written using word processing programs.

¢ Messages are sent via email.

+ Inventories and purchases are tracked using Enterprise Resource Planning (ERP) systems.
¢ Medical information is stored in Electronic Medical Record (EMR) systems.

Although these transactions are performed in a paperless environment, organizations have still not
managed to find an easy way to get rid of the paper used for data authentication (signing the
authenticity of the data). Today, although organizations have invested large amounts of funds and
other resources in creating paperless environments, their workers are still printing every transaction,
signing it, and saving the printed copy. These organizations require a digital method for data
authentication.

By moving to a viable electronic data authentication system, organizations can reduce their printing,
archiving, shipping, and handling costs. In addition, better and more competitive customer service can
often be provided.

Requirements for Data Authentication Systems
A viable data authentication system must meet the following specifications:

+ Security — The system must ensure that no one other than the data creator can tamper with or
change the data in any way.

¢ Third-party validation — The system must enable any third party to validate the authenticity of
the data. If a dispute arises between the parties (the data creator and recipient), any third party
must be able to validate the data authenticity in order to settle the dispute.

+ System independence — Data authentication must be independent of the system that created
the data. Users must be able to validate the authenticity of the data using a known standard
that is independent of any specific system.

+ Validation over time — Users must be able to validate data authenticity at any point in time.
Authenticity cannot expire at any point.

Currently, the only data authentication method known to support all of these requirements is the
Public Key Infrastructure (PKI) method of authenticating data, simply called “digital signatures”.

Introduction to DocuSign Signature Appliance (DocuSign SA)

DocuSign SA is a PKl-based, off-the-shelf digital-signature solution that can be integrated with a wide
range of applications. In this way, DocuSign SA enables organizations to embed digital signatures in

various documents, forms, and transactions. DocuSign SA is a turnkey, hardware-based solution that
is easily and quickly deployed in the network and provides cost-effective digital-signature capabilities

for the organization.
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DocuSign SA includes all the components needed for PKI-based digital-signature deployment. You do
not need to install any other device or integrate any other component for the system to work.

Environments Supported by DocuSign SA

DocusSign SA integrates with leading user management systems, including Microsoft Active Directory
and a variety of LDAP (Lightweight Directory Access Protocol) based directories, such as IBM Tivoli.
This integration ensures no overhead in managing the digital-signature system and signature
credentials (i.e., the private keys that are needed in a PKI environment), solving one of the main
problems of legacy digital-signature systems. System managers, network managers, and end-users
can continue to use the IT infrastructure in the same manner as before DocuSign SA was installed.

DocuSign SA stores the signature credentials in a secure server, ensuring that the signer has
exclusive access to his or her signature credentials, while still maintaining a centrally managed
solution. This is necessary in order to fulfill the security requirement of the data authentication system.

Applications that Work with DocuSign SA

An increasing number of applications can work with DocuSign SA as their digital-signature layer
without needing any further integration, including:

Microsoft Office 2010/2013/2016 (Word, Excel, and PowerPoint)
Microsoft InfoPath 2010/2013

Adobe Acrobat

Microsoft SharePoint 2010/2013

XML

TIFF files

Word Perfect

Microsoft Outlook and Outlook Express

Adobe Server forms (for signing web forms)

AutoCAD

Lotus Notes

Microsoft BizTalk

FileNet eForms

Verity Liquid Office

ERP systems (e.g., SAP)

OpenText

Oracle

*

Crystal Reports
Web applications

+ Any application that has a print option can use DocuSign SA to generate a PDF file and sign it.
For information on using DocuSign SA with other applications, contact DocuSign technical support.
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DocuSign SA Components

DocusSign SA includes the following components:

*

DocuSign Signature Appliance — The DocuSign Signature Appliance hardware and
software, connected to the organization’s network. For more information, refer to

Chapter 3: Installing DocuSign SA.

The DocuSign Signature Appliance can be interfaced either through installed DocuSign SA
client software or through a Web Services interface that can be based on either a SOAP or
RESTful API.

Client — The DocuSign SA Client software, installed on the users’ computers. For more
information, refer to Chapter 4: Deploying the DocuSign SA Client.

Administrator — The DocuSign SA Administrative software that includes the DocuSign SA
Microsoft Management Console (MMC) snap-in, installed on the administrative computer. For
more information, refer to Chapter 5: Managing the DocuSign Signature Appliance.

DocuSign SA Connector for SharePoint — This connector enables adding digital signature
functionality to documents managed by Microsoft SharePoint, or using digital signatures within
any workflow procedure that is based on Microsoft SharePoint.

DocuSign SA Web App — This application is deployed in the Microsoft Web Server of the
organization and enables users to sign documents without installing any client component.
DocuSign SA Web App can use the local DocuSign Signature Appliance for performing digital
sighature operations.

Applications can interact with the DocuSign SA Web App and add a digital signature to
documents using a web based interface.

DocuSign SA Mobile App — This mobile application, which can be installed on Android-based
devices or Apple iOS devices, enable users to sign documents using their mobile devices.

The mobile devices interface directly with the DocuSign SA Appliance via a DocuSign SA
RESTful interface.

The DocuSign SA Mobile App can interface with either the organizational DocuSign SA
Appliance, or DocuSign SA’s Trial system.

DocuSign SA Signhature APIs — Developers can use local and network APls to integrate their
applications with DocuSign SA appliances.

DocuSign SA Guides

DocuSign SA documentation includes the following guides:

*

DocusSign Signature Appliance Administrator Guide — Provides all the information necessary
for an administrator to install and manage the DocuSign Signature Appliance in the various
environments in which DocuSign SA can operate.

DocuSign Signature Appliance User Guide — Provides all the information necessary for an end
user to use DocuSign SA. Includes information about special add-ins for various applications
such as Microsoft Office.

DocuSign Signature Appliance Connector for SharePoint User Guide — Provides all the
information necessary for implementing and using the DocuSign SA Connector for SharePoint.

DocuSign Signature Appliance Web App User Guide — Provides all the information necessary
for deploying DocuSign SA Web App in the organization’s environment.
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+ DocuSign Signature Appliance Signature APIs Developer’s Guide — Provides all the
information necessary for a developer to integrate their application with DocuSign SA.

¢ DocuSign Signature Appliance Mobile App Deployment Guide — Provides all the information
necessary for deploying the DocuSign SA Mobile App.

DocuSign Signhature Appliance Hardware Models

There are several available hardware models of the DocuSign Signature Appliance. All the models
are easy-to-deploy and easy-to-use digital-signature appliances that integrate with leading
applications. They enable organizations to embed digital sighatures that can include a graphical
(handwritten) signature. The models differ in functionality, as follows:

¢ DocuSign SA Enterprise Model — This is the most commonly used DocuSign Signature
Appliance. The hardware is based on a rack-mountable 1U box packaged in a standard
commercial casing.

+ DocusSign SA FIPS Model — This 3U rack-mountable box is based on a sealed, tamper-
response casing. The hardware box is FIPS 140-2 level 3 certified.
This model is also used for deploying DocuSign SA in Common Criteria EAL4+ deployments.
Starting from DocuSign SA version 8, a hew DocuSign SA version 8 hardware model is
available. The new hardware version has some functionality changes.

Note: Throughout this manual, the term “DocuSign SA” refers to all hardware models (Enterprise
and FIPS) and hardware versions, unless stated otherwise.

End User Platforms
DocuSign SA supports various end-user platforms for signing documents or data.

+ Desktop applications — Desktop applications interact with the DocuSign Signature Appliance
through the installation of the DocuSign SA Client. For example, end users can sign using
DocuSign SA Prepare & Sign, a desktop application that enables users to sign PDF files.
¢ Web applications — Web applications do not require the end user to install any software;
instead, the end user signs documents and data through a web portal or web application.
DocuSign SA offers:
¢ Microsoft SharePoint integrated with DocuSign SA Connector for SharePoint, enabling the
end user to sign documents or data stored inside SharePoint.

¢ The DocuSign SA Web App which can be installed in the organizational portal. The end
user can view the document via the web interface and visibly sign the document as part of
the web interface.

¢ Mobile Applications — The DocuSign SA Mobile App enables end users to sign documents
using their mobile devices. The Mobile App can be installed either on Android devices or iOS
devices.

The DocuSign SA Mobile App currently supports signing of PDF files: the PDF file is loaded
into the application, and the user can view the entire document and sign it.
Intended Audience

This guide is intended for developers wishing to integrate digital signatures into their system.
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Chapter 2: DocuSign SA Architecture and Data Flow

DocuSign SA is a hardware appliance that is installed on the network. The appliance includes all
the necessary components for PKl-based digital signatures. DocuSign SA integrates with the
organization’s user management system to eliminate overhead associated with managing users
in a digital-signature system.

To prevent a malicious user from signing with the credentials of a user whose desktop was left
running, user authentication is performed by either the signing application or the desktop
operating system. Once a user is authenticated, DocuSign SA signs all of the user’s signing
requests using the user’s signing credentials.

Figure 1 illustrates the DocuSign SA architecture.

o

User
\9‘* Directory

O
o

DocuSign Signature Appliance

Administrator

Figure 1 DocuSign SA Architecture

Enrollment Using a Standard User Management Application

With DocusSign SA, enrollment in the digital-signature system (i.e., creating the signature
credentials) is performed automatically when a new user joins the system, using one of the
supported user management systems.
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A user’s signature credentials are renewed automatically if the user is part of the system at the
yearly renewal time. Once a user is removed from the users list (for example, upon leaving the
organization), the user’s signature credentials are revoked and the user can no longer perform a
digital signature operation.

This enables DocuSign SA to eliminate the costs associated with managing users in two systems,
both in the regular user management system and in the digital-signature system.

Central Storage of Signing Keys

In traditional PKI systems, users can choose to store their signing keys in personal software or
hardware tokens. This creates many management problems and significantly increases the
system’s Total Cost of Ownership (TCO). In DocuSign SA, the signature credentials are stored in
a central, secure repository.

The following are several advantages of this scheme:
+ Users have access to their signature credentials from any computer they are working with,
without having to import or export signature credentials.

+ There is no need for distributing signature credentials since all credentials are centrally
managed.

There is no need for issuing temporary credentials or handling forgotten tokens.
Signature credentials cannot be lost or stolen.

With DocuSign SA’s central, secure repository, the security level is not affected. The repository is
like a huge collection of network-attached virtual SmartCards that combine with the organization’s
user management and authentication system.

User Authentication

In the DocuSign SA environment, user authentication can be performed using the same
authentication method as was used by the organization prior to the installation of the DocuSign
Signature Appliance. If the organization has chosen to use a certain authentication method, such
as a user password, this method will also be used when performing digital signature operations.

Once a user is authenticated, the following data flow illustrates how documents are digitally
signed:

1. In a paperless environment, a user requires a digital signature.

2. The user’s application sends a request to DocuSign SA with the user’s credentials (in the
case of Microsoft Active Directory, credentials are sent automatically).

3. DocuSign SA finds the correct signing key for the user and signs the document with this
key.

4. DocuSign SA returns the signature to the requesting application.

Extending User Authentication

You can configure DocuSign SA to prompt the end user for credentials upon every digital
signature attempt. This functionality provides a solution for organizations that would like to
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enhance the security of the digital signature operation, beyond using a regular user ID and
password. If authentication is successful, DocuSign SA allows accessing the user’s key and
performing the digital signature operation.

The following mechanisms can be used as part of extended user authentication:

¢ One Time Password (OTP) — The user uses an OTP mechanism such as a Yubiko token.
In this mechanism the password is based either on a password that is changed every
several seconds or on a button that is pressed by the end user.
In these types of deployments, a dedicated Radius Server that is deployed in the
organizational network is used for validating the OTP entered by the signing user.
This mode is mandatory when DocuSign SA is deployed in Common Criteria EAL4+
certified environments as a Qualified Signature Creation Device.
It is important to note that OTP devices or OTP related information should be delivered in
a secure manner to end users.

¢ SmartCard — The user uses a SmartCard for authentication.
+ Biometric Device — The user uses a biometric device for authentication.

Turnkey Solution

DocuSign SA provides a complete and integrated digital-signature system. DocuSign SA
integrates the different components required by a digital-signature system along with a graphical
signature capture mechanism. Since DocuSign SA uses the organization’s existing user management
system, no extra overhead is needed to manage the users in the digital-signature system. In addition,
DocuSign SA easily integrates with many of the leading applications that are digital-signature
enabled, such as Microsoft Word and Adobe Acrobat, without requiring any additional
development.

Directory Independent Environment

DocuSign SA can also be used by organizations that maintain their own proprietary user-
management system.

When DocuSign SA is installed in a Directory Independent environment, the organization’s
administrator can either use DocuSign SA’s users management utility or an application developed
by the organization to create DocuSign SA users and consequently generate keys and certificates
for the new DocuSign SA users.

These DocuSign SA users are just like DocuSign SA users in a Microsoft Active Directory
environment or LDAP environment, and they can use digital signature enabled applications such
as Microsoft Word and Adobe Acrobat to perform digital signature operations.

A Directory Independent environment can also be used by organizations that do not have a user
directory that is supported by DocuSign SA (currently, Microsoft Active Directory or LDAP-based
directory). DocuSign SA enables these organizations to manage the DocuSign SA users through
GUI-based user management utilities.

Using DocuSign SA’s Internal CA

DocuSign SA can be installed with an internal CA. The internal CA is initiated during installation
and a new CA ROOQT key is generated. For every new signer, DocuSign SA generates a new key
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and the internal CA generates a certificate for the key. When the signer’s account is deleted, the
signature key is deleted and the user’s certificate is revoked. In addition, if certain user attributes
(such as user name or email address) are changed, a new certificate is automatically issued for
the user.

The user’s certificate is valid for a year and includes basic attributes necessary for performing a
digital signature operation. This certificate will be automatically renewed close to its expiration
date.

If a CA system is already installed within the enterprise, it is possible to have the DocuSign SA’s
internal CA certificate certified by the organization’s CA, thus DocuSign SA acts as a subordinate
CA.

Using DocuSign SA in Manual External CA Mode

DocuSign SA can be installed in a manual external CA mode, in which each end user is allocated
an empty account, and must manually enroll for a certificate from an external CA. Certificate
enrollment for each user is performed using an external certificate enroliment or RA application
software. This application software uses standard Cryptographic APIs to access DocuSign SA,
and is not part of the DocuSign SA solution.

When DocusSign SA is installed in manual external CA mode, DocuSign SA does not install its
internal CA, so users are not automatically provided with a certificate. During the enroliment:

+ The enroliment application software requests that the DocuSign Signature Appliance
generate a new signature key for the specific user. The key is generated within the
DocuSign Signature Appliance and under the specific user account in a non-extractable
manner.

+ A certificate request is sent to the external CA.

The external CA issues an X-509 certificate and sends it back to the enrollment
application software.

+ The enroliment application software uploads the certificate to the user's DocuSign SA
account.

The user is now ready to sign with the newly-enrolled certificate.

Several signature keys and certificates can be created and stored for any given user, depending
on the organization’s needs.

The main drawback of this mode of work is that it requires manual enrollment for each user.
Manual enrollment requires user intervention, as well as substantial management time and effort.
Manual enroliment also requires additional efforts spent on certificate renewal and certificate
revocation. However, there are cases where you must employ manual enrollment. These include:

+ Cases where it is required that the certificate be provided by a qualified CA of a certain
country or the EU.

+ Cases where the certificate must have specific or specialized attributes not provided by
the built-in DocuSign SA CA.

+ Cases where the certificate must be provided by an external CA that is not currently
supported by DocuSign SA’s automatic external CA. In this case, the verifying party’s PC
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is already installed with the ROOT certificate, so the verifying party does not have to
manually install a ROOT certificate. This makes documentation validation easier.

Using DocuSign SA in Automatic External CA Mode

An alternative external certification mode is available that addresses the deficiencies of the
manual external certificate enrollment process described above.

In Automatic external certification mode, the DocuSign Signature Appliance automatically
interfaces with the external CA during the process of generating a single signature key and
certificate for each user. The user’s certificate is automatically renewed close to its expiration. In
addition, if the user account is revoked, the user’s certificate is also automatically revoked.

All communication between the DocuSign Signature Appliance and the external CA is secured
based on the HTTPS protocol. Note that using this mode requires an outbound network
connection from the DocuSign Signature Appliance to the Internet.

The Comodo certificate authority or Symantec certificate authority can be used for this purpose.
The certificate authority that will serve as the Automatic External CA is selected during the
DocusSign Signature Appliance installation process.

The Symantec certificate authority interface is available in DocuSign Signature Appliance version
8.1 and starting from DocuSign Signature Appliance version 8.5.
Appliance version 8.1 can be used only with DocuSign SA FIPS hardware version 8.0.

Communication with the external CA is based on the TLS Protocol:

¢ If DocuSign SA Hardware version 7.0 is used, then TLS v1.0 is used.
+ If DocuSign SA Hardware version 8.0 is used, then TLS v1.0 or v1.1 or v1.2 is used.

Using DocuSign SA in Common Criteria EAL4+ Deployments

The DocuSign SA FIPS appliance can be deployed in a Common Criteria EAL4+ mode.

In this type of deployment, additional security measures should be carried out in the environment
of the DocuSign Signature Appliance to ensure the Appliance and its environment are protected
from both physical and logical threats.

In Common Criteria EAL4+ deployments DocuSign SA is installed in Directory Independent mode.
This means that the DocuSign Signature Appliance is not synchronized with any external users
directory.

In the future DocuSign SA version 8.2, it will be possible to install DocuSign SA in either of the
following modes:
¢ Common Criteria mode as a Signature Creation Device — In this mode, the end user is

authenticated based on two factor authentication (i.e., providing a Static Password and an
OTP).

¢ Common Criteria mode as a Seal Creation Device — In this mode, the end user is
authenticated based on one factor authentication (i.e., providing a Static Password).
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Extended Authentication using an External Radius Server

In a Common Criteria EAL4+ deployment when DocusSign SA is deployed as a Signature Creation
Device, all digital signature operations require extended authentication, as described in Extending
User Authentication.

Specifically, the user is requested to enter a fixed password as well as a one-time-password
(OTP) using a personal OTP device provided by the organization. The fixed password and OTP
are validated upon any digital signature operation request and only when the validation is
successful does the DocuSign Signature Appliance continue with the digital signature operation.

As part of DocuSign SA deployment in Common Criteria EAL4+ mode, the actual OTP validation
is performed in the DocusSign Signature Appliance. Special software must be integrated with the
deployed Radius Server software to enable OTP validation by the DocuSign Signature Appliance
firmware.

Any information required for the purpose of OTP validation is sent securely (via SSL/TLS) to the
DocusSign Signature Appliance.

For more information on how to integrate the functionality into the Radius Server, contact
DocuSign.

The Radius Server should be installed and configured so that DocuSign SA will interface the
Radius Server using a Radius Protocol, and the Radius Server will access the DocuSign
Signature Appliance using the DocuSign SA secured protocol.

Always make sure that:

+ Only a dedicated administrator of the organization performs the following:

+ |Installs the Radius software and the component that accesses the DocuSign Signature
Appliance.

+ Performs any technical configuration of the Radius software.

+ Installs and maintains any additional software in the Radius Server.
¢ The Radius Server is fully observed and can be accessed only by authorized personnel.
¢ The Radius Server limits network access to its resources.

OTP Management in the Radius Server

The Radius Server manages the following information, which must be kept securely by the Radius
Server and protected with data integrity mechanisms:

+ Information related to every OTP device used by end users. This information is mandatory
for proper validation of the OTP, which is performed by the DocuSign Signature Appliance.
+ Information that binds actual users with their specific OTP device, when applicable.
The following guidelines should be strictly followed. Any attempt to modify the guidelines may
jeopardize the security of the DocuSign SA system:
¢ Only an authorized and dedicated administrator can manage users, OTP devices, and
OTP device information in the Radius Server. The administrator’s responsibilities include:
¢ Adding, updating and deleting users in the Radius Server.
¢ Uploading information for batches of OTP devices, when applicable.
¢ Uploading OTP device information.
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¢ Binding an OTP device or OTO device information to a user.

¢ The authorized and dedicated administrator assigns OTP devices to end users via the
Radius Server, with the following restrictions:

¢ If OTP devices are distributed to end users, they should be distributed in a secure
manner.

¢ If OTP device information is distributed to end users, it should be distributed in a
secure manner.

¢ If a useris revoked in the DocuSign Signature Appliance, the user’'s OTP device
should be revoked too and should not be allocated to a different user.

¢ A specific OTP device or specific OTP device information may not be bound to several
users.

¢ A user's OTP device may not be replaced once the user account is activated. To
replace an OTP device, the user account must first be revoked and a new account
created.

User Activation

When the DocuSign Signature Appliance is running in Common Criteria EAL4+ mode, a user
activation process is required for every new user created. Without activation, no operation can be
performed by the user.

Activation is required also when DocuSign SA is deployed in Common Criteria EAL4+ mode as a
Seal Creation Device.

Every new user receives a fixed activation password in addition to the OTP device mentioned
above. The activation password must be delivered in a secure manner.
Note that an OTP device is not required if DocuSign SA is installed as a Seal Creation Device.

The new user uses the DocuSign SA client to perform the activation process. During the
activation process, the user is required to enter his/her activation password, new fixed password,
and the OTP (if required). The activation process can be performed only once per user account.

It is important to note that if a new user receives a message that the account has already been
activated, this may indicate that the user account was compromised and the issue should be
investigated by the organization.

Signature key Generation and Certificate Enroliment

In Common Criteria EAL4+ installations, DocuSign SA is installed without an internal CA. This
means that all users’ keys and certificates are created as part of a user enroliment process using
an external CA. For more information refer to Using DocuSign SA in Manual External CA Mode.

The end user must use the Certificate Authority’s tools or trusted third party tools that are installed
in the same PC as the DocuSign SA client is installed.

These tools can use either the DocuSign SA API (DocuSign SA Signature Local API or DocuSign
SA Signature API) or other APIs to interface with the DocuSign Signature Appliance for the
purpose of generating a signature key for the user in his/her account and generating a certificate
request for the user. The certificate request is sent by these third party tools to the Certificate
Authority.
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The Certificate Authority sends the certificate to the end user, who loads it into the DocuSign
Signature Appliance via a DocuSign SA API (DocuSign SA Signature Local APl or DocuSign SA
Signature API) or other APIs (such as PKCS#11, Microsoft CAPI or JAVA JCA interface), which
are offered by the DocuSign SA Client software.

Physical Security: Tamper Evidence and Tamper Response

DocuSign SA is encased within a tamper-responsive and tamper-evident steel box. All the
DocusSign Signature Appliance vents are baffled so it is not possible to view any of the internal
hardware components. It is also not possible to probe any of the DocuSign Signature Appliance
internal hardware components.

The DocuSign Signature Appliance includes a removable cover. This cover is rigged with micro-
switches, which are connected to an internal Tamper Device. When the tamper device is
triggered, the Appliance is immediately powered off. The mechanism works as follows:

Two of the screws holding the removable top case in place are connected to two micro-switches
each. These micro-switches are tripped if the screw is even partially removed. One screw with its
corresponding pair of micro-switches is used for tamper detection while power is off, and the other
is used for tamper detection while power is on. Both screws must be removed in order to remove
the cover of the module.

Any unauthorized attempts to remove the cover results in the automatic tamper response, which
occurs whether the Appliance is powered on or not.

Any attempt to restart the Appliance automatically displays tamper alerts on the Console.

Only a Reset Tamper operation performed by the Appliance administrator can set the DocuSign
SA Appliance back to an operational state.

During the Reset Tamper Operation, the Appliance administrator is required to plug-in the Backup
MiniKey (described in Chapter 3: Installing DocuSign SA).

In addition, external Tamper Evident cans provide physical evidence of any attempt to tamper
with the module cover. The Tamper Evident cans are placed over the screws that join the top
cover and bottom enclosure. The Tamper Evident cans are installed at the manufacturing stage.

The DocuSign Signature Appliance should be constantly monitored to make sure the device is
not tampered with and that there is no unauthorized access to the Appliance.

Recommended OTP Devices
It is recommended to select OTP devices that have the following characteristics:

¢ The OTP device has mechanisms that deny access to the security sensitive information of
the OTP device. These may be tamper evident or tamper response mechanisms that
provide evidence to the user that his/her device was tampered with, or more active
mechanisms that disable the device if tampering occurs.

¢ The OTP device cannot be duplicated. This prevents the possibility of a hostile user
signing on behalf of the legitimate user who holds the original OTP device.

¢ Each OTP device has a unique identification. This is necessary to enable binding a
different OTP device to every user.

The OTP devices should be distributed in a secure manner to the end users, if applicable.
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Using SAML Tickets to Authenticate DocuSign SA Users
You can log into DocuSign SA using a SAML ticket.

When a user presents a SAML token for the first time, an account is created for the user and the
user can start signing. At any subsequent session, the user is required to present a new valid
SAML ticket.

One of the benefits of accepting SAML tickets for authenticating users is to make DocuSign SA
services available to new user communities. For example, suppose Company A would like to
enable users from company B to connect to DocuSign SA services offered by Company A.

Using SAML tickets, Company A does not have to register each of the requesting users. The fact
that the users were provided with SAML tickets indicates they are trusted by Company B.

A popular product that enables issuing SAML tickets in Active Directory is Microsoft ADFS.
For more information, refer to ADES Flow and to Microsoft documentation, such as:
http://msdn.microsoft.com/en-us/library/bb897402.aspx.

Note:

SAML tickets can be used only if DocuSign SA is installed in Directory Independent mode.

SAML tickets cannot be used if DocuSign SA is deployed in a Common Criteria EAL4+ mode.

ADEFES Flow
The ADFS/SAML workflow is as follows:

1. The end user authenticates to the local Active Directory based on the configuration of the
local Active Directory deployment. For example, a Kerberos-based authentication may be
used.

2. Following successful authentication, the local active directory provides the end user with a
SAML ticket. This SAML ticket is a proof of authentication by the local ADFS, which is
signed with the local ADFS key.

3. As part of the communication of the local user with the remote DocuSign Signature
Appliance, the SAML ticket is presented to the remote DocuSign SA service, and the
DocuSign Signature Appliance validates the signature of the local ADFS system.

4. Atfter the SAML ticket is approved for the first time, an account is created for the user and
the user can start signing. At any subsequent session, the user is required to present a
new valid SAML ticket.

Note: The SAML ticket is signed using the ADFS signing key accompanied by a certificate. The
certificate should be given by a WorldWide Verifiable (WWYV) Certificate Authority, so that the
DocuSign Signature Appliance can validate the certificate of the SAML ticket.

Note: It is also possible to use a SAML ticket that is based on a non-WWYV certificate, but in this
case the entire certificate chain must be trusted by DocuSign SA and should be loaded to
DocuSign SA using the All Tasks - Subordinate CA -2 Load ROOT Cert Chain option in the
DocuSign SA Control Panel.
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Passive Mode using the DocuSign SA Web App and DocuSign SA Connector for
SharePoint

If an organization would like to enable users from another organization to sign via a web
application, the organization can deploy DocuSign SA Web App in the same IT environment as
the deployed DocusSign Signature Appliance. When a web application is used, the SAML based
authentication process proceeds as follows:

1. The end user connects to his organizational URL in the DocuSign SA Web App that is
dedicated to that user’s organization.

2. The DocuSign SA Web App redirects the user to the user’s local ADFS provider. During
this process, the user is authenticated by his/her local Active Directory and receives a
SAML ticket.

The user is redirected back to the DocuSign SA Web App with the provided SAML ticket.

The DocuSign SA Web App accesses the DocuSign Signhature Appliance with the supplied
SAML ticket. If this is a first time user, a new account is generated for this user. If the user
already has an account, the account will be used.

The user is identified by his email address, which is part of the SAML ticket. It is assumed

that the email address is unique.

5. The user continues with his/her web session.

Note: If the DocuSign SA Connector for Microsoft SharePoint is deployed, the redirection of the
user to the local ADFS provider is handled by Microsoft SharePoint. Further information is
provided in the DocuSign SA Connector for SharePoint User Guide

This mode is called Passive mode because the end user’s flow is automatic and does not require
any installation or configuration on the part of the end user. This flow is therefore suitable for
many clientless platforms such as tablets, smartphones, etc.

Active Mode Using the DocuSign SA Client

If an organization would like to enable users from another organization to sign via a desktop
application, the end users must install the DocuSign SA client and configure the DocuSign SA
client to use SAML based authentication. For mare information, refer to the DocuSign SA User
Guide.

SAML Ticket Requirements

The SAML tickets must meet the following requirements to receive approval by the DocuSign
Signature Appliance:
¢ The SAML ticket must be version 1.1 or version 2.0.

+ Date/Time restriction — Every SAML ticket is valid for a given period. Make sure to provide
SAML tickets that are still valid.

¢ The SAML ticket may include the following parameters:
¢ upn — The user’s identity. Mandatory
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emailaddress — The user’s email address. Mandatory
Common Name — the common name of the user. Mandatory
Group — The group name of the user, which is the user’s organizational ID. This
parameter is mandatory if the DocuSign SA SAML Working Method system parameter
has a value of 2.

¢ Audience — This mandatory field should contain a URL that defines the DocuSign SA
Service. This URL should be identical to the URL defined in the DocuSign SA
Accepting Relying Parties Tickets system parameter.

+ Additional fields such as name and surname. These fields are optional.

¢ The SAML ticket must include a standard XML digital signature generated by the local
ADFS server. The local ADFS server must be certified by a trusted worldwide verifiable

CA.
If groups are mandatory, the certificate thumbprint is validated against the thumbprint of

the certificate that exists in the group record.

Note: Many of the SAML ticket parameters hames (such as upn or emailaddress) can be
modified in the SAML section of the DocuSign SA system parameters.
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Chapter 3: Installing DocuSign SA

The following chapters describe how to install and uninstall DocuSign SA, manage the DocuSign
SA system, and connect to and use the DocuSign SA console.

DocusSign SA installation consists of several steps:

1.

Installing the DocuSign SA administrative client. The DocuSign SA administrative client
includes various administrative utilities, as well as the Microsoft Management Console
(MMC), DocuSign SA’s administration snap-in. The DocuSign SA administrative client
installation is described in this chapter.

Installing the DocuSign SA Enterprise / DocuSign SA FIPS appliance hardware. Appliance
hardware installation is described in this chapter.

Installing the DocuSign Signature Appliance software, in either a Microsoft-Active
Directory, LDAP based directory, or Directory Independent environment (including
installing DocuSign SA in Common Criteria EAL4+ mode). Appliance software installation
is described in this chapter.

Deploying the DocuSign SA Client, in a Microsoft-Active Directory environment, LDAP
based directory, or Directory Independent environment. This is described in
Chapter 4: Deploying the DocuSign SA Client.

Using the DocusSign SA console. This is described in Chapter 6: Using the DocuSign SA
Consoles.

Using the graphical signature management application that enables setting a graphical
signature for users of the organization. This is described in Using the Graphical Signature
Management Application

Optionally setting up the organization in a high availability configuration, in which several
DocusSign Signature Appliances are set up to provide load balancing and redundancy.
This is described in Chapter 7: Configuring High Availability.

Note: DocuSign SA installation differs slightly depending on whether DocuSign SA is being
installed in a Microsoft Active Directory environment, LDAP based environment, or Directory
Independent environment. These differences are mentioned where applicable.

Installing the DocuSign SA Administrative Client

The DocuSign SA administrative client includes various administrative utilities. The DocuSign SA
administrative client enables you to administrate the following DocuSign SA components:

+ Administrate DocuSign Signature Appliances, using the DocuSign SA Administration

MMC. For more information, refer to Chapter 5: Managing the DocuSign Signature
Appliance.

¢ Administrate DocuSign SA users. For more information, refer to Using the Users

Management Utility.
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¢ Set end users configuration. For more information, refer to Chapter 8: DocuSign SA
Configuration Utility.

+ Set graphical signatures for users. For more information, refer to Using the Graphical
Signature Management Application.

Installation Requirements

The DocuSign SA administrative client requires the administrative station to have one of the
following operating systems:
¢ Windows 2008/Windows 2008 R2.
Windows 7
Windows 8
Windows 10
Windows 2012 Server.

* & o o

Note: The DocuSign SA client can be also be installed in any 64 bit variant of the above
operating systems, such as Windows 7 64 bit.

When installing the DocuSign SA administrative client in a Microsoft Active Directory environment,
the administrative station must be joined to the Microsoft Domain. In addition, the administrator who
is installing the DocuSign SA administrative client must have domain administrative rights.

Note: It is possible for a user with limited permissions to install DocuSign SA in an Active
Directory environment. This situation is relevant for organizations where DocuSign SA serves
only certain organizational units.

This type of installation requires performing certain preparations prior to installing DocuSign SA,
as well as performing certain actions after DocuSign SA was installed.

Refer to Appendix A: DocuSign SA Installation with Reduced Privileges for detailed information
on how to install DocuSign SA using a user with limited permissions.

Note: The administrative client software installs the DocuSign SA administrative client along
with other administrative components, such as the graphical signature management capabilities
and administrative utilities.

Installing the DocuSign SA Administrative Client

Note: You must install the DocuSign SA administrative client on your administrative station
before installing the DocuSign Signature Appliance.

To install the DocuSign SA administrative client:

1. Insert the DocuSign Signature Appliance CD into the CD drive. The DocuSign Signature
Appliance screen appears:
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DOCUS\?&E Signature Appliance

Documentation | Support | Contact Us

| DocuSign Signature Applance Client

Signature Applance Admin:

Select supported applications:
Microsoft Office (Word, Excel, InfoPath)

DocuSign SA Printer

Install Mowe

Figure 2 DocuSign Signature Appliance Screen

2. Select the following components:

¢+ DocuSign Signature Appliance Client (this options is pre-selected).
¢ Signature Appliance Admin.
3. Click Install Now.

When installation is complete, a success message appears.

Uninstalling the DocuSign SA Administrative Client

To uninstall the DocuSign SA administrative client, uninstall all DocuSign Signature
Appliance components, as follows:

1. Open the Start menu and select Programs > DocuSign > Signature Appliance >
Uninstall Signature Appliance Components.

A confirmation box appears. Click Yes to uninstall. The uninstalling process begins.

When the DocuSign SA Client is uninstalled from the workstation, a message box appears
to inform you that the system finished uninstalling. Click OK.

The DocuSign SA administrative client is uninstalled from the workstation.
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Installing the DocuSign Signature Appliance Hardware version 8.0

The following sections provide instructions for installing the DocuSign Signature Appliance
hardware version 8.0 models:

+ DocuSign SA FIPS Appliance Hardware version 8.0 — refer to Installing the DocuSign SA
FIPS Appliance Hardware 8.0

+ DocuSign SA Enterprise Appliance Hardware version 8.0 — refer to Installing the DocuSign
SA Enterprise Hardware v7.0 and 8.0.

Installing the DocuSign SA FIPS Appliance Hardware 8.0
The DocuSign SA FIPS Appliance hardware (shown in Figures 3 and 4) includes:

A vent for the inner fan.

Three LEDs — Power, Hard Disk, and Tamper.

A USB connector for inserting MiniKey tokens.

A power switch

A touch screen for basic console information.

Dual power supply.

Two Ethernet connectors for connecting to the network.

+ An Ethernet connector for the regular secure interface, marked with the Ethernet MAC
Address of the Ethernet Interface.

+ An Ethernet connector dedicated to the Web Console (IP address 10.0.0.2, port 8088),
marked MGMT.

* & & & o o o

CoSign Central

Figure 3 DocuSign SA FIPS v8.0 hardware Front Panel
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Figure 4 DocuSign SA FIPS v.8.0 Back Panel
The following table lists the physical dimensions of the DocuSign SA FIPS v8.0 Appliance.

Width 42.5cm (16.7")
Length (Depth) 48.2 cm (18.9")
Height 13 cm (5.1%)
Weight 13.5 kg (30 Ib)

To install the DocuSign SA FIPS v8.0 hardware:
1. Verify that you have all the necessary sets of keys and MiniKey (USB) tokens, as follows:

¢ Two backup MiniKey tokens. Each of the backup MiniKey tokens contains identical
secrets, which include several triple DES Keys that are generated during the
installation of the DocuSign Signature Appliance software. These keys are used for
encrypting the backup file and the private keys in the database.
The keys also serve a role in database replication, which is an integral component of a
High Availability configuration (refer to Chapter 7: Configuring High Availability).

Note: The backup MiniKey token that was supplied with DocuSign SA versions prior to
version 5, is not compatible with Appliance version 8.0. Please contact DocuSign for
information on how to duplicate the backup tokens so that they are compatible with
DocusSign SA version 8.0.
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¢ One license MiniKey token. The license MiniKey token must be inserted while
operating the DocuSign Signature Appliance. If the license MiniKey token is not
inserted, the Appliance automatically shuts down after two hours. In this case, the
Event Log and the console display messages indicating that the license MiniKey token
is not inserted.

Note: The license MiniKey limits the number of end-users that may use the DocuSign
Signature Appliance. If you require additional user licenses, please contact your
DocuSign sales representative.

Note: Starting from DocuSign SA version 7.5, the license Minikey token may have an
expiration date.

Refer to Displaying DocuSign SA Status for instructions on how to view the expiration
date.

Refer to Obtaining a New DocuSign SA License for instructions on how to obtain an
updated license.

+ A physical key for front panel locking.

2. The DocusSign SA FIPS box is rack mountable. Install DocuSign SA FIPS in the rack as
follows:

¢ Insert a rack shelf in the rack.
Follow the instructions in the rack’s guide to properly attach the shelf to the rack.
Carefully place the DocuSign SA FIPS box on the shelf.

Use a screw driver, 4 screws, 4 washers, and 4 nuts to secure the DocuSign SA FIPS
box to the front vertical rail of the rack.
Use the four holes in the front of the DocuSign SA FIPS box.

A Caution: Make sure that the rack has no overload limitations that exceeds
the weight of the Appliance as defined in the above physical dimensions
table.

Connect the Appliance to the dual power supply.

Connect the Appliance to the network using the Main Ethernet connector and a standard
Ethernet cable. DocuSign SA supports 10/100/1000 Mbits/sec Ethernet connections.
You can also connect, as needed, the Web Console platform to the DocuSign Signature
Appliance via the dedicated administrative network interface.

A Caution: Use shielded network cables.

5. Onthe DHCP server, you can set up a specific IP address for the DocuSign Signature
Appliance based on the Appliance’s MAC address. The Appliance’s MAC address is
located on the back panel of the Appliance (refer to Figure 6).
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Note: To use a static IP address, you must set the Appliance’s network parameters
using the console. For more information on using the console, refer to Chapter 6: Using
the DocuSign SA Consoles.

6. On the back panel of the Appliance, connect the dual power supply to the power networks.

7. On the front panel of the Appliance, press the power switch.

A Caution: There is a risk of explosion if the battery is replaced with an incorrect
type of battery. Dispose of used batteries according to the manufacturer’s
instructions.

Environmental Conditions

The following table lists the environmental conditions:

Operating Non-operating
Ambient Temperature | 41 to 104°F - 4 to 149°F

5 to 40°C - 20 to 65°C
Relative Humidity 20 to 80 % 10 to 90 %

(non-condensing) (non-condensing)

A Caution: Make sure that the temperature inside the rack does not exceed

the temperatures listed in the above Environmental Conditions table.
Note that temperatures inside the rack can sometimes exceed the service room
temperature.

A Caution: When installing the Appliance in a rack, make sure that the amount of air
flow required for the safe operation of the equipment is not compromised.

Note: The Appliance is permitted for connection to an IT power distribution system in Norway.

DocuSign SA FIPS/Common Criteria Certificates
The DocuSign SA FIPS Appliance complies with the following certificates:

¢ UL: Certificate #CU72160723, File# 31680947.001, with the following conditions:
¢ Indoor usage only.

¢ The box has been judged on the basis of the required spacing in the Standard for
Safety of Information Technology Equipment, including Electrical Business Equipment.
¢ Electrical rating of power supply:
Rated Voltage: 100-127 Vac/200-240 Vac
Input Current: 2 x 5.8A/2.9A (the 2 x is due to a dual power supply)
Power dissipation: 250 Watt, 850 BTU/h
Frequency: 50/60 Hz
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A Caution: Make sure that the electricity circuit is not overloaded by the
electrical consumption of the Appliance as defined in the above list.
This may entail taking overcurrent protection and supply wiring measures.

A Caution: Make sure that the rack has reliable earthing. Particular attention
should be given to supply connections other than direct connection to the
branch circuit (e.g., use of power strips).

+ The following warning is presented: “DANGER! Incorrect replacement of battery can
cause explosion. Replace only with the same or equivalent type of battery
recommended by the manufacturer. Dispose of used batteries according to the
manufacturer’s instructions”.

FIPS 140-2 level 3 validation:
Certificates number 2665.

Common Criteria EAL4+ validation:
Certificates number pending.

Warnings

A Before performing hardware maintenance based service, remember to
disconnect the Appliance from the two power sources.

Installing the DocuSign Signature Appliance Hardware version 7.0

The following sections provide instructions for installing the various DocuSign Signature
Appliance models.

L4
L4

Installing the DocuSign SA FIPS Hardware version 7.0.
Installing the DocuSign SA Enterprise Hardware v7.0 and 8.0.

Installing the DocuSign SA FIPS Hardware version 7.0

The DocuSign SA FIPS Appliance hardware (shown in Figures 5 and 6) includes:

* & & o o

A vent for the inner fan.

A protective metal door with a lock.

Three LEDs — Power, Hard Disk, and Tamper.

A USB connector for inserting MiniKey tokens.

Two power switches (one on the front panel of the Appliance and one in the back of the
Appliance).

A built-in console, consisting of a display and 4-button keypad.

A power connector.

An Ethernet connector for connecting to the network.
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Console

Vent for ON/OFF Power
Inner Fan Switch

_ LEDS: Power
Protective Metal Door USB Connector Hard Disk
with Lock Tamper

Figure 5 DocuSign SA FIPS v7.0 hardware Front Panel

Ethernet Connector
MAC Address

Power Power
Connector Switch

Figure 6 DocuSign SA FIPS v7.0 hardware Back Panel

The following table lists the physical dimensions of the DocuSign SA FIPS v7.0 Appliance.

Width 48.3 cm (19")
Length (Depth) 44.7 cm (17.6")
Height 17.8 cm (7")
Weight 15 kg (33 Ib)

To install the DocuSign SA FIPS Appliance hardware:

1. Verify that you have all the necessary sets of keys and MiniKey (USB) tokens, as follows:

+ Two backup MiniKey tokens. Each of the backup MiniKey tokens contains identical

secrets, which include several triple DES Keys that are generated during the

installation of the DocuSign Signature Appliance software. These keys are used for

encrypting the backup file and the private keys in the database.

The keys also serve a role in database replication, which is an integral component of a

High Availability configuration (refer to Chapter 7: Configuring High Availability).

+ One license MiniKey token. The license MiniKey token must be inserted while
operating the DocuSign Signature Appliance. If the license MiniKey token is not
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2.

~

inserted, the Appliance automatically shuts down after two hours. In this case, the
Event Log and the console display messages indicating that the license MiniKey token
is not inserted.

Note: The license MiniKey limits the number of end-users that may use the DocuSign
Signature Appliance. If you require additional user licenses, please contact your
DocuSign sales representative.

Note: Starting from DocuSign SA version 7.5, the license Minikey token may have an
expiration date.

Refer to Displaying DocuSign SA Status for instructions on how to view the expiration
date.

Refer to Obtaining a New DocuSign SA License for instructions on how to obtain an

updated license.

¢ A physical key for front panel locking.
The DocuSign SA FIPS box is rack mountable. Install DocuSign SA FIPS in the rack as
follows:
¢ Insert a rack shelf in the rack.
Follow the instructions in the rack’s guide to properly attach the shelf to the rack.
Carefully place the DocuSign SA FIPS box on the shelf.

Use a screw driver, 4 screws, 4 washers, and 4 nuts to secure the DocuSign SA FIPS
box to the front vertical rail of the rack.
Use the four holes in the front of the DocuSign SA FIPS box.

Connect the Appliance to the power supply.

Connect the Appliance to the network using the Ethernet connector and a standard
Ethernet cable. DocuSign SA supports 10/100/1000 Mbits/sec Ethernet connections.

A Caution: Use shielded network cables.

On the DHCP server, you can set up a specific IP address for the DocuSign Signature
Appliance based on the Appliance’s MAC address. The Appliance’s MAC address is
located on the back panel of the Appliance (refer to Figure 6).

Note: To use a static IP address, you must set the Appliance’s network parameters
using the console. For more information on using the console, refer to Chapter 6: Using
the DocuSign SA Consoles.

On the back panel of the Appliance, turn on the power switch.

On the front panel of the Appliance, press the ON/OFF power switch.

A Caution: There is a risk of explosion if the battery is replaced with an incorrect
type of battery. Dispose of used batteries according to the manufacturer’s
instructions.
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Environmental Conditions

The following table lists the environmental conditions:

Operating Non-operating
Ambient Temperature | 41 to 95°F - 4 to 149°F
5 to 35°C - 20 to 65°C
Relative Humidity 20t0 80 % 10t0 90 %
(non-condensing) (non-condensing)
A Caution: Make sure that the temperature inside the rack does not exceed
35°C / 95°F.

DocuSign SA FIPS and Common Criteria Certificates
The DocuSign SA FIPS Appliance complies with the following certificates:

+ UL file No: E192352, with the following conditions:
+ Indoor usage only.

¢ The box has been judged on the basis of the required spacing in the Standard for
Safety of Information Technology Equipment, including Electrical Business Equipment.

¢ Electrical rating of power supply:
Voltage: 100-240 Vac
Frequency: 60/50 Hz
Current: 10 A

+ The following warning is presented: “DANGER! Incorrect replacement of battery can
cause explosion. Replace only with the same or equivalent type of battery
recommended by the manufacturer. Dispose of used batteries according to the
manufacturer’s instructions”.

¢ FIPS 140-2 level 3 validation:

¢ Certificates number 887, 1208, 1422, 2590, 2665.
¢ Common Criteria EAL4+ certification:

¢ For DocuSign SA version 7.1 and version 7.5

Installing the DocuSign SA Enterprise Hardware v7.0 and 8.0

Note: The following installation instructions apply both to hardware version 7.0 and hardware
version 8.0 of the DocuSign SA Enterprise.

The DocuSign SA Enterprise hardware (shown in Figures 7 and 8) includes:

¢ In Hardware v7.0 — Power supply.
¢ In Hardware v8.0 — Dual power supply.
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A recessed power button on the front panel.

In Hardware v7.0 — An Ethernet connector for connecting to the network on the back
panel.

¢ In Hardware v8.0 — Two Ethernet connectors (see Figure 9):
+ An Ethernet connector for the regular secure interface, marked 2.

+ An Ethernet connector dedicated to the Web Console (IP address 10.0.0.2, port 8088),
marked 1 (IMM)

+ A serial connector for connecting a terminal in the back panel.
¢ Front panel USB connectors for inserting MiniKey tokens.

Note: Do not connect any of the other interfaces.

Note: The DocuSign SA Enterprise includes two additional LAN interfaces that are not
operational and are covered with lids.

Power Switch
USE Ports

Figure 7 DocuSign SA Enterprise Front Panel

Network Interface

Serial Connector

Figure 8 DocuSign SA Enterprise Hardware version 7.0 Back Panel
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Figure 9 Ethernet connectors in DocuSign SA Enterprise Hardware version 8.0 Back Panel

The following table lists the dimensions of the DocuSign SA Enterprise hardware version 7.0.

Width

47.9 cm (18.8")

Length (Depth)

55.88 cm (22"

Height

4.45 cm (1.75")

Weight

12.7 kg (25.4 Ibs)

The following table lists the dimensions of the DocuSign SA Enterprise hardware version 8.0

(M3).

The following table lists the dimensions

Width 44 cm (17.3")
Length (Depth) 55.9cm (22")
Height 4.3 cm (1.7")
Weight 12.7 kg (28 Ibs)

of the DocuSign SA Enterprise hardware version 8 (M5).

Width

43.5 cm (17.1")

Length (Depth)

57.6 cm (22.7")

Height

4.3cm (1.7")

Weight

12.3 kg (27.1 Ibs)

To install the DocuSign SA Enterprise hardware:

1. Verify that you have all the necessary sets of keys and MiniKey (USB) tokens, as follows:

¢ Two backup MiniKey tokens. Each of the backup MiniKey tokens contains identical
secrets, which include several triple DES keys that are generated during the
installation of the DocuSign SA Enterprise software. These keys are used for
encrypting the backup file and the private keys in the database.
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¢ License MiniKey token. The license MiniKey token must be inserted while operating
the DocuSign SA Enterprise model. If the license MiniKey token is not inserted, the
Appliance automatically shuts down after two hours. In this case, the Event log
displays messages indicating that the license MiniKey token is not inserted.

Note: The license MiniKey limits the number of end-users that may use the DocuSign SA
Enterprise Appliance. If you require additional user licenses, contact your DocuSign
sales representative.

2. Connect the power cable to the DocuSign SA Enterprise’s power connector, and then
connect the power cable to the power supply.

3. Connect the Appliance to the network using the Ethernet connector and a standard
Ethernet cable. DocuSign SA Enterprise supports 10/100/1000 Mbits/sec Ethernet
connections.

A Caution: Use shielded network cables.

4. Onthe DHCP server, you can set up a specific IP address for the DocuSign SA Enterprise
based on the Appliance’s MAC address. The Appliance’s MAC address is located on the
back panel of the Appliance.

Note: To use a static IP address, first connect the console terminal to the serial
connector of the DocuSign SA Enterprise. For more information on using the console,
refer to Chapter 6: Using the DocuSign SA Consoles.

5. On the front panel of the Appliance, press the recessed power button.

Environmental Conditions
The following table lists the environmental conditions:

Operating Non-operating
Ambient Temperature | 50 to 95°F -40 to 140°F

10 to 35°C -40 to 60°C
Relative Humidity 810 80 % 810 80 %

(non-condensing) (non-condensing)

A Caution: Make sure that the temperature inside the rack does not exceed 35°C /
95°F.
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Installing the DocuSign Signature Appliance Software

DocuSign SA can be installed in either a Microsoft Active Directory environment, LDAP
environment, Directory Independent Environment or in a Common Criteria EAL4+ Environment.

All Tasks 3 Install 3 Mew Active Directory Signature Appliance
View 5 Restore Mew Directory Independent Appliance

I Mew LDAP Appliance
Refresh

Mew Common Criteria appliance

Export List... Mew Common Criteria Seal appliance

Help

Figure 10 DocuSign SA Installation Options
If you are planning on Using DocuSign SA in Manual External CA Mode, then:

+ If you plan to use Symantec as the external CA, you must create a Symantec profile
before installing DocuSign SA, Refer to Creating a Symantec Profile Preparatory to
Configuring Symantec as DocuSign SA’s External CA.

+ If you plan to use Comodo as the external CA, contact DocuSign and they will perform all
the necessary setup. DocuSign will then provide you with the CA User Name and CA User
Password you will need to specify during DocuSign SA installation, as described in Using
an External CA in Automated Mode - Comodo.

Note: The following software installation instructions apply for all DocuSign SA hardware
models, unless otherwise noted.

Note: In the future DocuSign SA version 8.2, an additional entry for installing a New Common
Criteria Seal appliance option will appear for installing DocuSign SA as a Seal Creation Device.

Installing DocuSign SA in a Microsoft Active Directory Environment

The DocuSign SA interface to Microsoft Active Directory assists both administrators and end
users in the following aspects:

+ Administrators — The administrator does not need to manage users in DocuSign SA since
DocuSign SA can be instructed to automatically synchronize with the users located in the
Microsoft Active Directory. Depending on DocuSign SA’s configuration, each time a new
user is created in the Active Directory, the DocuSign Signature Appliance generates a new
user account. Additionally, depending on the DocuSign SA Internal certificate authority
configuration, a private key and a certificate are generated for the user. When certain
attributes in the user record in the directory are modified (such as the user's email
address), a new certificate is generated for the user by the DocuSign Signature Appliance.
When the user is deleted from the directory, the user is also be deleted from the DocuSign
Signature Appliance and his/her certificate is revoked.

In addition, the DocuSign Signature Appliance also publishes information in the domain,
enabling the user to easily access it automatically. For example, the availability status of
the DocuSign Signature Appliance or the DocuSign SA Root CA certificate is published at
the Microsoft Active Directory as well.
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¢ Users —When using active directory, DocuSign SA can employ the Kerberos ticketing
mechanism to enable users to automatically logon to the DocuSign Signature Appliance
using the credentials supplied at the beginning of the user's session in the Microsoft
Domain. In this case, it is mandatory that the user's machine be joined to the Microsoft
domain.

You can install DocuSign SA in a multiple trusted Active Directory (AD) environment, where a
single DocusSign Signature Appliance installed in a certain AD Domain can accept users from
other domains that have mutual trust with DocuSign SA’s domain.

In this mode of work, users’ synchronization works differently: upon first access of a new user,
DocuSign SA automatically creates an account for the user and, depending on the configuration,
also generates a key and a certificate for the user.

Upon an update of the user information in the domain, an updated certificate is generated for the
user, depending on the updated parameters.

When the user is deleted from the domain, the user account is deleted from DocuSign SA, and
his/her certificate is revoked.

In order to manage DocuSign SA after installation, you must be either a member of the
administrators group and be a valid DocuSign SA user (as defined in the Directory Setup dialog
box, shown in Figure 15), or be the built-in DocuSign Signature Appliance administrator.

Permission Considerations

Since the installation of the DocuSign Signature Appliance requires access to Microsoft Active
Directory in several locations in the Directory, special care must be taken in using the appropriate
administrator accounts. Regarding the permissions of the administrator installing DocuSign SA in
a Microsoft Active Directory environment, there are three approaches:

¢ Straightforward installation by an administrator with full permissions. The DocuSign
Signature Appliance software is installed from the DocuSign Signature Appliances
Management application. In this installation scenario, the administrator logged on to the
administration workstation that is running the DocuSign SA administrative client is a
member of both the Enterprise admins and Domain admins groups. This is because one
of the operations that are performed during the installation is the creation of a new
computer entry in the Microsoft Active Directory.

¢ Installation by an administrator with limited permissions. This situation is relevant to
organizations where DocuSign SA serves only certain organizational units. This type of
installation requires performing certain preparations prior to installing DocuSign SA, as
well as performing certain actions after DocuSign SA was installed.
Refer to Appendix A: DocuSign SA Installation with Reduced Privileges for detailed
information on how to install DocuSign SA using a user with limited permissions.

¢ Installation by an administrator who may not have full permissions. If the administrator
does not have permissions for all Active Directory related activities that occur during the
installation, a window appears, detailing the exact problem. The exact returned error is
displayed in the bottom of the window.
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Figure 11 Switching to a Different Administrator

You can switch to another administrator account that may have the permissions to perform
the failed operation. You can also specify whether to continue using the new administrator
account for the next operations.

For example, if DocuSign SA is installed in a child domain environment, the installation
can start with an administrator of the child domain using a workstation that is joined to the
child domain. During the installation, it is required to also access the parent domain for
updating the parent domain with information such as the DocuSign SA CA certificate and
the DocuSign SA CA CRL. If the administrator of the child domain does not have parent
domain permissions, the window shown in Figure 11 appears, requesting the user to
supply an administrator account with administrative permissions in the parent domain.

Installation Instructions
To install the DocuSign SA software:

1. Activate the DocuSign SA Control Panel by opening the Start menu and selecting
Programs > DocuSign > Signature Appliance > Signature Appliance Control Panel.
The Signature Appliance Control Panel appears.

2. Select Appliances Management. The DocuSign Signature Appliance Management
window appeatrs.
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3. Right-click Signature Appliances and select All Tasks = Install > New Active
Directory Signature Appliance. The DocuSign SA License Agreement appears.

4. Accept the license agreement and click Next. The Network Setup dialog box appears.

Signature Appliance |P address:

Figure 12 Network Setup Dialog Box

5. Enter the IP address of the DocuSign Signature Appliance. This parameter is necessary
for enabling basic communication to and from the DocuSign Signature Appliance.
Starting from DocuSign SA hardware version 8.0, IPv6 is also supported. You can enter
an IPv6-type IP address in the DocuSign Signature Appliance IP address field.

Note: For information on setting up the IP address of the DocuSign Signature Appliance,
refer to_Using a Static IP_Address and Enabling DHCP.

Note: Make sure that your DHCP server is set up to allocate the correct DNS server
address for the domain. If it is not set up, use the console to set a DNS server address
before installing DocuSign SA (refer to Using a Static IP Address).

6. Click Next. The DocuSign SA Administrator User dialog box appears.
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Figure 13 DocuSign SA Administrator User Dialog Box

7. Enter the user name and password of a built-in administrator who will manage the
DocuSign Signature Appliance. You will need to enter the password again for

confirmation.
The built-in administrator is very useful in cases where the Active Directory-based

administrator has a problem connecting to DocuSign SA.

Note: Make sure to select an appropriate password for this user since the administrator
user name and password that you enter in this dialog box are used for appliance
management. During installation, a new user is generated in DocuSign SA with this user

name and password.
Make sure not to forget this password, since without it you will not be able to perform any

administrative task.

8. Click Next. The Active Directory Admin Account dialog box appears.
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Enter the name and pazsword of an account with permizzion to join the appliance to the
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User name: Iadministratnr

Pazgwiord: Ixxxxxxxxx

Darmnair : Idn:nmain.n::n:nm

Figure 14 Active Directory Admin Account Dialog Box

Note: The Active Directory Admin Account dialog box includes default values based on
the administrative user who is currently logged on. You can change the default values if
desired. If default values do not appear, the DNS configuration of the administration
station may be problematic and the installation procedure may fail (refer to Default
Values Do Not Appear in the Directory Setup Dialog Box).

9. Enter an administrative account that has permission to join the DocuSign Signature
Appliance to the Domain.

10. Click Next. The Directory Setup dialog box appears.
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Figure 15 Directory Setup Dialog Box

Note: The Directory Setup dialog box includes default values based on the
administrative user who is currently logged on. You can change the default values if
desired. If default values do not appear, the DNS configuration of the administration
station may be problematic and the installation procedure may fail (refer to Default
Values Do Not Appear in the Directory Setup Dialog Box).

Note: If DocuSign SA is intended to be installed in a regional domain of a forest, set the
above fields to include information of the regional domain and not of the ROOT domain.

11. Enter the following information:

+ Domain/Tree name — The name of the domain that contains the DocuSign Signhature
Appliance.

+ DocuSign SA container — The location in the Active Directory where the DocuSign
Signature Appliance computer will be contained. A new computer entry will be created

in this location.
You can click Browse to browse to the appropriate location. The Directory Object

Selection Tree dialog box appears.
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Note: If the DocuSign SA Administration MMC is being used on the domain machine, the
displayed default values will be different than those for a regular machine. Modify these
values as required.

+ Users Synchronization Settings — If you do not select this option, the DocuSign
Signature Appliance will work in a multiple Active Directory environment. This means
that users from several domains that have trust between the domains can use
DocuSign SA to perform signature operations. The user must belong to the specified
signers group.

The first attempt of the user to access the DocuSign Signature Appliance will
automatically generate an account for the user and, depending on the system
configuration, will also generate a key and a certificate for the user.

If you do select this option, then using the values you enter in the Directory Setup
dialog box (Figure 15), the DocuSign Signature Appliance selects the users of the
domain who will be considered DocuSign SA users and thus will be able to sign
documents. The selection is performed as follows: In the first stage, all users defined
in the Users Container can be potential users of the DocuSign Signature Appliance.

In the next stage, if Use Signers Group is selected, only users who belong to the
specified group are valid DocuSign SA users. Note that in the Signers group it is
possible to define additional subgroups to ease the selection of DocuSign SA users.
For example, the administrator can define that the Signers group include the Sales and
Marketing groups.

+ Users container — The general scope of users who can access DocuSign SA, based
on a sub-tree of users in the Active Directory.
You can click Browse to browse to an existing location of the Users container in Active
Directory. The Directory Object Selection Tree dialog box appears.

+ Use Signers Group — Select this option to specify that only users who belong to the
Signers group be defined as DocuSign SA users.

¢ Signers Group Name — The full distinguish name of the Signers Group. Click Browse
to browse to the location of the Signers Group. Remember to specify the name of the
Signers Group in addition to the location of the group.
You can click Browse to browse to an existing location of the Signers Group in Active
Directory. The Directory Object Selection Tree dialog box appears.

¢+ Automatically synchronize DocuSign SA with the directory to create user
database — If this option is selected, DocuSign SA will automatically generate
accounts for each signer and, depending on the CA configuration, generate a key and
a certificate for each signer.
If this option is not selected, the administrator should perform a manual
synchronization. This option should be used in cases where it is required to change
settings after installation, but before user accounts are created.
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Note: In addition to the default DocuSign SA administrator, you can define additional
DocuSign SA administrators who are valid Active Directory users. If you do so, the
DocuSign SA administrator must also be located in this subtree and the Signers Group in
order to be a valid DocuSign SA user. Otherwise the administrator will not be able to
administrate DocuSign SA.

Important: In the case of a regular AD installation, do not modify the name of the sub-
tree of DocuSign SA users in the Active Directory. Such a maodification can lead to
deleting all the users and their information inside the DocuSign Signature Appliance.

Note: If you move a user from the DocuSign SA OU (DocusSign SA container) to a
different location, the user is not automatically deleted from the DocuSign Signature
Appliance. The next manual synchronization operation will delete the user from the
DocuSign Signature Appliance. This means that the user’s key, certificate, and graphical
signature are deleted.

Note: If you move a user from the Signers group in the Active Directory, the user is not
automatically deleted from the DocuSign Signature Appliance, but the users will be
unable to connect to DocuSign SA. The next manual synchronization operation will
delete the user from the DocuSign Signhature Appliance.

Note: In a multiple AD domain environment, user synchronization is based on two
considerations:

- If the user is updated in the domain in a parameter that is relevant to DocuSign SA (i.e.,
email address), the user will be updated in DocuSign SA as well.

- If the user is deleted from the domain, the user will be deleted from DocuSign SA as
well and his/her certificate will be revoked.

12. Click Next.

If the requested Signers groups does not exist, you are queried whether the installation
procedure should create this group inside Active Directory.
After clicking Yes or No, the CA Setup dialog box appears.

Note: If a Signers group is created, valid DocuSign SA users are created only after assigning
users to the Signers group.
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Figure 16 CA Setup Dialog Box

If you want the DocuSign Signature Appliance to use an internal Certificate Authority
(CA) for generating end-user certificates, refer to Installing an Internal Certificate
Authority for detailed explanations of the CA Setup dialog box. After setting up the
internal CA in the CA Setup dialog box, continue with Step 9.

If you want the DocuSign Signature Appliance to use an external Certification Authority
(CA) for automatically generating end-user certificates, refer to Using an External CA
in Automated Mode for detailed explanations of the CA Setup dialog box. After
configuring the CA type in the CA Setup dialog box, continue with Step 9.

If you do not wish the DocuSign Signature Appliance to use an internal CA, select the
Without CA option in the CA type drop-down box. In this case, you will be using
DocuSign SA in manual external CA mode. It is highly recommended to read the
section Using DocuSign SA in Manual External CA Mode before installing DocuSign
SA with this option.

13. Click Next. The DocuSign SA installation begins. A status bar displays the status of the
installation operation.
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During the installation, status messages appear on both the console display and the
DocuSign SA Administration MMC display.

14. At the Please insert a backup Minikey prompt, insert the first backup MiniKey token.

15. At the Please insert a second backup Minikey prompt, remove the first MiniKey
token and insert the second backup MiniKey token.
The second backup MiniKey is a duplicate of the first backup MiniKey.

16. At the Please insert your License Minikey prompt, insert the license MiniKey token.

If you selected the option Install as Subordinate CA in the CA Setup dialog box (refer to
Installing an Internal Certificate Authority), several dialog boxes appear, necessitating
various operations. For detailed instructions, refer to Installing DocuSign SA as a
Subordinate CA.

If you selected the CA Type to be Symantec World Wide Verifiable CA in the CA Setup
dialog box, some additional configuration is required, as described in Using an External
CA in Automated Mode — Symantec.

In all other cases, your part in the installation is complete.

If you did not select Automatically synchronize DocuSign SA with the directory to
create user database in the Directory Setup dialog box (Figure 15), a message appears,
reminding you to perform a manual synchronization.

If you did select that option, the installation will generate user accounts and automatically
generate keys and certificates for all created users. A progress bar continues to display
the progress of the operation. The time needed for creating the users, keys, and
certificates depends on the number of users and the selected key length.

17. Click Finish.

Note: If the first stage of installation was unsuccessful, the DocuSign Signature
Appliance returns to its factory settings. This enables you to rerun the installation. In this
case, the status bar displays that installation was unsuccessful and you can click the
Back buttons to modify settings before rerunning the installation.

If the installation was unsuccessful and you are unable to rerun the installation, restore
DocuSign SA to factory settings and then try again. For more information about restoring
factory settings, refer to Restoring Factory Settings.

Note: Clicking Cancel does not stop the installation process, it only closes the progress
bar on the administration machine (unless you specified a subordinate CA installation).

18. In the DocuSign SA Administration MMC window, right-click DocuSign Signature
Appliances and select Refresh from the popup menu. The window refreshes and
displays the newly installed appliance. You will need to login and then you can manage
DocuSign SA using the DocuSign SA Administration MMC (refer to Chapter 5: Managing
the DocuSign Signature Appliance).
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Note: Keep the license MiniKey token plugged into the device at all times. Unplugging the
license MiniKey for several hours may shut down the service.

Periodically check the number of appliance users. If the number of users is approaching the
license limit, contact DocuSign for a replacement license MiniKey token

If you received a license with an expiration date, periodically check it using the console to verify
it is not about to expire. Refer to Displaying DocuSign SA Status for instructions on how to view
the expiration date. Contact DocuSign for a replacement license MiniKey token before the
current key expires.

Note: In a high availability environment, the licenses of all the DocuSign Signature Appliances in
the high availability site should have an identical limitation on the number of appliance users.

Note: Store the backup MiniKey in a separate, secure place (for example, a safe). In case of
disaster, you can use the backup MiniKey and the backup file of the DocuSign SA’s database to
safely recover and restore DocuSign SA data. For more information on how to backup and
restore the DocuSign SA’s database, refer to Backing up the DocuSign SA Data.

If you lose the backup MiniKey, you will not be able to perform some critical functions, such as
restoring the DocuSign Signature Appliance (even if you a have a backup file), adding an
alternate appliance, and performing a reset tamper operation. Therefore, make sure that the
backup MiniKey, as well as the second backup MiniKey, will be available when needed.

The following table provides a summary of the users involved in the installation procedure and
DocuSign SA operation. The table also describes the actions and permissions of each of these
users.

For more information on how DocuSign SA interfaces with Active Directory, refer to Appendix A:
DocusSign SA Installation with Reduced Privileges.

Table 1 Users Involved in the Installation and Operation of DocuSign SA

User Actions Active Directory | Permissions | Suggested
Operations Permission
Group
Domain Administrator | Running the Update the Active Permission to Enterprise
DocuSign SA Directory as create objects admins and
Administration follows: Register in Active Domain admins
MMC for the DocuSign Directory and
performing Signature enable the
installation. Appliance as a DocusSign
workstation, and Signature
create the following | Appliance to
objects: SCP update them
objects, a CA during
object, a CA AIA operation.
object, and a CA
CRL object.
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User Actions Active Directory | Permissions | Suggested
Operations Permission
Group
Administrator user Registering the Join the DocuSign Permission to Enterprise
(name and password DocuSign Signature register the admins and
are provided during Signature Appliance to the appliance as a | Domain admins
installation) Appliance as a domain. member of the | in the domain.
member of the domain.
domain during
installation.
DocuSign SA Performing None Only Active administrators
Administrator DocusSign SA Directory groups in the
administrative administrators domain.
operations. and the built-in

administrator
can
administrate
the DocuSign
Signature
Appliance.

Installing DocuSign SA in an LDAP based Environment

The solution for LDAP is different from the solution for Microsoft Active Directory. The creation of
a new user account is based on a first access performed by the end user. When the user
accesses the DocuSign Signature Appliance and presents his/her password, the DocuSign
Signature Appliance accesses the LDAP server and presents these credentials. Upon a
successful LDAP access, DocuSign SA generates a new account for the user and depending on
the DocuSign SA configuration, generates also a key and a certificate for the end user.

When certain attributes in the user record in the directory are modified (such as the user's email
address), a new certificate is generated for the user by the DocuSign Signature Appliance.

When the user is deleted from the directory, the user is also deleted from the DocuSign Signature
Appliance and his/her certificate is revoked.

In addition, the DocuSign Signature Appliance also publishes information in the domain, enabling
the user to easily access it automatically. For example, it publishes the availability status of the
DocusSign Signature Appliance.

The following directories are supported:

¢ |IBM Tivoli.
For more information refer to
http://www.ibm.com/software/tivoli/products/directory-server/

Note: The identification of the user in the directory is based on the uid attribute.
The common name of automatically generated user certificates is based on the
givenName and sn attributes.
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¢ SUN Directory Server.
For more information refer to
http://www.sun.com/software/products/directory srvr ee/dir srvr/index.xml

Note: The identification of the user in the directory is based on the uid attribute.

The common name of automatically generated user certificates is based on the ¢cn
attribute.

¢ Oracle OID (Oracle Internet Directory).

For more information refer to http://www.oracle.com/technetwork/middleware/id-
mgmt/overview/index.html.

Note: The identification of the user in the directory is based on the uid attribute.

The common name of automatically generated user certificates is based on the
givenName and sn attributes.

Note: The following software installation instructions apply for all DocuSign SA models, unless
otherwise noted.

You install the DocuSign Signature Appliance software from the DocuSign SA Administration
MMC. In order to manage DocuSign SA after installation, you must either be a member of the
administrators group or be the built-in appliance administrator.

Note: Managing users, groups, and stations are features of the LDAP based directory. The
LDAP based directory enables you to define which actions users are permitted to perform. While

following this installation procedure, make sure that all user permissions are correctly defined in
the Directory, as specified in the procedure.

To install the DocuSign SA software:

1. Activate the DocuSign SA Administration MMC by opening the Start menu and selecting
Programs > DocuSign > Signature Appliance > Signature Appliance Control Panel.
The Signature Appliance Control Panel appears.

2. Inthe DocuSign SA Control Panel select Appliances Management. The DocuSign
Signature Appliance Management window appears.

3. Right-click DocuSign Signature Appliances and select All Tasks - Install > New
LDAP appliance. The DocuSign SA License Agreement appears.

4. Accept the license agreement and click Next. The Network Setup dialog box appears.
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Signature Appliance IF address:

Figure 17 Network Setup Dialog Box

5. Enter the DocuSign Signature Appliance IP address. This parameter is necessary for
enabling basic communication to and from the DocuSign Signature Appliance.
Starting from DocuSign SA Hardware version 8.0, IPv6 is also supported. You can enter
an IPv6-type IP address in the DocuSign Signature Appliance IP address field.

Note: For information on setting up the IP address of the DocuSign Signature Appliance
refer to Using a Static IP_ Address and Enabling DHCP.

6. Click Next. The DocuSign SA administrator user dialog box appears.
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Enter a uzer name and a pazsword of a built-in administrator who will manage the
Signature Appliance. Do not farget this passward, since without remember the pazswaord
yoL will not be able to perform impartant administrative tasks.

Adrin uzer narne:; Icsnadm
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Figure 18 DocuSign SA Administrator User Dialog Box
7. Enter the user name and password of a built-in administrator who will manage the
DocuSign Signature Appliance. You will need to enter the password again for

confirmation.
The built-in administrator is very useful in cases where the LDAP based administrator has

a problem connecting to DocuSign SA.

Note: Make sure to select an appropriate password for this user since the administrator
user name and password that you enter in this dialog box are used for appliance
management. During installation, a new user is generated in DocuSign SA with this user

name and password.
In addition, do not forget this password, since without the password you will not be able

to perform any administrative task.

8. Click Next. The Directory Server Information dialog box appears
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Figure 19 Directory Server Information Dialog Box

9. Enter the following information:

*

Schema - The commercial name of the LDAP server. This parameter directs
DocuSign SA to the differences between the LDAP implementations when the
DocusSign Signature Appliance interacts with the LDAP Server.

Address —The DNS name or IP address of the LDAP server.

Port — The port number of the LDAP server. Usually the port number is 389 or 636 (if
LDAP over SSL is used).

SSL — Select this option if the desired communication between the DocuSign
Signature Appliance and the LDAP server is based on SSL.

Authentication — Select whether the user’s password is transmitted to the LDAP
server in the clear or using the digest-MD5 method.

Base Users DN — The base root of the users tree that determines the scope of users
in DocuSign SA.
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10. Click Next. The CA Setup dialog box appears.
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Figure 20 CA Setup Dialog Box

If you want the DocuSign Signature Appliance to use an internal Certificate Authority
(CA) for generating end-user certificates, refer to Installing an Internal Certificate
Authority for detailed explanations of the CA Setup dialog box. After setting up the
internal CA in the CA Setup dialog box, continue with Step 11.

If you want the DocuSign Signature Appliance to use an External Certification
Authority (CA) for automatically generating end-user certificates, refer to Using an
External CA in Automated Mode for detailed explanations of the CA Setup dialog box.
After configuring the CA Type in the CA Setup dialog box, continue with Step 11.

If you do not wish the DocuSign Signature Appliance to use an internal CA, select the
Without CA option in the CA type drop-down box. It is highly recommended to read
the section Using DocuSign SA in Manual External CA Mode before installing
DocuSign SA with this option.

11. Click Next. DocusSign SA installation begins. A status bar displays the status of the
installation operation.
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12.
13.

14.

15.

16.

During the installation, status messages appear on both the console display (or on the
terminal console, for the Enterprise model) and the DocuSign SA Administration MMC
display.

At the Please insert a backup Minikey prompt, insert the first backup MiniKey token.

At the Please insert a second backup Minikey prompt, remove the first Minikey
token and insert the second backup MiniKey token.
The second backup MiniKey is a duplicate of the first backup MiniKey.

At the Please insert your License Minikey prompt, insert the license MiniKey token.

If you selected the option Install as Subordinate CA in the CA Setup dialog box (refer to
Installing an Internal Certificate Authority), several dialog boxes appear, necessitating
various operations. For detailed instructions, go to Installing DocuSign SA as a
Subordinate CA.

If you selected the CA Type to be Symantec World Wide Verifiable CA in the CA Setup
dialog box, some additional configuration is required, as described in Using an External
CA in Automated Mode — Symantec.

In all other cases, your part in the installation is complete.
Click Finish.

Note: If the first stage of installation was unsuccessful, the DocuSign Signature
Appliance returns to its factory settings. This enables you to rerun the installation. In this
case, the status bar displays that the installation was unsuccessful, and you can click the
Back buttons to modify settings before rerunning the installation.

If the installation was unsuccessful and you are unable to rerun the installation, restore
DocuSign SA to factory settings and then try again.

For more information about restoring factory settings, refer to Restoring Factory Settings.

Note: Clicking Cancel does not stop the installation process, it only closes the progress
bar on the administration machine (unless you specified a subordinate CA installation).

In the DocuSign SA Administration MMC window, right-click DocuSign Signature
Appliances and select Refresh from the popup menu. The window refreshes and
displays the newly installed appliance. You can now manage DocuSign SA using the
DocuSign SA Administration MMC (refer to Chapter 5: Managing the DocuSign Signature

Appliance).

Note: Keep the license MiniKey token plugged into the device at all times. Unplugging the
license MiniKey for several hours may shut down the service.

Periodically check the number of appliance users. If the number of users is approaching the
license limit, contact DocuSign for a replacement license MiniKey token.

If you received a license with an expiration date, periodically check it using the console to verify
it is not about to expire. Refer to Displaying DocuSign SA Status for instructions on how to view
the expiration date. Contact DocuSign for a replacement license MiniKey token before the
current key expires.
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Note: In a high availability environment, the licenses of all the DocuSign Signature Appliances in
the high availability site should have an identical limitation on the number of appliance users.

Note: Store the backup MiniKey in a separate, secure place (e.g., a safe). In case of disaster,
you can use the backup MiniKey and the backup file of the DocuSign SA’s database to safely
recover and restore DocuSign SA data. For more information on how to backup and restore the
DocuSign SA’s database, refer to Backing up the DocuSign SA Data.

If you lose the backup MiniKey, you will not be able to perform some critical functions, such as
restoring the DocuSign Signature Appliance (even if you a have a backup file), adding an
alternate appliance, and performing a reset tamper operation. Therefore, make sure that the
backup MiniKey, as well as the second backup MiniKey, will be available when needed.

In Microsoft Active Directory, user keys and certificates are generated during the installation of the
DocusSign Signature Appliance. In the case of LDAP based installation, only the administrator
account is generated.

A new DocusSign SA user is generated when this user attempts to access the DocuSign Signature
Appliance. After successfully authenticating the user against the LDAP server, the DocuSign
Signature Appliance generates an account for the user and may generate a key and a certificate
for the user, depending on the DocuSign Signature Appliance configuration.

Note: In a Sun One directory installation, you will need to update some system parameters for
enabling DocuSign SA to access the LDAP based directory. Connect to the appliance
administration using the local DocuSign SA administrative account.

Fill in the parameters LDAP DocuSign SA User Name and LDAP DocuSign SA User
Password with an administrative account that can perform queries to the directory. For more
information, refer to LDAP in Changing DocuSign SA System Parameters.

Installing DocuSign SA in a Directory Independent Environment

The cases where DocuSign SA is installed in a Directory Independent environment fall into two
categories:

+ DocusSign SA is integrated into a product that has its own user management capabilities.
User management of the product is not based on Microsoft Active Directory or LDAP.
In this case, DocuSign SA provides external signature APIs that enable the integrator to
insert a user into DocuSign SA upon the creation of a new user in the system. All other
user management APIs such as updating a user, deleting a user, etc., are supported
through the DocuSign SA signature APIs. For information, refer to the DocuSign SA
Signature APIs Developer’s Guide.

+ DocuSign SA is integrated into a product with no user management capabilities. In these
cases, the administrator will use a DocuSign SA GUI utility to manage the internal
DocuSign SA users. Refer to Using the Users Management Utility.

To install the DocuSign SA software:

1. Activate the DocuSign SA Administration MMC by opening the Start menu and selecting
Programs - DocuSign > Signature Appliance > Signature Appliance Control Panel.
The DocuSign SA Control Panel appears.
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2. Inthe DocuSign SA Control Panel select Appliances Management. The DocuSign
Signature Appliance Management window appears.

3. Right-click DocuSign Signature Appliances and select All Tasks - Install > New
Directory Independent appliance. The DocuSign SA License Agreement appears.

4. Accept the license agreement and click Next. The Network Setup dialog box appears.

Signature Appliance IF address:

Figure 21 Network Setup Dialog Box

5. Enter the DocuSign Signature Appliance IP address. This parameter is necessary for
enabling basic communication to and from the DocuSign Signature Appliance.
Starting from DocuSign SA Hardware version 8.0, IPv6 is also supported. You can enter
an IPv6-type IP address in the DocuSign Signature Appliance IP address field.

Note: For information on setting up the IP address of the DocuSign Signature Appliance,
refer to Using a Static IP_Address and Enabling DHCP.

6. Click Next. The DocuSign SA Administrator User dialog box appears.
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Enter a uzer name and a pazsword of a built-in administrator who will manage the
Signature Appliance. Do not farget this passward, since without remember the pazswaord
yoL will not be able to perform impartant administrative tasks.

Adrin uzer narne:; Icsnadm

Admin pazsword; Ixxxxxxxx

Canfirn admin pazswaord: Ixxxxxxx>1

Figure 22 DocuSign SA Administrator User Dialog Box

7. Enter the DocuSign SA Admin user name and Admin password, then enter the
password again for confirmation. This user will perform the administrative tasks.

Note: Make sure to select an appropriate password for this user since the administrator
user name and password that you enter in this dialog box are used for the appliance
management. During installation, a new user is generated in DocuSign SA with this user

name and password.

8. Click Next. The CA Setup dialog box appears.
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Figure 23 CA Setup Dialog Box

If you want the DocuSign Signature Appliance to use an internal Certificate Authority
(CA) for generating end-user certificates, refer to Installing an Internal Certificate
Authority for detailed explanations of the CA Setup dialog box. After setting up the
internal CA in the CA Setup dialog box, continue with Step 9.

If you want the DocuSign Signature Appliance to use an External Certification
Authority (CA) for automatically generating end-user certificates, refer to Using an
External CA in Automated Mode for detailed explanations of the CA Setup dialog box.
After configuring the CA Type in the CA Setup dialog box, continue with Step 9.

If you do not wish the DocuSign Signature Appliance to use an internal CA, select the
Without CA option in the CA type drop-down box. It is highly recommended to read
the section Using DocuSign SA in Manual External CA Mode before installing
DocuSign SA with this option.

9. Click Next. DocuSign SA installation begins. A status bar displays the status of the
installation operation.
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During the installation, status messages appear on both the console display (or on the
terminal console, for the Enterprise model) and the DocuSign SA Administration MMC
display.

10. At the Please insert a backup Minikey prompt, insert the first backup MiniKey token.

11. At the Please insert a second backup Minikey prompt, remove the first MiniKey
token and insert the second backup MiniKey token.
The second backup MiniKey is a duplicate of the first backup MiniKey.

12. At the Please insert your License Minikey prompt, insert the license MiniKey token.

If you selected the option Install as Subordinate CA in the CA Setup dialog box (refer to
Installing an Internal Certificate Authority), several dialog boxes appear, necessitating
various operations. For detailed instructions, refer to Installing DocuSign SA as a
Subordinate CA.

If you selected the CA Type to be Symantec World Wide Verifiable CA in the CA Setup
dialog box, some additional configuration is required, as described in Using an External
CA in Automated Mode — Symantec.

In all other cases, your part in the installation is complete.
13. Click Finish.

Note: If the first stage of installation was unsuccessful, the DocuSign Signature
Appliance returns to its factory settings. This enables you to rerun the installation. In this
case, the status bar displays that the installation was unsuccessful, and you can click the
Back buttons to modify settings before rerunning the installation.

If the installation was unsuccessful and you are unable to rerun the installation, restore
DocuSign SA to factory settings and then try again.

For more information about restoring factory settings, refer to Restoring Factory Settings.

Note: Clicking Cancel does not stop the installation process, it only closes the progress
bar on the administration machine (unless you specified a subordinate CA installation).

14. In the DocuSign SA Administration MMC window, right-click DocuSign Signature
Appliances and select Refresh from the popup menu. The window refreshes and
displays the newly installed appliance. You can now manage DocuSign SA using the
DocuSign SA Administration MMC (refer to Chapter 5: Managing the DocuSign Signature

Appliance).
15. Activate the DocuSign Signature Appliance Users Management utility to add users and

automatically generate keys and certificates for these users (refer to Using the Users
Management Utility).
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The created DocuSign SA users can connect to DocuSign SA and perform digital signature
operations.

Note: Keep the license MiniKey token plugged into the device at all times. Unplugging the
license MiniKey for several hours may shut down the service.

Periodically check the number of appliance users. If the number of users is approaching the
license limit, contact DocuSign for upgrading the license MiniKey token.

If you received a license with an expiration date, periodically check it using the console to verify
it is not about to expire. Refer to Displaying DocuSign SA Status for instructions on how to view
the expiration date. Contact DocuSign for a replacement license MiniKey token before the
current key expires.

Note: In a high availability environment, the licenses of all the DocuSign Signature Appliances in
the high availability site should have an identical limitation on the number of appliance users.

Note: Store the backup MiniKey in a separate, secure place (e.g., a safe). In case of disaster,
you can use the backup MiniKey and the backup file of the DocuSign SA’s database to safely
recover and restore DocuSign SA data. For more information on how to backup and restore the
DocuSign SA’s database, refer to Backing up the DocuSign SA Data.

If you lose the backup MiniKey, you will not be able to perform some critical functions, such as
restoring the DocuSign Signature Appliance (even if you a have a backup file), adding an
alternate appliance, and performing a reset tamper operation. Therefore, make sure that the
backup MiniKey, as well as the second backup MiniKey, will be available when needed.

Installing DocuSign SA in a Common Criteria EAL4+ Mode as a Signature Creation
Device or Seal Creation Device

When DocuSign SA is deployed in a Common Criteria mode, special consideration should be
given to the security of the DocuSign Signature Appliance’s operational environment. For more
information, refer to the DocuSign SA Security Target, located in the Products for Digital
Signature section in the Common Criteria portal (https://www.commoncriteriaportal.org/products/).

In addition, make sure all security measures related to the networking infrastructure of the
environment are taken. Make sure that routers, switches, firewalls, etc. are deployed correctly and
only allowed requests are sent to or from a deployed DocuSign Signature Appliance.

DocuSign SA installation in a Common Criteria EAL4+ mode is similar to installing DocuSign SA
in a Directory Independent mode.

To install the DocuSign SA software:

1. Activate the DocuSign SA Administration MMC by opening the Start menu and selecting
Programs - DocuSign > Signature Appliance > Signature Appliance Control Panel.
The DocuSign SA Control Panel appears.

2. Inthe DocuSign SA Control Panel select Appliances Management. The DocusSign
Signature Appliance Management window appears.
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3. Right-click DocuSign Signature Appliances and select All Tasks - Install > New
Common Criteria appliance. The DocuSign SA License Agreement appears.

4. Accept the license agreement and click Next. The Network Setup dialog box appears.

Signature Appliance |P address:

Figure 24 Network Setup Dialog Box

5. Enter the DocuSign Signature Appliance IP address. This parameter is necessary for
enabling basic communication to and from the DocuSign Signature Appliance.
Starting from DocuSign SA Hardware version 8.0, IPv6 is also supported. You can enter
an IPv6-type IP address in the DocuSign Signature Appliance IP address field.

Note: For information on setting up the IP address of the DocuSign Signature Appliance,
refer to Using a Static IP Address and Enabling DHCP.

6. Click Next. The DocuSign SA Administrator User dialog box appears.
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Enter a uzer name and a pazsword of a built-in administrator who will manage the
Signature Appliance. Do not farget this passward, since without remember the pazswaord
yoL will not be able to perform impartant administrative tasks.

Adrin uzer narne:; Icsnadm

Admin pazsword; Ixxxxxxxx

Canfirn admin pazswaord: Ixxxxxxx>1

Figure 25 DocuSign SA Administrator User Dialog Box

7. Enter the DocuSign SA Admin user name and Admin password, then enter the
password again for confirmation. This user will perform the administrative tasks.

Note: Make sure to select an appropriate password for this user since the administrator
user name and password that you enter in this dialog box are used for the appliance
management. During installation, a new user is generated in DocuSign SA with this user
name and password.

8. Click Next. DocuSign SA installation begins. A status bar displays the status of the
installation operation.

During the installation, status messages appear on both the console display and the
DocuSign SA Administration MMC display.

9. Atthe Please insert a backup Minikey prompt, insert the first backup MiniKey token.

10. At the Please insert a second backup Minikey prompt, remove the first Minikey
token and insert the second backup MiniKey token.
The second backup MiniKey is a duplicate of the first backup MiniKey.
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11. Atthe Please insert your License Minikey prompt, insert the license MiniKey token.
Your part in the installation is complete.
12. Click Finish.

Note: If the first stage of installation was unsuccessful, the DocuSign Signature
Appliance returns to its factory settings. This enables you to rerun the installation. In this
case, the status bar displays that the installation was unsuccessful, and you can click the
Back buttons to modify settings before rerunning the installation.

If the installation was unsuccessful and you are unable to rerun the installation, restore
DocuSign SA to factory settings and then try again.

For more information about restoring factory settings, refer to Restoring Factory Settings.

Note: Clicking Cancel does not stop the installation process, it only closes the progress
bar on the administration machine (unless you specified a subordinate CA installation).

13. In the DocuSign SA Administration MMC window, right-click DocuSign Signature
Appliances and select Refresh from the popup menu. The window refreshes and
displays the newly installed appliance. You can now manage DocuSign SA using the
DocuSign SA Administration MMC (refer to Chapter 5: Managing the DocuSign Signature
Appliance).

14. Activate the DocuSign Signature Appliance Users Management utility to add users and
automatically generate keys and certificates for these users (refer to Using the Users
Management Utility).

The created DocuSign SA users can connect to DocuSign SA and perform digital signature
operations.

Note: Keep the license MiniKey token plugged into the device at all times. Unplugging the
license MiniKey for several hours may shut down the service.

Periodically check the number of appliance users. If the number of users is approaching the
license limit, contact DocuSign for upgrading the license MiniKey token.

If you received a license with an expiration date, periodically check it using the console to verify
it is not about to expire. Refer to Displaying DocuSign SA Status for instructions on how to view
the expiration date. Contact DocusSign for a replacement license MiniKey token before the
current key expires.

Note: In a high availability environment, the licenses of all the DocuSign Signature Appliances in
the high availability site should have an identical limitation on the number of appliance users.

Note: Store the backup MiniKey in a separate, secure place (e.g., a safe).

If you lose the backup MiniKey, you will not be able to perform some critical functions, such as
adding an alternate appliance, and performing a reset tamper operation. Therefore, make sure
that the backup MiniKey, as well as the second backup MiniKey, will be available when needed.
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Installing an Internal Certificate Authority

The CA Setup dialog box appears during the course of DocuSign SA software installation. It
enables setting up the DocuSign Signature Appliance to use an internal Certificate Authority (CA)
for generating end-user keys and certificates. This section describes in detail the various options
available in the dialog box.

LAtpE ||ntermnal Ca

L name:

Organizatiar:

Organizational Unit:

Lo |US Urited States
IJzers key size [hits):
Key type: I Secure ;I

¥ Use Default Settings for COP and &4 Locations
AlA Location: I

COP Locatian; I

Cé key size [bits]: |2n4a
[ Install as Subordinate G

Figure 26 CA Setup Dialog Box
To specify an Internal CA:
1. Specify Internal CA in the CA type field.
2. Enter the following information:

+ CA name — The identifying name of DocuSign SA’s internal CA. This name will also be
displayed as the Issuer Name in the certificates issued by the DocuSign Signature
Appliance.

¢ Organization — The CA’s organization. This field is included in the CA’s certificate.
This field is optional.
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+ Organizational Unit — The organizational unit of the CA. This field is included in the
CA'’s certificate. This field is optional.

Note: The Organizational Unit parameter in the certificate does not have to be identical
with the Users Container field in the Microsoft Active Directory, which is provided during
the Directory Setup (Figure 15).

Country — The CA’s country. This field is included in the CA’s certificate.

Users key size (bits) — The size, in bits, of the end-users’ generated keys. Bigger
RSA keys result in larger digital signatures and higher security. However, this results in
slower overall performance. Currently, the maximum user key size is 4096 bits.

+ Key type — The default Key Type is Secure.

*

*

Use Default Settings for CDP and AlA Locations — Select whether to use the
default settings for the AIA (Authority Information Access) and CDP (CRL
Distribution Paint) locations. If you choose not to use the default settings, enter the
desired settings:

AIA Location — AlA (Authority Information Access) is put into the end user’s
certificate and specifies where the DocuSign SA CA certificate is located in the
organization’s network.

The AIA can be accessed using the HTTP protocol, LDAP protocoal, a file in the
organization’s network, or a local file in the end user’s hard disk.

The value entered in this field will be included in every end user’s certificate that is
generated by DocuSign SA.

Deselecting the Use Default Settings for CDP and AIA Locations option while
leaving this entry empty, triggers a null AlA in the end user’s certificate.

The default value in the case of Active Directory includes the LDAP location. If the
default is not modified, the DocuSign SA installation will also put the DocuSign SA
ROOT certificate in the proper LDAP location.

In a Directory Independent environment, the default is an empty entry.

If the administrator decides to change the AIA default value, the administrator must
place the CA certificate in the location specified in the AlA. In addition, whenever the
CA certificate is renewed, the administrator must place it in the location specified in
the AlA.

CDP Location — CDP (CRL Distribution Point) is put into the end user’s certificate
and specifies where the DocuSign SA CA’s CRL (Certificate Revocation List) is
located in the organization’s network.

The CDP can be accessed using the HTTP protocol, LDAP protocol, a file in the
organization’s network, or a local file in the end user’s hard disk.
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The value entered in this field will be included in every end user’s certificate that is
generated by the DocusSign SA.

Deselecting the Use Default Settings for CDP and AIA Locations option while
leaving this entry empty, triggers a null CDP in the end user certificate.

The default value in the case of Active Directory includes the LDAP location. If the
default is not modified, DocuSign SA will constantly update the CDP with the
updated CRL.

In a Directory Independent environment, the default is an empty entry.

If the administrator decides to change the CDP default value, the administrator must
place the CRL in the location specified in the CDP.

For details on obtaining the DocuSign SA AIA and CRL, refer to Changing DocuSign SA
System Parameters.

CA key size (bits) — The size of the key of the CA.

Install as Subordinate CA — Select this option if you wish to install the DocuSign SA
CA as a subordinate CA.

You can install the DocuSign SA CA as a subordinate CA of another CA (who can be a
subordinate CA of another CA, etc.). This option is useful if you are installing DocuSign
SA in an organization with an existing CA or in cases where a national CA certifies
organizational CAs, and you wish to integrate into the existing infrastructure.

Note: Selecting the Install as Subordinate CA option will necessitate performing
various tasks before installation is complete. These tasks are described in detail in
Installing DocuSign SA as a Subordinate CA.

After completing CA Setup, return to the software installation procedure as follows:

+ If you are installing DocuSign SA in a Microsoft Active Directory Environment, continue
with Step 13.

If you are installing DocuSign SA in an LDAP based Environment, continue with Step 11.

If you are installing DocuSign SA in a Directory Independent Environment, continue with
Step 9.

Advanced Settings

The Advanced option available from the CA Setup dialog box enables the administrator to control
additional configuration parameters used by the DocuSign SA installation. These parameters
enable sending email notifications to end users during and after installation, and defining SSL
proxy parameters that are relevant when DocuSign SA is configured to use an External CA in
automated mode.
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Figure 27 Advanced Settings Dialog Box
+ Enable Email Notification — Check this option to direct DocuSign SA to send email
notifications to end users. Enter the following information:
¢ Mail server name — IP address or DNS name of the organization’s mail server.
+ Mail server port — The port number of the organization’s mail server.
+ Email from address — The address from which to send email notifications to users.

¢ Enable the server to use proxy for internet access — check this option to enable
DocuSign SA to communicate with the internet through an SSL proxy. This option is
relevant for cases where DocuSign SA is configured to use an External CA in automatic
mode, and the organization communicates via the Internet through an SSL proxy.
You can use proxies that require a user name and password authentication before
communicating with the external HTTPS server.

¢ Proxy’s address — The IP address or DNS name of the organization’s SSL proxy.
¢ Port — The port number of the organization’s SSL proxy.
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+ User name — The identity of the user being verified by the proxy.
+ User password — The password of the user being verified by the proxy.

Using an External CA in Manual Mode

This CA mode is the only available CA mode if DocuSign SA is installed in Common Criteria
EAL4+ mode.

If DocuSign SA is installed in an environment where an external CA is used in manual mode, the
DocusSign Signature Appliance will generate an empty account for the signing users, but will not
generate signature keys or certificates.

Each authenticated user of the appliance will need to manually enroll for a certificate. The
certificate generation process is as follows:

+ The user communicates with the certificate enroliment pages of the CA using client tools
that are executed in the end-user’s PC. One example of such a tool is a regular browser.
You can optionally use tools that are developed using SAPI or DocuSign SA RESTful API.

¢ During enroliment, a command to generate a key is sent from the DocuSign SA client to
the DocusSign Signature Appliance. The DocuSign Signature Appliance securely
generates a signature key for the user, and a certificate request is sent by the DocuSign
SA client to the external CA using the CA interface. The CA interface is usually a web-
based interface.

¢ The external CA generates a certificate and sends it to the user.

The user imports the certificate to the DocuSign Signature Appliance using the CA
application. This is usually a web-based application.
You can optionally use tools that are developed using SAPI or DocuSign SA RESTful API.

After the certificate is uploaded to the DocuSign Signature Appliance, the user can sign normally
using the newly uploaded certificate.

In this mode of work, the user must repeat this procedure upon certificate renewal.

Note: In a Common Criteria EAL4+ mode of operation, the user is required to activate his/her
account prior to any operation, including key and certificate enroliment as well as signing with
the generated signature key. For information on how to activate an account, refer to Performing
User Activation.

Using an External CA in Automated Mode

The CA Setup dialog box appears during the course of DocuSign SA software installation. It
enables setting up the DocuSign Signature Appliance to use an external CA whose ROOT
certificate is automatically installed in many workstations.

In this way, a document that is signed using DocuSign SA can be properly verified without having
to install the DocuSign SA ROOT certificate in all third-party workstations that need to verify the
signature of the document.

In this work mode, the end user’s keys are generated inside the DocuSign Signature Appliance.
Immediately after the key is generated, a certificate request is sent to the external CA. The
external CA replies with the user certificate.
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After the certificate is returned to DocuSign SA from the external CA, the end user can start
signing documents.

An example of scenarios in which an external CA is useful are cases where customers may wish
to use signing certificates that are part of a special program such as Adobe CDS, where the
certificate enrollment characteristics and parameters differ from those of the certificate provided
by the internal Appliance’s CA.

The following External CAs can be defined as part of the DocuSign SA installation:

¢ Comodo
¢ Symantec
The following sub-sections explain how to configure each of these external CAs.

Note that the organization’s policy may not allow direct communication between the DocuSign
Signature Appliance and the external CA. In such cases, you can optionally configure the
DocusSign Signature Appliance to communicate with the external CA through the organization’s
proxy server. To do so, you must configure the proxy settings defined in Advanced Settings as
part of Installing the DocuSign Signature Appliance Software.

Using an External CA in Automated Mode - Comodo

The CA Setup dialog box appears during the course of DocuSign SA software installation. It
enables setting Comodo as the external World Wide Verifiable CA in automated mode.
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Figure 28 CA Setup — Comodo World Wide Verifiable CA Dialog Box
To specify the Comodo CA:
1. Specify Comodo World Wide Verifiable CA in the CA type field.
2. Enter the following information:
¢ CA User Name — Contact DocusSign for a special user ID for communication with the
external CA.

¢ CA User Password — Contact DocuSign for a password for authenticating the
organization to the external CA.

¢ Users key size (bits) — The size, in bits, of the end-users’ generated keys. Bigger
RSA keys result in larger digital signatures and higher security. However, this results in
slower overall performance. Currently, the maximum user key size is 4096 bits, and
the minimum user key size is 2048 bits.

+ Key type — The default Key Type is Secure.
After completing CA Setup, return to the software installation procedure as follows:
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¢ If you are installing DocuSign SA in a Microsoft Active Directory Environment, continue

with Step 13.

If you are installing DocuSign SA in an LDAP based Environment, continue with Step 11.
If you are installing DocuSign SA in a Directory Independent Environment, continue with

Step 9.

Using an External CA in Automated Mode — Symantec

The CA Setup dialog box appears during the course of DocuSign SA software installation. It
enables setting Symantec as the External CA in automated mode.

Symantec as DocuSign SA’s Extemal CA.

Note: It is recommended to setup a Symantec Admin account before installing DocuSign SA
with the Symantec External CA. There are several parameters defined during account setup in
the Symantec Portal that are required for the DocuSign SA installation. For information on
setting up an account, refer to Creating a Symantec Profile Preparatory to Configuring

Symantec website.

Note: The process of setting Symantec as the External CA involves direct interaction with
Symantec (http://www.symantec.com). For more information on Symantec, refer to the

CA setup

C4 type: Symantec World YWide Werifiable Ca

Organization: |

QOrganizational U nit: |

Locahty: |

Country: |US United States

Users key size [bits): |2048

ey type: |Secure j Advanced...
-

|

|

2045
-

< Back

Figure 29 CA Setup — Symantec CA Dialog Box
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To specify the Symantec CA:

1.
2.

Specify Symantec World Wide Verifiable CA in the CA type field.
Enter the following information:

+ Users key size (bits) — The size, in bits, of the end-users’ generated keys. Bigger
RSA keys result in larger digital signatures and higher security. However, this results in
slower overall performance. Currently, the maximum user key size is 4096 bits.

You should use a key size of 2048 bits.

+ Key type — The default key type is Secure.

If you are installing DocuSign SA in a Microsoft Active Directory Environment, continue
with Step 13.

If you are installing DocuSign SA in an LDAP based Environment, continue with Step 11.

If you are installing DocuSign SA in a Directory Independent Environment, continue with
Step 9.

When installation is complete, the following message appears:

The first phase of CoSign installation with External CA completed successfully.
To completely end the installation please upload PKC5#12 (.pfx] file produced by
the CA

for authenticating CoSign. For more information please refer to CoSign user
manual,

Figure 30 External CA Installation message

At this stage final installation is postponed until CA information is uploaded to the
DocuSign Signature Appliance. No user information is generated, and thus no user can
perform a digital signature operation until CA information upload is complete.

Upload CA information to DocuSign SA, as described in Uploading CA Information to
DocuSign SA.

At the end of the process, DocuSign SA will be fully interfaced with the Symantec service
for the purpose of automatically managing DocuSign SA users’ certificates.

Uploading CA Information to DocuSign SA
Upload the CA information to DocuSign SA using the DocuSign SA Administration MMC.

1. Open the Start menu and select Programs - DocuSign > Signature Appliance >

Signature Appliance Control Panel.
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2. Inthe DocuSign SA Control Panel, select Appliances Management.

The DocuSign Signature Appliance Management window appears, showing all installed
DocuSign Signature Appliances.

Note that the current state of the DocuSign SA installation is Waiting for PFX from CA.

3. Right-click the DocuSign Signature Appliance, and select All Tasks > Upload CA
Information.

The Upload CA Information window appears:

PK.CSH12 file [ pfs] Browse. .. |

File Paszword

Accaunt Mame

Account profile D

Cancel |

Figure 31 Upload CA Information Window

4. Enter the following information, and then click OK:

¢ PKCS#12 file (.pfx) — Browse to the PKCS#12 authentication key file provided by the
Symantec portal. The default file name is RA-certificate.pfx.

File Password — Enter the protection password provided by the Symantec portal.

Account Name — Enter your account Number in Symantec. To obtain your Account
Number, click the Settings icon (Figure 43) and select the Manage account and sub-
accounts option. In the Manage Accounts window that appears, note the number
under the account name. This is the number to be entered to the Account Name field.
In the example below, the number is 775243.

& Manage accounts ‘ ¥ Add accounts

All accounts

Search operations: 1 account

All available accounts are displayed. _u: DocuSign-TEST12
= 775243

Figure 32 Manage Accounts
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+ Account Profile ID — This information refers to the certificate profile used. To obtain
the profile ID, click the Settings icon (Figure 43) and select the Manage Certificate
Profiles option. In the Manage certificate profiles window that appears, select the
relevant certificate profile, which is My Certs in the example below. Note the Certificate
Profile OID. This is the dotted numbered string which you should enter in the Account

Profile OID field. In the example below, the profile ID is:
2.16.840.1.113733.1.16.1.2.5.6.1.149026865

' Manage certificate proﬁ|¢5 | % Add cerfificate profiles -] Manage custom scripts

Al certificate profiles

Search operations: 1 certificate profile 1 certificate profiles selected My Certs
[
Search by: My Certs Customize options u g  Seatpool: User
& Mode Test
Show all v - ¢ Adobe® Individual (Test Drive) Hide profile Status Active
iteria: Test
(130 GTLEEE e Suspend profile Certificate Profile OID 2.16.840.1.113733.1.16.1.2. 5.6 1149026865
Show all M Move profile to production Issued 0
Include hidden certificate profiles Pending pickup 0
@ Revoked 0

Manage this profile

You will need to integrate PKI Web Services into your end-user certificate management applications.
Download the PKI Web Service package (including documentation).

(' Select where PKI Manager obtains identifiers for the user. Seat ID is used to uniguely identify
- S S, S, v, S —

Figure 33 Manage Certificate Profiles

After you click OK, the authentication Private Key and certificate are uploaded to the

Appliance and used as part of the communication between the DocuSign Signature
Appliance the Symantec.

5. If Active Directory is used, user synchronization is performed automatically.
This operation results in DocuSign SA generating a signature key for each user and
receiving a certificate for this user from Symantec.

In a Directory Independent environment, you must activate the Users Management utility

to create DocuSign SA users and generate keys and certificates for them (refer to Using
the Users Management Utility).

Note: In an LDAP environment or Active Directory multiple domain environment, a new
account is generated when the end user first attempts to connect to DocuSign SA.

Note: It is very important to save the Account Name, Account Profile ID and any other
information related to accessing the Symantec account such as the admin software key and the
password to access this key. You will need these when your authentication key file expires and
you need to renew it.

For more information on how to renew your authentication key file, refer to Renewing the
Symantec Authentication Key File

Verifying end-users can use the Symantec CA

In order to get properly generated certificates from Symantec CA, the following needs to be taken
care of for every user that is supposed to get a certificate:
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¢ The user should have an email address either in his/her Active Directory/LDAP account or
in his/her DocuSign SA account. If there is an empty email address for the user, a
certificate will not be issued for this user.

¢ The user should have a first name and last name in his/her Active Directory/LDAP account
or in his/her DocuSign SA account. If one of these attributes are missing, a certificate will
not be issued for this user.

Note: The Appliance administrator can view all users that failed to receive a certificate from the
Symantec CA service, by viewing the DocuSign SA log file.

Creating a Symantec Profile Preparatory to Configuring Symantec as DocuSign SA’s
External CA

If you are planning on using DocuSign SA with the Symantec External CA, it is recommended
setup a Symantec Admin account before installing DocuSign SA. There are several parameters
you define during account setup in the Symantec Portal that are required for the DocuSign SA
installation.

Configure the following in Symantec before installing DocuSign SA:
1. Creating a New Account for the Organization in Symantec

2. Creating a profile in Symantec

3. Defining a Software based Key

4. Uploading the Certificate Request File to the Symantec Portal

Creating a New Account for the Organization in Symantec
To create a new account for the organization in Symantec:

Note: If you wish to open a Production account, contact Symantec for more information on how
to initiate opening a production account.

1. Go to https://www.symantec.com/theme/free-trial-mpki and fill in the registration
information.

2. After submission you will receive an activation email. Click the activation link to start the
process of installing the Symantec PKI Client and an administrator certificate. The
Symantec PKI Client will enable you to access the Symantec portal and acts as a browser
extension.

The following message appears after pressing the activation link:
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@Symantec. PKI CERTIFICATE SERVICE

Install Symantec Authentication Client Plugin extension

You need to install Symantec Authentication Client Plugin extension before you can enroll for your certificate.
Symantec Authentication Client Plugin extension lets your browser communicate with Symantec PKI Client to
manage your certificates.

Prerequisites:

* You must have local administrator rights on your computer.
s Your browser security setting should not be set to High.

Overview of Symantec Authentication Client Plugin extension installation:

Download the Symantec Authentication Client Plugin extension.

Click Download. If prompted, click Add to add the extension into your browser. Then, click Run.

Install the Symantec Authentication Client Plugin extension.

Follow the prompts to install the plugin extension.

If prompted, install PKI Client.

Follow the prompts to install PKI Client.
Enroll for a certificate.

After you install PKI Client, you will need to reboot your system. Once you have rebooted your system
find the enrollment email and click on the link to begin the enrollment process again.

Download

Legal Nofices | Privacy
Copyright @ 2016 Symaniec Corporation. All ights reserved.

Figure 34 Install Symantec PKI Client Plugin Extension

3. Download and install the Symantec PKI Client software (if not installed already). This is a
standard installation that ends with the following window and a restart:
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1 Symantec PKI Client Setup

Installation Wizard Completed

Setup has finished for Symantec PKI Client.

The Installation Wizard has successfully installed Symantec PKI
Client. Click Finish to exit the wizard.

Symantec.

Back | Finish |

e
= ) L=

i

Figure 35 Symantec PKI Client Setup — Installation Complete

4. After the Symantec PKI client is installed, continue and install the administrator certificate
by clicking Install Certificate in the window below:
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@Symantec. PKI CERTIFICATE SERVICE

Enroll: Confirm your identity Install certificate Confirm access

Install your certificate

Review these installation steps, and then click Install certificate to begin the process.

Either create a PIN or enter your existing PIN to protect your certificate:

« |f this is the first certificate you are installing, create and confirm your PIN. You need to enter this
PIN each time you use your certificate.

Remember this PIN!
If you forget this PIN, you will not be able to use your certificate, and you will need to repeat the
enrollment process to install another certificate.

« |f you have previously installed a certificate on your computer, enter your existing PIN.

'4 Wait for the certificate to be installed on your computer

Install certificate

Legal Mofices | Privacy
Copyright @ 2016 Symantec Corporation. All rights reserved.

Figure 36 Selecting to install a Symantec PKI certificate

5. In the following Create your new PIN window that appears, enter the Pin Code that will
enable you to access a locally generated software key and thus access the Symantec
portal as an administrator and configure your account.
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Create your new PIN

You will need to enter it each time you use your
certificate.

Remember this PIN!.
If you forgot it, you will need to repeat the
enrollment process to install another certificate.

New PIN:

Repeat PIN:

Figure 37 Create your new PIN - Symantec PKI

6. When you are prompted with the following message, you can logon as an administrator to
the trial system:

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide

@Symantec. PKI CERTIFICATE SERVICE

Enroll: Confirm your identity Install certificate

Your certificate was successfully installed.

Confirm access to Symantec PKI Manager

Log in now to confirm that you can access PKI Manager. You should see the PKI Manager home page.

Log in now

Legal Nofices | Privacy
Copyright @ 2016 Symantec Corporation. All rights reserved.

Figure 38 Confirm Access - Symantec PKI

Note: There is a difference between this administrative account that enables you to
connect to the Symantec portal for the purpose of configuration and watching status
information, and the administrative account that will be used by the DocuSign Signature
Appliance to access the Symantec portal as a Registration Authority (RA) for generating
certificates for users that have signature keys inside the DocuSign Signature Appliance.

7. Each DocusSign SA user certificate is associated with a Symantec certificate template,
which is defined as a Certificate Profile entity in the Symantec CA service.
Connect to your Symantec account by clicking Log in now (Figure 38) and create a new
Certificate Profile as described in Creating a profile in Symantec.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide E

Creating a profile in Symantec

Manage certificate profiles

Figure 39 Selecting Manage Certificate Profiles
Log into Symantec.

2. Click the Manage Certificate Profile icon and then use the Add Certificate Profile
option.

3. Inthe Select mode screen, select the Test Mode option.

In the Select template screen, select the type of certificates to use. In test mode, please
select Adobe Individual (Test Drive).

Note: Consult with DocuSign which certificate type to use if you require a different
certificate type.

5. In the Customize options screen:
a. Enter Certificate Friendly Name for the certificate profile.
b. Set the Enroliment method to PKI Web Services and click OK.
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Create profile: [: Select mode [: Selecttemplate [ Customize options [ Customize services

Customize certificate options
Review and change the template options for this profile.

Certificate friendly name:

Primary certificate options

Certificate authority:

Shared Symantec Test Drive... Enroliment method:

Enroliment method: PKI Web Services v

PKIWeb Services

Use Web Services if you will develop your own certificate

Authentication method: management application to replace the PKI Certificate
3rd party application M Services for your users.
VrEi
Advanced options
| Back | | Cancel | | Preview | | Save

Figure 40 Creating a Symantec Profile — Customize options

6. Click Advanced options. The Certificate Fields section appears. Modify the fields so
you get the following list. Basically the Locality field should be added and the
Organizational Unit fields should be removed and added:

Common Name — Required and included in Webservice Request

Email — Required and included in Webservice Request

Country — Required and included in Webservice Request

Organization — Is a fixed value and determined by the account name

Locality — Required and included in Webservice Request

Organizational unit — this item should be removed and inserted again with Required
—Yes and included in Source for the field’s value - Webservice Request.

* & & o o
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Certificate fields

Subject DN &) Add field

Common Name (CN)

Source: Webservice Request rg
@) Required: Yes L
@ Email
Source: Webservice Request rﬁ
& Required: Yes L
ﬂ Organizational Unit (OU) Undo
Source: Fixed value
@ value: ADOBE(r)}-AATL
& Country
Source: Webservice Request r"::
&) Required: Yes L
& Organization (O}
Source: Fixed value r":';
@ Value: DocuSign-TEST12 L
@ Organizational Unit (OU) ®

Source: Webservice Request
Fequired: Yes

Add certificate field

Select a field to add to the certificate and define the value
for the new field.

Certificate field:
| Organizational Unit (OU) v |

Source for the field's value:
Webservice Request v |

Required ?
® ves
Mo

Figure 41 Certificate Fields

7. Add the following additional extensions:

¢ Adobe CDS Custom Extension for Time Stamp
¢ Adobe CDS Custom Extension for OCSP Revocation.

8. Go to Additional Extensions and mark these extensions as True. They are marked as

False by default.

9. In the additional certificate option make sure the key size is 2048 bits
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Additional Extensions &y Add
Extension

Symantec Certificate Profile ... celect M

Adobe® CDS Custom Extension for Time Stamp

S TEE BT S R B ﬁdube@ DS Custom Extension for QCSP Hevucatinn‘

Subject Key ldentifier

Undefined field o

Figure 42 Additional Extensions

10. Save the Certificate Profile.

Defining a Software based Key

DocuSign SA interacts with Symantec using a client authentication scheme based on a software
token. To define the software based key, open a Command Prompt window and use the special
DocuSign SA tool that is based on the OpenSSL library to generate the software key and its
matching authentication certificate, as follows:

1. Getthe PFXCreation.zip package and extract it to a certain directory in your PC (for
example, c:\tmp\pfx).
Open a Command Line application, such as cmd.exe, and go to the above directory.
Run the Set.bat command
Run the CertRequest.bat command. Keep in mind:
a. Before running the command, call the following command set RANDFILE=.rnd

b. While running the command, you will be asked to provide some application related
information:

Enter a valid two letter code for your country name.
In the Common Name field, enter your Symantec account name.

In the Email Address field, enter your email address as configured in your
Symantec account.

¢ The challenge password can be left blank

An RSA key will be generated and afterwards a certificate request file will be created. The output
file CSR.csr is the certificate request file. This file should be uploaded to the Symantec portal, as
described in Uploading the Certificate Request File to the Symantec Portal.
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Uploading the Certificate Request File to the Symantec Portal

1. Inthe PKI Manager Console, click the Settings icon and select the Get an RA Certificate
option.

ectwhe
Jser sed

Users and certificates
Manage users

it 1D: Manage cerificates

T email i
Manage cerfificate profiles

Manage authorized user lists

Reporting
View recent reporis

Schedule a report

L view audit trails

ails: Your account

Manage account and sub-
accounts

Manage administrators

sipients Manage CAs

IEL  Manage PKI Enterprise Gateways
Getan RA cerlificate

Get a signing authority cerfificate

v

B 1l @

i i
Figure 43 Symantec Settings Options

2. Inthe Get an RA Certificate page that appears, paste the contents of the CSR.csr file
(created in Defining a Software based Key) into the Paste your CSR field.
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Get an RA certificate

If you are setting up PKI Enterprise Gateway or PKI Web Services, you must install an RA cerificate to secure
communications between your client and the Web Service.

If you are not setting up these services, or have already gotten your RA cerificate, you do not need to complete this
process.

Enter Certificate Signing Request (CSR)

Ask your server administrator to generate a CSR for your RA certificate. Your administrator must generate the CSR
according to the instructions in the installation guide for your service.

You can access the resources page by clicking on the @ icon on the dashboard.

*Paste your CSR:

.

Important Sernvice Requlrements Ifyou discover or have reason to believe that there has been a compromise of your private key,
you must immediately revoke the certificate or notify the issuing center to do so. Similarly, if the information within your certificate or
your organization name has changed, please notify the issuing center. Note that the issuing center retains the right to revoke your
certificate at any time without notice if (i) you fail to perform your obligations under the terms of your service agreement; or (i} in the
issuing center's sole discretion, you have engaged in activities which the issuing center determines are harmful to its systems.

Enter a certificate friendly name:

* Required informaticn

Cancel ‘| Continue

Figure 44 Get an RA Certificate Page

3. When the Your CA certificate is ready window appears, click Download to download the
authentication certificate.
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@Symantec. PKI CERTIFICATE SERVICE

Your RA certificate is ready
Your RA certificate must be installed on the server where your PKI Enterprise Gateway or PKI Web Services
is installed.

Install your RA certificate
1. Download your RA certificate.

Issued to:
DocuSign-TEST12

Expiration date:
Dec 18, 2016

File format:
PKCS #7

2. Forward the RA certificate to your server administrator. Your administrator must follow the instructions in
the installation guide for your service.You can download the appropriate installation guide from the resources

page by clicking on the U icon on the dashboard.

Figure 45 Your RA certificate is ready

4. Place the file named RA-Certificate.p7b in the directory in which you placed the
PFXCreation.zip package (refer to Defining a Software based Key), and run the command
cert_import.bat. You will be requested to provide a password that protects the pkcs#12
based file format that encapsulates the Software Key and the authentication certificate.

Remember the provided password. It will be used when uploading the pkcs#12 key to
DocuSign SA.

The file RA-certificate.pfx now contains the authentication key and certificate file that will be

uploaded to DocuSign SA and used for accessing the Symantec Service from the DocuSign
Signature Appliance.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide

Note: You can continue using this administrative portal to view the status of all certificates that
are linked to this account. However, you should not perform any direct action on these
certificates or modify any of the account parameters, since this can cause the service to become
non-operational.

Instead, user certificates should be managed by the DocuSign SA through the DocuSign SA’s
interface to the Symantec service.

Installing DocuSign SA as a Subordinate CA

This section applies to users who selected the option Install as Subordinate CA in the CA Setup
dialog box (refer to Installing an Internal Certificate Authority). The sections describing the
software installation process in each of the three environments (Active Directory, LDAP, and
Directory Independent) refer you to this section just before the end of the installation process,
after inserting the license MiniKey token.

You are prompted to perform the following tasks, after which DocuSign SA installation is
complete:

1. A File Selection dialog box appears, prompting you to supply the name of the file that will
contain the Certificate Request (CRQ) that should be submitted to the ROOT CA.

Prior to this step, the DocuSign Signature Appliance internally generated a key for the
DocuSign SA CA, and then created a certificate request based on the generated key.
DocusSign SA then exported the CRQ that should be sent to the ROOT CA.

2. Specify the name of the CRQ file.

The Subordinate CA Installation dialog box appeatrs:

The first phase of the Signature Appliance installation with subordinate CA
completed successfully.

Please perform the following steps:

1. Upload the root CA's root certificate,

in case of certificates chain upload one certificte at a time.

2. Using the certificate request stored in

'ChUsers), ', [} ecltophaaaaaaa.crg,

submit a certificate request to the root CA.

3. Upload the certificate reply issued by the root CA.

Figure 46 Subordinate CA Installation Dialog Box

The Subordinate CA Installation dialog box lists the tasks you still need to perform before
DocuSign SA users can be created. The following steps describe those tasks.
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3. Exit the DocuSign SA Administration MMC.
4. Submit the Certificate Request to the ROOT CA by providing the CRQ file.

The files you will eventually receive back from the ROOT CA include a group of files that
constitute the complete chain of CA certificates, and the Certificate Reply file that contains
the new DocuSign SA subordinate CA certificate. The DocuSign SA subordinate CA
certificate can also be packaged in certificate format (. cer) and not necessarily in a
certificate reply format (. crp).

Note that if a ROOT CA certified DocuSign SA, the complete chain of CA certificates
includes only the ROOT CA certificate.

Note: Make sure that the certificate reply contains only the DocuSign SA certificate and
does not contain any of the certificates that are part of the certificate chain.
The certificates in the certificate chain are loaded separately.

Note: The file formats of the certificate and certificate chain must be ASN.1(DER)
encoded. If the files are encoded in BASE64 format, they must be converted.

If the DocuSign SA subordinate CA certificate is encoded in BASE64 format, you can
use the Microsoft standard certificate information utility to browse to that BASE64
certificate, and use the copy to file option to save the certificate to a DER encoded

certificate.

Once you receive the files from the ROOT CA, activate the DocuSign SA Administration
MMC by opening the Start menu and selecting Programs > DocuSign > Signature
Appliance > Signature Appliance Control Panel.

Select Appliances Management, and the DocuSign Signature Appliance Management
window appeatrs.

6. For each file in the chain of CA certificates, perform the following:

+ Right-click the relevant DocuSign Signature Appliance and select All Tasks 2>
Subordinate CA -> Load ROOT Cert Chain.

File Action View Help
L AR ANEEY

{# DocuSign Signature Appliance || Address Version  Serial Number  Status Role Actions
«0 Sa‘g'lzt“'eﬁﬂﬂ'ia”‘es 110654837 82 CSN020T6 Waiting for CRE Primary Signature Appliances  «
|—I—!\II Tasks v Login v More Actions
Refresh =gy
Upload Software
RS Synchronize 3
Clear CA Files
Downlead Logs 3
Restart b
High Availability 3
Subordinate CA v Load Root Cert Chain
Upload SSL Certificate Upload Certificate Reply
Upload CA Information Download Certificate Request
g 2| Signature Appliance Performance Monitor 3
Subordinate CA tasks License »

Figure 47 Subordinate CA Installation — Loading the CA Certificates
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A file selection window pops up.
+ Specify the path and file name of the CA certificate.

After each certificate is loaded, the following message appears: Uploading root
certificate chain finished successfully.

7. Right-click DocuSign Signature Appliances and select All Tasks - Subordinate CA >
Upload Certificate Reply.

A dialog box appears, prompting you to specify the Certificate Reply file, which contains
the new DocuSign SA subordinate CA certificate.

8. Specify the path and file name of the Certificate Reply.

A message appears: Waiting for the CA service to restart... and soon after DocuSign SA
proceeds with the installation process. In an Active Directory, DocuSign SA now automatically
creates DocuSign SA users and generates keys and certificates for them. In a Directory
Independent environment, you must activate the Users Management utility to create DocuSign
SA users and generate keys and certificates for them (refer to Using the Users Management

Utility).

Note: In an LDAP environment or Active Directory multiple domain environment, a new account
is generated when the end user first attempts to connect to DocuSign SA.

At the end, the following message is displayed: Uploading certificate reply finished
successfully.

The created DocuSign SA users can now connect to DocuSign SA and perform digital signature
operations.

Note: Keep in mind that setting up DocuSign SA as a subordinate CA requires further
administrative attention. The subordinate CA certificate should be renewed according to the
ROQOT CA policy. It is recommended to start the renewal process a month before certificate
expiration.

Multi-Language Support

You can deploy DocuSign SA in environments that allow the use of non-ASCII characters in fields
such as the user's common name in the certificate, etc.

However, due to system limitations, there are cases where multi-language environments cannot
be supported. For more information about these limitations, refer to the DocuSign SA release
notes.
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Chapter 4: Deploying the DocuSign SA Client

This chapter describes how to:
+ Deploy the DocuSign SA Client, in a Microsoft-Active Directory environment, LDAP based
environment, or a Directory Independent environment.
Use the DocuSign SA Control Panel.

Use the graphical signature management application that enables setting a graphical
signature for users of the organization.

+ Install the ROOT certificate to validate DocuSign SA signatures in an organization without
DocuSign SA.

¢ Use DocuSign SA Verifier to validate digital signatures that were attached to Microsoft
Office documents using DocuSign SA.

Note: The installation of DocuSign SA differs slightly depending on whether it is being
installed in a Microsoft Active Directory environment, LDAP based environment, or
Directory Independent environment. These differences are mentioned where applicable.

Deploying the Client

DocuSign SA enables the end-user to digitally sign transactions, documents, and other types of
data. In order to perform these tasks, the DocuSign SA client must be installed. The DocuSign SA
client enables applications (e.g., Microsoft Word) to use DocuSign SA for generating digital
signatures. For more information on generating signatures in third-party applications, refer to the
DocuSign SA User Guide.

The DocuSign SA client may be installed on a machine using one of the following operating
systems:
¢ Windows 2008/Windows 2008-R2
Windows 7
Windows 8
Windows 10
Windows Server 2012

* & o o

Note: The DocuSign SA client can be also be installed in any 64 bit variant of the above
operating systems, such as Windows 7 64 bit.

Deployment Options

The DocuSign SA client can be deployed on an end-user machine, a terminal server, a Web
server, or application server.
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On an End-User Machine

Deploying the client on an end-user machine enables end-users to use DocuSign SA for
generating digital signatures on documents, transactions, or other types of data. Each client
installation generally services one end-user.

On a Terminal Server

Deploying the client on a terminal server (e.g., Citrix Server or Microsoft Terminal Server) enables
multiple users to concurrently use DocuSign SA for signing and validating signatures. This
circumvents the need to install the client on each end-user’'s machine.

End-users connect to the terminal server and use the installed applications (e.g., Microsoft Word
or Outlook) remotely. If the end-user wishes to sign a document, the signature is attached in the
terminal server via the installed DocuSign SA client.

On a Web Server or Application Server

You can deploy the DocuSign SA client on a Web server. This enables multiple end-users to use
DocuSign SA for generating signatures in Web applications without deploying the client on every
end-user’s machine, and without requiring the end-user machines to be part of the domain.

DocusSign provides digital signature APIs through a C/C++ interface or COM interface. These
Signature APIs are explained in detail in the DocuSign SA Signature APIs Developer’s Guide.
When the end-user wants to add a digital signature, the Web application prompts the end-user for
a login name and password. Through DocuSign SA’s SAPI COM interface, the Web server
creates a signature using DocuSign SA by providing the end user’s credentials (User ID,
password, and domain name). The digital signature value can then be attached to the signed data
by the Web application.

In addition, a web server can use DocuSign SA through a Web Services interface, which is
executed in the DocusSign Signature Appliance. An additional Web Services interface that is
based on a RESTful API can optionally be used.

For more information, refer to the DocuSign SA Signature APIs Developer’s Guide.

The DocuSign SA client can also be installed on a Microsoft SharePoint server.
For more information, refer to the DocuSign SA Connector for SharePoint User Guide.

The DocuSign SA client can also be installed together with a DocuSign SA Web App deployment
on a Microsoft web server. For more information, refer to the DocuSign SA Web App User Guide.

Installing the DocuSign SA Client

The DocuSign SA Client can either be installed directly from the DocuSign Signature Appliance
CD or automatically using a centralized mechanism. Regardless of how the client is deployed, the
client must be installed on the appropriate machine with all the relevant plug-ins.

Note: You must have local administrative rights in order to install the DocuSign SA client.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide m

Note: If the DocuSign SA internal CA is used for generating end user’s certificates, then for all
environments except Microsoft Active Directory, the ROOT certificate must be manually installed
on every workstation on which a DocuSign SA client is installed. Refer to the section Installing
the Root Certificate and DocuSign SA Verifier in the DocuSign SA User Guide.

DocuSign SA Client Components

The DocuSign SA Client CD displays a DocuSign SA Client Components Installation screen
when the DocusSign SA Client CD is inserted into the CD driver.

Each DocuSign SA component is based on several .msi files. The .ms1 files are based on the
Microsoft Software Installation technology.

The components include:

¢ DocuSign Signature Appliance Client — The standard DocuSign SA client
installation without any plug-ins. The installation includes the following .ms1 files:

¢ DocuSign CryptoKit — Provides the basic standard Cryptographic APIs, which
include PKCS#11 and MS-CAPI. These API enable off-the shelf products, such as MS
Outlook and MS Office 2010/2013/2016, to use DocuSign SA without any integration
efforts.
For more information about CryptoKit, refer to the CryptoKit documentation.
The CryptoKit installation file name is ARX CryptoKit Basic.msi. The 64 bit
CryptoKit installation file name is ARX CryptoKit Basic64.msi.

¢ ARX CoSign Client.msi — Provides the basic functionality for interfacing with the
DocuSign Signature Appliance.
The installation file name for 64 bit name is ARX CoSign Client64.msi.

¢ ARX Signature API.msi — Provides signature APIs for enabling OEMs to use
DocuSign SA with a minimal development effort.
The APIs also include a COM-based interface that enables applications to use
DocuSign SA.
The Signature API installation file name for 64 bit operating systems is ArRx
Signature API64.msi.
For more information about the Signature API, refer to the DocuSign Signature
Appliance Signature APIs Developer’s Guide.

¢ DocuSign Signature Appliance admin — Enables administrators to install and
manage DocuSign SA. The installation and management activities are described in
Chapter 3: Installing DocuSign SA and Chapter 6: Using the DocuSign SA Consoles.
The DocuSign Signature Appliance admin componentis based on the following
.ms1i files:

¢ ARX CoSign Admin Client.msi — Includes all the administrative components of
DocuSign SA. For example, it includes the DocuSign SA Administration MMC for
managing the DocuSign Signature Appliance.

¢ ARX Signature PAD.msi — Includes all the software necessary for installation of
the graphical signature pad and the utility that controls the pad.
For more information, refer to Using the Graphical Signature Management Application.
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¢ Microsoft Office (Word, Excel)— Two types of plug-ins are supported:

¢ DocuSign SA Signature Line Provider — A digital signature plug-in for Office
2010/2013/2016 for the .docx and . x1sx file types.

¢ DocuSign SA Legacy Word Add-in — A digital signature plug-in for Word
2010/2013/2016 and Excel 2010/2013/2016 that enables you to sign .doc and .x1s
files.

For more information, refer to Signing Microsoft Office Documents in the DocuSign SA
User Guide.

¢ DocuSign SA Prepare and Sign — A plug-in for signing any printable data from any
application. For more information, refer to Prepare & Sign — Signing PDF and non-PDF
Files in the DocuSign SA Client User Guide.
The DocuSign Prepare & Sign printer file name is ARX OmniSign Printer.msi. The 64
bit name is ARX OmniSign Printeré64.msi.

Installation Pre-requisites

¢ To perform signatures using Office 2010/2013/2016 upon .docx or . x1sx files, it is
mandatory to install .NET Framework version 4 on the client machine. .NET Framework
version 4 is normally installed by default in Windows machines.

¢ If you intend to use the DocuSign SA add-in for Microsoft office, you should include the
component called "Visual Basic for applications" when installing Microsoft Office. This
component is included in the Microsoft Office installation by default.

Installing the Client Directly from the CD
To install the DocuSign SA client directly from the CD:
1. Insert the DocuSign Signature Appliance CD into the CD drive.

2. If you are using Windows 7 and above or Win2008R2 and above, you are prompted to
select a language. Select the desired language from the list and press OK.
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Docus;vgn_ o |
* Welcome to DocuSign Signature Applian

Signature Appliance

Selectyourlanguage:

English

Cancel

Figure 48 Language Selection Window

The language selection will affect the installation screens, and all end-user Client GUI
elements such as Prepare & Sign, the DocuSign SA Word Legacy add-in, etc. It will not
affect the Configuration Utility or any administrative tools.

The following DocuSign Signature Appliance screen appears:
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DOCUSL?M/: Signature Appliance

Documentation | Support | Contact Us

| DocuSign Signature Applance Client

Signature Applance Admin:

Select supported applications:
Microsoft Office (Word, Excel, InfoPath)

DocuSign SA Printer

Install Mowe

Figure 49 DocuSign Signature Appliance Screen

3. Select the components you wish to install, based on the designation of the current
workstation. Keep in mind the following:
¢ The DocuSign Signature Appliance Client component is always selected.

+ If the workstation is an administrative workstation, select the Signature Appliance
Admin component.

+ If the workstation is a user workstation, select the applicable components: Microsoft
Office, or DocuSign SA Printer.

Note: The Microsoft Office component is automatically selected if Microsoft Office is
installed in the end-user machine.

Note: The DocuSign SA Printer component installs a new virtual printer in the end-user’s
machine.

4. Click Install Now.

When installation is complete, a ¥ appears next to each of the installed components. In case of a
failure, an X appears next to the relevant components and a summary information box appears.

Alternatively, you can place the contents of the DocuSign SA CD on the network so that end
users can install the DocuSign SA Client through the network. While this method eliminates the

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 102

need to use the CD for each installation, it does not facilitate automatic installations of the
software.

Automatically Deploying the Client

Refer to Appendix B: Centralized DocuSign SA Client Installation for information on how to
automatically deploy the DocuSign SA Client on various end user platforms.

Uninstalling the DocuSign SA Client

Uninstall the DocuSign SA client either locally, or automatically using Microsoft Active Directory.

Uninstalling the DocuSign SA Client locally:

To uninstall the DocuSign SA client locally:

1. Open the Start menu and select Programs > DocuSign > Signature Appliance >
Uninstall Signature Appliance Components.

A confirmation box appears. Click Yes to uninstall. The uninstalling process begins.
3. When the DocuSign SA Client is uninstalled from the workstation, a message box appears
to inform you that the system finished uninstalling. Click OK.
Uninstalling the Client in an Active Directory Environment

Refer to Appendix B: Centralized DocuSign SA Client Installation for information on how to
centrally instruct all clients to uninstall their DocuSign SA client installation.

Distributing DocuSign SA Information through the SCP

The DocuSign SA client requires some basic information about the DocuSign Signature Appliance
in order to be able to communicate with it. For example, it must know the IP address of the
DocusSign Signature Appliance.

When DocuSign SA is installed in Microsoft Active Directory, all DocuSign Signature Appliances
update a specific location in the directory called SCP (Service Connection Point) with the
necessary information. The DocuSign SA Client automatically updates itself with the necessary
information from the SCP.

The following sections provide a description of SCP usage in Microsoft Active Directory.

In an LDAP or Directory Independent environment, you must manually configure each DocuSign
SA client with the necessary information using the Configuration Utility (refer to Chapter 8:
DocusSign SA Configuration Utility). If you wish, you can also use the Configuration Utility to
manually configure each DocuSign SA client in an Active Directory.

Note: You can use the administrative configuration utility to generate a configuration and
distribute it to clients using either a group policy or through other mechanisms such as a login
script. For more information, refer to Appendix B: Centralized DocuSign SA Client Installation.
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Microsoft Active Directory SCP

To view the DocuSign SA SCP in a Microsoft Active Directory:

1. Inthe DocuSign SA Administration MMC, navigate to Active Directory Sites and
Services > Services > NetServices.

The list of DocuSign Signature Appliances in the network is displayed. Each DocuSign Signature

Appliance is listed under the name DocuSign SA Service Connection Point For CSN00001 where
CSNO0O001 is the specific DocuSign SA serial number.

7111 Consolel - [Console Root' Active Directory Sites and Services [do

_|ol x|
J"& Console  window  Help

DS E| @ |-18x|

“ Ackion Wiew  Fawvarites |J = o= | | = | @ |
Tree I Favarites | Marme | Type

| Descrip
[ Console Root

- ADST Edit

g Active Directory Users and Computers [domainZ ., CaSignz.ar.c

[=] Active Directory Sikes and Services [domain2 . CoSignz. arx.com
- Sites

ED Services
Msma3ervices
EID MetServices

(C05ign Service Connection Point For CSMO0041
P D ZoSign Service Connection Poink For CSMO0047

H : D CoSign Service Connection Poink For sig00000
F-[Z] Public Key Services

- RRAS
B Windows NT

| | i |
|

| |
Figure 50 Active Directory SCP

Each entry in the list represents a DocuSign Signature Appliance. The following information is
available about each DocuSign Signature Appliance (the information cannot be viewed through

the Net Services window):
¢ DocuSign SA IP address.
¢ DocuSign SA listening port number.
+ DocusSign SA availability status (Up or Down).

Note: In rare cases where the DocuSign SA availability status does not reflect the actual
status of the appliance, you can manually set the Up/Down state of a DocuSign

Signature Appliance using the setscp utility. Refer to SetSCP in Chapter 5: Managing
the DocuSign Signature Appliance.

¢ DocuSign SA prompt for logon parameter value — Directs the client whether to

present a logon popup window for accessing DocuSign SA, or whether to use Microsoft
mechanisms.
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¢ DocuSign SA prompt for sign parameter value — Directs the client whether to display
a password window for every signature operation.

The SCP information is updated by each DocuSign Signature Appliance upon installation and
upon any modification.

If a DocuSign Signature Appliance is replaced by another appliance or removed from the
organizational network, it is recommended to delete the appropriate entry. This ensures that
DocuSign SA clients will not attempt to connect to irrelevant appliances.

Using the DocuSign SA Control Panel

All client-based operations are activated through the DocuSign SA Control Panel.

User Admin Tools Help

Uszer

Client Graphical
@ Configuration * @ Signatures
§.| Prepare & Sign

Adminiztrator

. Apphances Uszers Chent
@ Management * @ M anagement @ Eunfiguratiun*

Management

DOCUQ%}’L; Signature Appliance

Figure 51 DocuSign SA Control Panel
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Some Control Panel options are always active, while others are active depending on the status of
the DocusSign Signature Appliance (Installed/Not Installed) or the type of DocuSign Signature
Appliance installation (Microsoft Active Directory, LDAP, or Directory Independent).

The following sections describe the actions available from the DocuSign SA Control Panel:

User Actions

Client Configuration — This option enables the end user to configure the DocuSign SA client
settings. Refer to Chapter 8: DocuSign SA Configuration Utility for more information.

Graphical Signatures — This option enables both end users and administrators to manage
personal graphical signatures. For more information, refer to Using the Graphical Signature
Management Application.

Change Password — This option is relevant only in the case of a Directory Independent
environment. For more information, refer to Directory Independent Environment Options.

This option includes also the User Activation operation that is mandatory when DocuSign SA is
installed in Common Criteria EAL4+ mode.

Prepare & Sign — This option activates the DocuSign SA Prepare & Sign application. You can
activate the application to sign PDF files, and you can setup the appearance and other
parameters related to the digital signature created using DocuSign SA Prepare & Sign. For more
information related to DocuSign SA Prepare & Sign, refer to Prepare & Sign — Signing PDF and
non-PDF Files in the DocuSign SA User Guide.

Logoff — This option logs off from the session. This option is relevant when DocuSign SA is
installed in a Directory Independent environment, or any other configuration where the user needs
to login manually.

Administrator Actions

Note: The Administrator Actions are relevant only if the administrative client is installed.

Appliances Management — This option displays the DocuSign SA Administration MMC. Using
the DocuSign SA Administration MMC it is possible to install or restore the appliance, or manage
it in operation mode. Refer to Chapter 3: Installing DocuSign SA and Chapter 5: Managing the
DocusSign Signature Appliance for more information related to the DocuSign SA Administration
MMC.

Users Management — This option activates the DocuSign SA Users Management application.
This application is mandatory when DocuSign SA is installed in a Directory Independent
environment, but can also help the administrator to view users’ statuses in all other installation
environments.

Client Configuration Management — This option activates the DocuSign SA Configuration Utility
in administrative mode. For more information, refer to Chapter 8: DocuSign SA Configuration
Utility.
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DocuSign SA Control Panel Menu Bar

User Admin | Tools | Help

Options
Llact Refresh panel |

Figure 52 DocuSign SA Control Panel Menu Bar

The User and Admin options of the DocuSign SA Control Panel menu bar display all the options
that can be activated from the Control Panel.

In addition, the Tools option includes two options.

+ Options — This enables you to configure DocuSign SA Control Panel settings. When you
select Options from the Tools menu, the following dialog box appears:

Show Signature &ppliance Cantral Panel in
# H
;the Fpghem tray

Ferzonal graphical signatures management

Figure 53 DocuSign SA Control Panel Settings

¢ Show DocuSign SA Control Panel in system tray — Check this option to display the
DocuSign SA Control panel in the system tray when the Control Panel is activated.

¢ Personal graphical sighature management — Check this option to activate the
graphical signature application in user mode. If the option is unchecked and the
DocuSign SA administrative client is installed, the graphical signature application will
operate in administrative mode. Refer to Using the Graphical Signature Management
Application.
¢ Refresh Panel — This option updates the icons in the control panel according to the
updated state of the DocuSign Signature Appliance.

DocuSign SA Control Panel — Tray Item

The DocuSign SA control panel icon appears in the tray if the option Show DocuSign SA
Control Panel in system tray is selected. Right-click the icon to display a popup that enables
you to perform the following operations:

¢ Open control panel — Maximizes the control panel.

¢ Change password — Relevant only for a Directory Independent environment. Refer to
Directory Independent Environment Options.
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¢ This operation includes also the User Activation operation that is mandatory when
DocuSign SA is installed in Common Criteria EAL4+ mode.

Logoff — Refer to the description of Logoff in User Actions.
Exit — Closes the DocuSign SA control panel.

Directory Independent Environment Options

The following options are relevant only for a Directory Independent environment.

User Admin Tools Help

User

. Client =~ Graphical Change User
@ Eunfiguratiun* & Signatures . Password

%.1 Prepare & Sign @ Logoff

Administrator

vy Applances Users Client
@ Management * Management Configuration *
M anagement

DOCU%}]«E Signature Appliance

Figure 54 DocuSign SA Control Panel — Directory Independent Environment
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Changing the Password

To change your password when DocuSign SA is installed in a Directory Independent
environment:

1. Click Change User Password in the DocuSign SA Control Panel (Figure 54).

The Change Password window appears.

[zer's pazsword

Izer Mame:

0ld Pazsword:
MHew Pazsword:

Confirmn Mew Pazsward:

Change pazswoard

Figure 55 Change Password in a Directory Independent Environment

Enter your user name.

Enter the old password of the account and the new password of the account. Confirm the
new password.

4. Click Change password.

Performing User Activation

To activate your account when DocuSign SA is installed in a Common Criteria EAL4+
environment:

1. Click Change User Password in the DocuSign SA Control Panel (Figure 54).
The Change Password window appears (Figure 55).
2. Select the User’s activation tab.
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User's pazsword | Activate user

Izer Mame:

0ld Pazzword:
MHew Pazsward:
Confirm Mew Pazsward:

Additional Pazsword:

Activate Uszer

.................................

.................................

Figure 37 User Activation Window
3. Enter your user name.
In the Old Password field enter the Activation password of the account.

In the New Password and Confirm New Password fields enter a new password of your
choice. The password must follow organizational password policy rules.

Enter an OTP as it appears in your personal OTP device.
Click Activate User.

The user account is now activated. You can start working with DocuSign SA — perform key
and certificate enrollment, upload graphical images, and sign using your key.

Note: Activation can be performed only once per account.

Note: If you get a message that the account was already activated, this may indicate a security
breach.
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Using the Graphical Signature Management Application

The Graphical Signature Management application enables you to view all your graphical
signatures and create a new graphical signature. This graphical signhature can be attached to all
Microsoft Word, Excel, InfoPath, Tiff, and Adobe Acrobat documents that you sign.

The Graphical Signature application is automatically installed together with the bocuSign
Signature Appliance Client component.
The Signature application can be used in either of two modes of operation:

+ Administrative Mode — An administrator station is used for creating the user’s graphical
signatures, as follows: The user supplies his/her identity and password, after which the
user can create and then view his/her own graphical signatures.

¢ User Mode — The user can create or view his/her own graphical signatures.
There are several mechanisms that can be used for capturing a graphical signature:

¢ A capturing device such as Topaz pads or Interlink pads.
¢ A mouse or a tablet PC.
+ Atext-based graphical signature.
+ Animage uploaded from a file.
The following section details how to capture graphical signatures.
If you do not capture a graphical signature, a default graphical signature that is based on your

name is used by the signing application, such as Office 2010/2013/2016 or DocuSign SA Prepare
& Sign.

Installing the Graphical Signature Capture Device

The DocuSign Signature Appliance is supplied with a graphical signature capture device.
However, you can use any of the following types of graphical signature capture devices:

+ Graphical signature capture devices produced by Topaz Systems
(http://www.topazsystems.com). Two models are available:

¢ SigLite LCD 1x5 USB — This model includes an LCD capture device. The entered
graphical signature appears on the LCD screen.

¢ SigLite 1x5 USB — This model does not include an LCD capture device.
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Figure 56 SigLite LCD 1x5 USB

+ Graphical signature capture devices produced by Interlink Electronics
(http://www.interlinkelectronics.com). Two models are available:

¢ ePad-ink — This model includes an LCD capture device. The entered graphical
signature appears on the LCD screen.

¢ ePad — This model does not include an LCD capture device.

Figure 57 ePad-ink
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Figure 58 ePad

Note: Install the signature capture device only on machines in which the DocuSign SA
administrative client is installed.

To install the graphical signature capture device:

+ Connect the signature capture pad to the USB port on the workstation. The pad’s drivers
are automatically installed.

Managing Graphical Signatures

The Graphical Signature Management application enables you to create and manage graphical
signatures. The graphical signatures you create using this utility are stored inside the DocuSign
SA’s users database as graphical objects.

This section describes how to operate the Graphical Signature Management application in
Administrative mode, in which different users typically use the administrator machine to create
their graphical signatures. Certain options that are relevant only to User mode are not described
here, but rather in the DocuSign SA User Guide.

To manage your graphical signatures:
1. Open the Start menu and select Programs > DocuSign > Signature Appliance >

Signature Appliance Control Panel, or you can double-click the DocuSign SA icon E in
the tray. The DocuSign SA Control Panel appears.

2. If the signature application is operating in user mode and you would like it to operate in
administrative mode, perform the following:

¢ Select Options from the Tools menu in the Control Panel. The Control Panel Settings
window appears (Figure 53).

+ Make sure that the Personal graphical signature management option is not
selected.

3. Inthe Control Panel, click Graphical Signature. An empty Graphical Signatures Viewer
dialog box appears.
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0/0

Sign in to manage your signatures...

Figure 59 Empty Graphical Signatures Viewer Dialog Box

4. Click Sign in to manage your signatures. A window appears for entering your login
information (similar to Figure 60).

DOCUQ%}&E ‘ Signature Appliance

Ilzer name: |

Uszer's password: |

Caricel |

Figure 60 Enter Login Information Dialog Box
5. Enter your login information and click OK.

The Signature Appliance — Graphical Signature Viewer dialog box appears, for managing
your graphical signatures.
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Edit Signature. .. |+ Mew Signature.,.. |

Dot THiller

yz |

Sign out from John Miller

Figure 61 Graphical Signature Management Application

6. Select a signature from the drop down list at the top of the window. The corresponding
graphical image appears in the middle of the window.

You can also use the left and right arrows to browse through all the available graphical
signatures — those stored in the DocuSign Signature Appliance, and also those located in
the local wetInk, Logo, Or Initials folders, under

My Documents/My Pictures/My CoSign images.

Note: The Update Acrobat and Download Images options are relevant only in User
mode. For information, refer to the DocuSign SA User Guide.

7. If you click either New Signature or Edit Signature, the New Signature or Edit Signature
dialog box appears.
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Signature Signature

Signature name: Signature name: sig2
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Figure 62 New Signature and Edit Signature Dialog Boxes
The display area displays the currently selected graphical signature.
The following options are available:

+ Signature Name — Specify the name of the edited graphical signature.

+ Image/Text Only — Specify if the loaded graphical signature is based on an image or
text. Depending on the selected option, the set of actions is different. Refer to Creating
an Image-Based Graphical Signature and Creating a Text-Based Graphical Signature.

+ Used For — Specify the type of graphical signature: Full Signature, Initials, or Logo.
A single logo is allowed per user.

+ Select Color — Specify the color of the foreground of the image. This is available for
monochrome images.

+ Delete this signature — Available in the Edit Signature dialog box only. The currently
selected graphical signature is deleted.

Note: A graphical signature is limited to 29KB. You can use up to a maximum of 140KB for your
entire set of graphical signatures.

If you wish to use a larger graphical image, you can store it in a local directory as described at
the beginning of this section. Each local graphical signature is limited to 1 MB.

Note: The first time you create a sighature using a signature capture device, you must have
local administrative rights. Afterwards, any user can create a signature.

Creating an Image-Based Graphical Signature

If you select Image in the Edit Signature dialog box (Figure 62), you can create an image-based
graphical signature in any of the following ways:
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¢ Upload any local image file to DocuSign SA. Refer to Uploading an Image File.
+ Create an image file and load it into DocuSign SA. Refer to Creating an Image File.

Uploading an Image File
To load an image file into DocuSign SA:
1. Select Image in the Edit Signature dialog box (Figure 62).
2. Click Upload.

3. Inthe browse window that appears, browse to the desired image file. You can upload the
following types of graphic files: monochrome bmp, multicolor bmp, or jpg.

If the size of the image is larger than the maximal size allowed, it is automatically reduced.

A window appears (Figure 63), asking whether to upload the reduced size image to the
DocusSign Signature Appliance.

Your graphical signature size was too large, and was reduced as
displayed below.

If you wish to continue, dick OK. Otherwise, dick Cancel.

J. Miller

Figure 63 Reduce Graphical Image Dialog Box
Creating an Image File
To create an image file and upload it to DocuSign SA:
1. Select Image in the Edit Signature dialog box (Figure 62).

2. Click Create. A list of available image capturing techniques appears.
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Signature

Signature name:

(®) Image () Text only Used for: | Full signature

Upload. .. Create... Select Color...

Bxtended

Topaz
ePad
Tablet PC/Mouse

Figure 64 Create a Graphical Signature — List of Image Capturing Techniques
Select an image capturing technique while keeping the following in mind:

¢ Topaz or ePad — Use these options when it is required to enter the graphical signature
using a signature capture pad. Use the pad as described in Installing the Graphical
Signature Capture Device. If you are using a signature capture device with no LCD
display, you will be able to see the signature only on the PC screen while editing it.
If you are using a signature capture device with an LCD display, you will be able to see
the signature both on the device and on the PC screen while editing it.

+ Tablet PC/Mouse — Use a Tablet PC and a pen or a regular PC mouse to enter a new
graphical signature. Any movement of the mouse or pen in the tablet PC is drawn in
the Capture Signature window that appears.

Note: You will be able to use the mouse on a regular PC only when using Window 7 and
above or when Microsoft Office 2010/2013/2016 is installed.

The display in the Edit Signature window refreshes (see Figure 65).
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Signature

Signature name:

® Image Text only Used for: | Full signature

Use your capture device to sign Clear

Cancel

Cancel

Figure 65 Creating a Graphical Image File
3. Use the capturing technigue to capture a graphical signature.

When capturing is complete, click Done in the Edit Signature dialog box (Figure 65). The
graphical signature you created is uploaded into DocuSign SA.

5. If you wish to re-start the capture, click Clear.

Note: If the size of the image is larger than the maximal size allowed, the image size is
automatically reduced.

Creating a Text-Based Graphical Signature
To create a text-based graphical image:

1. Select Text only in the Edit Signature dialog box (Figure 62). The options shown in
Figure 66 appear.
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Signature

Signature name: John Miller

() Image (®) Text only Used for: |Fu|| signature

Calisto MT 42 | Font .. |

John Miller

Figure 66 Edit Signature Dialog Box— Text-based Graphical Signature
2. Click Font. A Font dialog box appears.
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Figure 67 Edit Signature Dialog Box— Text-based Graphical Signature — Defining the Text Appearance

3. Inthe Font dialog box, specify the appearance of the graphical signature text (font, size,
color, etc.).

Click OK to close the Font dialog box.
Using your keyboard, enter the text for the graphical signature. The signature is displayed,

with the appearance you defined, in the window of the Edit Signature dialog box
(Figure 66).

Installing the Root Certificate and DocuSign SA Verifier

In order to sign or validate documents originating from an organization, you must install on your
workstation the organization’s DocuSign SA ROOT certificate. In addition, if you do not have a
DocuSign SA Client, you need to install a DocuSign SA Verifier in order to validate signatures of
Office XP/2003 documents and Adobe documents.

For a full explanation of how to install a ROOT certificate and a DocuSign SA Verifier, refer to the
section Installing the Root Certificate and DocuSign SA Verifier in the DocuSign SA User Guide.

Adding the ROOT Certificate to a Trusted CA List (Active Directory only)

It is possible to add the ROOT certificate to a trusted CA list in the Active Directory of the domain.
Every workstation connected to the domain automatically obtains the ROOT certificate and places
the certificate in its local trusted ROOT CA list.
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To add the ROOQOT certificate to a trusted CA list, use the Microsoft utility certutil.exe. The
utility is part of Windows Server 2003 and Windows Server 2008. It is also available as part of the
Microsoft Windows Server 2003 Administration Tools Pack which can be downloaded from
http://support.microsoft.com.

Execute certutil.exe as follows:
certutil.exe -dspublish -f <file name> RootCA
where;:

-f forces the creation of the object if it doesn’t exist, and
<file name> is the certificate file name.

Note: The user who runs certutil.exe needs permissions for creating an object under
Services\public key services\Certificate authorities and under Services\public key services\AlA.

Using DocuSign SA Verifier for Validation Purposes

To validate a document, you need to install the root certificate of the organization that signed the
document. You do not need a DocuSign SA Client or DocuSign Signature Appliance. However, if
you do not have a DocusSign SA Client, you need to install a DocuSign SA Verifier if you wish to
validate signatures of Office XP/2003 documents and Adobe documents.

For a full explanation of how to install a ROOT certificate and a DocuSign SA Verifier, refer to the
section Installing the Root Certificate and DocuSign SA Verifier in the DocuSign SA User Guide.

+ For more information on verifying Office XP/2003 documents, refer to Signing Microsoft
Office Documents in the DocuSign SA User Guide.

+ For more information on verifying Adobe documents, refer to Signing Adobe Acrobat
Documents in the DocuSign SA User Guide.

Extended Authentication Modes

DocuSign SA enables the use of extended authentication modes, in addition to the regular
authentication mode which is based on a User ID and password authentication.

The extended authentication mode is required in more sensitive user environments, where the
digital signature process requires the end user to prove his/her identity based on additional
devices such as OTP (One Time Password) devices, SmartCard for authentication, or a Biometric
device.

Depending on the configured Extended Authentication, the end user is prompted during the digital
signature operation to supply information according to the Extended Authentication mode used.

The following Extended Authentication modes are supported:

¢ OTP based on Radius authentication — The end user is prompted to provide the OTP
during the digital signature operation.
The DocuSign Signature Appliance interfaces with the OTP server using a Radius
protocol. The Radius protocol enables the DocuSign Signature Appliance to interact with
the OTP server and send the user ID and the OTP in a secret manner.
The OTP is sent as is to the RADIUS server. There are some RADIUS servers whose
password is based both on static and dynamic passwords. In these cases, both the static
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and dynamic password are passed to the RADIUS server for authentication.

If the user is approved by the OTP server, DocuSign SA continues to perform the digital
signature operation.

For more information about the various parameters that require configuration in order to
interface to the RADIUS server, refer to Extended Authentication.

Note: DocuSign SA supports a maximum password length of 128 characters.

+ If DocuSign SA is operating in Common Criteria EAL4+ mode, OTP is used for every
digital signature operation. In addition, because the OTP must be validated within the
DocuSign Signature Appliance, initial additional integration is required within the Radius
Server for interacting with the DocusSign Signature Appliance for the purpose of OTP
validation. For information, contact DocuSign.

¢ Authentication SmartCard — The end user enters the authentication SmartCard in a
dedicated smart card reader device.
The user is prompted for a PIN to access the SmartCard, and the SmartCard is used to
prove the user identity to the DocuSign Signature Appliance.
The DocuSign Signature Appliance authenticates the user, and if the user is approved,
DocuSign SA continues to perform the digital signature operation.
This solution requires a special component in the DocuSign SA Client. For more
information, contact DocuSign support.

+ Biometric Device — The end user uses a biometric device. A proof of identity is sent to the
DocusSign Signature Appliance as part of the digital signature operation.
The DocuSign Signature Appliance checks the identity of the user, and if approved,
DocuSign SA continues to perform the digital signature operation.
This solution requires a special component in the DocuSign SA Client. For more
information, contact DocuSign support.

To configure DocuSign SA to use extended authentication, refer to Extended Authentication.
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Chapter 5: Managing the DocuSign Signhature Appliance

The DocuSign Signature Appliance is managed via the DocuSign SA Administration Microsoft
Management Console (MMC). This chapter describes how to use the DocuSign SA
Administration MMC for the most efficient DocuSign SA management.

This chapter also describes the DocuSign Signature Appliance Users Management GUI utility,
which provides easy users’ management for cases where DocuSign SA is installed in a Directory
Independent environment or other environments. It is also possible to manage users in this
environment through a DocuSign SA API (Application Programming Interface) called Signature
Local User Management API. DocuSign SA Signature APIs documentation is located in the
SAPI\doc folder of the SDK CD.

Note: Managing DocuSign SA differs slightly depending on whether it is installed in a Microsoft
Active Directory, LDAP, or Directory Independent environment. These differences are
mentioned throughout the chapter.

Prerequisites to Using the DocuSign SA Administration MMC

The DocuSign SA Administration MMC enables you to efficiently manage the DocuSign Signature
Appliance. In order to use the DocuSign SA Administration MMC, you must have the following
gualifications:

1. You must be the built-in administrator defined during DocuSign SA installation;
Or

You must belong to the domain’s administrative group as well as a valid DocuSign SA
user. For example, in a typical Active Directory installation, you must belong to the
DocuSign SA Signers group. The administrative group is defined by the system parameter
Administrator Group, as described in Users Directory Parameters.

In the case of a Directory Independent environment, you must be defined with DocuSign
SA Admin appliance management rights.

2. Before performing any appliance administrative activity, you must manually login to
DocuSign SA using either the built-in administrator or another valid administrator account.

Starting the DocuSign SA Administration MMC
To start the DocuSign SA Administration MMC:

1. Open the Start menu and select Programs - DocuSign - Signature Appliance >
Signature Appliance Control Panel.

2. Select Appliances Management.

The DocuSign Signature Appliance Management window appears, showing all installed
DocusSign Signature Appliances (Figure 68).
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Figure 68 DocuSign Signature Appliance Management Window
3. Right-click the DocuSign Signature Appliance you wish to administrate.

4. From the popup menu, login to DocuSign SA as an appliance administrator by selecting
All Tasks > Login—> Login, or All Tasks > Login-> Login built-in user.

File Action View Help

e #|d=H

! DocuSign Signature Appliance || Address Version Serial Number Status Role Actions
4 @ Signature Appliances [310.65.48.37 82 CSN02016 Not logged in  Primary T &
@‘ All Tasks » | Login s Login More .. b
Refresh Backup Login Built-in User
Upload Software
2R Synchronize v
Clear CA Files
Downlead Logs 3
Restart 3
High Availability [
Subordinate CA 3
Upload S5L Certificate
Upload CA Information
Signature Appliance Performance Monitor 3
License 3
€ >
Login.

Figure 69 DocuSign Signature Appliance Management Window — Logging in to DocuSign SA as an
Appliance Administrator

Note that in the regular login option you can use your Active Directory / LDAP / Directory
Independent admin user for connecting to DocuSign SA. If you choose to use the built-in
user login, you must provide the account name and password.
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DocuSign SA Administration MMC Capabilities

Once you are logged in to the DocuSign SA Administration MMC, you can perform the following
operations, described in detail below:

L4
*
L4

*

* & o o

Back up the current DocuSign SA data.
Upload software updates provided by DocuSign.

Manually synchronize DocuSign SA with your Microsoft Active Directory or LDAP
directory.

Synchronize DocuSign SA with the External CA. This option is relevant when DocuSign
SA is interfacing with an external CA automatically for producing users’ certificates.

Refresh Certificates.

Clear CA files. This option is relevant when DocuSign SA is using an internal CA for
producing certificates. This option clears internal CA information.
This option is not relevant for DocuSign SA 4.4 and above.

Download log files from the DocuSign Signature Appliance.
Restart or shut down DocuSign SA.
Configure high availability options.

Manage the Subordinate CA Certificate. This option is used when installing or renewing a
subordinate CA certificate.

Upload a new SSL Server certificate to be used as part of the DocuSign SA Web Services
offering. This operation is also relevant if the DocuSign SA Web Services interface that is
based on Rest API is used.

Extract technical performance figures on the internal activity of the appliance.

Prepare a request for a new DocuSign Signature Appliance license and upload the new
license.

View and modify system parameters.
Restore the DocusSign Signature Appliance from backup data.

Install a new DocuSign Signature Appliance (refer to Installing the DocuSign Signature
Appliance Software).

Install an alternate DocuSign Signature Appliance (refer to Installing an Alternate
DocuSign Signature Appliance).

Backing up the DocuSign SA Data

You can back up the entire DocuSign SA database (which includes all the users’ keys,
certificates, and graphical signatures), the internal CA files, and all the DocuSign SA configuration
data, to a file located on your local network. The generated backup file is encrypted and can only
be decrypted by the DocuSign Signature Appliance. The DocuSign SA key is generated and
stored on the backup MiniKey token during appliance installation.

After generating the backup file, you can save it to a disk or CD to store in case of data loss. This
file can then be used to restore the DocuSign Signature Appliance if necessary. For more
information on restoring the DocusSign Signature Appliance, refer to Restoring the DocuSign
Signature Appliance.
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To back up the DocuSign SA database:

1. Inthe DocusSign Signature Appliance Management window (Figure 68), right-click the
DocusSign Signature Appliance you wish to back up.

From the popup menu, select All Tasks > Backup. The Select a File dialog box appears.

Select a local backup file and click Save. The DocuSign SA backup in progress status bar
appears. When the backup operation is complete, the following message appears:

Backup finished successfully.

A Very Important: After any upgrade, you must perform a backup of the
appliance

A Very Important: You must perform a backup procedure periodically to enable

quick recovery in the case that important information, such as users’ graphical
signatures, is removed from the DocuSign Signature Appliance, or in the case
of any appliance hardware problem.

Note: You can also perform backup using the command line utility GetBackup (refer to
Using Command Line Utilities).

Upgrading DocuSign SA

You can upload DocuSign SA software updates provided by DocuSign. The software updates are
signed by DocuSign to ensure security. Software updates can be either a major version upgrade
or a software patch. The same procedure is used in both cases.

Before uploading an upgrade or a patch, use the DocuSign SA Console’s Status menu to verify
the existing appliance software version (refer to Displaying DocuSign SA Status).

Note the following:

¢ If you wish to upgrade DocuSign SA from version 6.0, or 6.3, you must first upgrade to
version 7.1, then upgrade to version 7.4, upgrade to version 7.5 and finally upgrade to
version 8.0.

+ If you wish to upgrade DocuSign SA from version 7.1, you must first upgrade to version
7.4, then upgrade to version 7.5 and finally upgrade to version 8.0.

Note: For information on how to upgrade DocuSign Signature Appliances in a high availability
environment, refer to Upgrading Appliances Patrticipating in a High Availability Cluster.

/!\ Very Important: After any upgrade, you must perform a backup of the appliance

Note: If DocuSign SA is deployed in Common Criteria EAL4+ mode, you can only upgrade the
DocuSign Signature Appliance to new versions that are Common Criteria certified.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 127

Upgrading to Version 7.1

DocuSign SA version 7.1 includes a software upgrade from DocuSign SA version 6 or 6.3 to
version 7.1. The upgrade consists of the following file: verupd71.d1m.

To upgrade from version 6/6.3 to version 7.1:
1. Load verupd71.dlm from the DocuSign SA version 7.1 CD.

2. Follow the instructions listed in Uploading a Software Update. The upgrade runs
immediately.

3. Use the DocuSign SA Console’s Status menu to verify that the software version is sw7. 1.
(refer to Displaying DocuSign SA Status).

Upgrading to Version 7.4

DocuSign SA version 7.4 includes a software upgrade from DocuSign SA version 7.1 to
version 7.4. The upgrade consists of the following file: verupd74.d1m.

To upgrade from version 7.1 to version 7.4:
1. Load verupd74.dlm from the DocuSign SA version 7.4 CD.

2. Follow the instructions listed in Uploading a Software Update. The upgrade runs
immediately.

3. Use the DocuSign SA Console’s Status menu to verify that the software version is SW7. 4.
(refer to Displaying DocuSign SA Status).

Upgrading to Version 7.5

DocuSign SA version 7.5 includes a software upgrade from DocuSign SA version 7.4 to
version 7.5. The upgrade consists of the following file: verupd75.d1m.

To upgrade from version 7.4 to version 7.5:
1. Load verupd75.d1m from the DocuSign SA version 7.5 CD.

2. Follow the instructions listed in Uploading a Software Update. The upgrade runs
immediately.

3. Use the DocuSign SA Console’s Status menu to verify that the software version is SW7. 5.
(refer to Displaying DocuSign SA Status).

Upgrading to Version 8.0

DocuSign SA version 8.0 includes a software upgrade from DocuSign SA version 7.5 to
version 8.0. The upgrade consists of the following file: verupd80.d1m.

To upgrade from version 7.5 to version 8.0:

1. Load verupd80.dlm from the DocuSign SA version 8.0 CD.
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2. Follow the instructions listed in Uploading a Software Update. The upgrade runs
immediately.

3. Use the DocuSign SA Console’s Status menu to verify that the software version is SW8. 0.
(refer to Displaying DocuSign SA Status).

Uploading a Software Update
To upload a software update:

1. Inthe window (Eigure 68), right-click the DocuSign Signature Appliance to which you wish
to upload the software.

2. From the popup menu, select All Tasks > Upload Software. The Select a File dialog box
appears.

3. Select a local software update file and click Open. The DocuSign SA Uploading Software
in progress status bar appears. When the upload operation is complete, the following
message appears:

Software uploaded successfully.

Note: Since most of the upload operation is carried out after the success message is displayed,
it is recommended to view the new version number in the DocuSign SA’s console or view the log
files to validate the success of the operation.

Synchronizing DocuSign SA with the Directory Service

Note: This option is not relevant in a Directory Independent environment.

Note: This operation is not relevant when DocuSign SA is deployed in a Common Criteria
EAL4+ mode of operation.

DocuSign SA monitors and retrieves information directly from the directory service.

During DocuSign SA installation, the DocuSign SA users are defined either by defining a ROOT
OU of all the signers or by defining a signers group (relevant only to Active Directory installations).
When a user is added to the directory service and is classified as a signer, DocuSign SA
automatically generates a key and a certificate for the user, depending on the certificate model
used. When a user is deleted from the directory service, DocuSign SA automatically removes the
user and the user’s key and certificate from the DocuSign Signature Appliance. When a user’s
information is updated in the directory service (e.g., the user’s email address is modified),
DocuSign SA automatically generates a new certificate for the user. In this way, DocuSign SA
and the directory service remain synchronized.

In certain cases, however, DocuSign SA may lose synchronization with the directory service. This
may occur if you run DocuSign SA with a license for fewer users than necessary, or if the
directory service is restored from an old backup. Once the license issue is resolved or the restore
operation complete, you can use the Sync with the Directory option to manually trigger
synchronization of DocuSign SA with the directory service.
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Another case requiring manual synchronization of the directory is the case where an Active
Directory environment is used, and DocuSign SA users are based on a dedicated Signers group
defined in the Active Directory. When users are removed from the Signers group in the Active
Directory, they are not automatically deleted from DocuSign SA to prevent users losing their keys
and graphical signatures in cases where users are removed and immediately entered back into
the Signers group. These users will not be able to sign using DocuSign SA, but if it is required to
remove these users from DocuSign SA, it is necessary to perform the manual synchronization
operation.

Note: DocuSign SA may lose synchronization also if you modify the DocuSign SA OU
(Organizational Unit) in the Active Directory environment. Keep in mind that performing a
synchronization operation after renaming the DocuSign SA OU may cause deletion of all the
users in the DocuSign Signature Appliance, including deleting their key, certificates, and
graphical signatures.

DocusSign therefore recommends not modifying the DocuSign SA users OU after installation.

Note: If DocuSign SA is installed in an LDAP or AD Multiple Domains environment, full
synchronization is automatically performed periodically. The frequency of synchronization
depends on a system parameter (refer to Changing DocuSign SA System Parameters).

Note: In the case of LDAP or AD Multiple Domains installations, running Directory
synchronization only updates users’ information in DocuSign SA or deletes users from DocuSign
SA. Any addition of new users to DocuSign SA requires the user to access the DocuSign
Signature Appliance.

The Sync with the Directory option compares DocuSign SA users to directory service users,
adding and deleting DocusSign SA users, keys, and certificates where necessary.

To manually trigger synchronization of DocuSign SA with the directory service:

1. Inthe DocuSign Signature Appliance Management window (Figure 68), right-click the
desired DocusSign Signature Appliance.

2. From the popup menu, select All Tasks > Synchronize - Sync with the Directory. The
following message appears:

Do you really want to sync with the Directory?

3. Click OK to confirm the operation. When the synchronization operation begins, the
message Sync with the Directory started appears.

Note: The synchronization operation may take a long time. This message only indicates
that the operation started. A message in the Event log indicates when the operation is
complete.

Synchronizing DocuSign SA with the External CA in Automated mode

Note: This operation is not relevant when DocuSign SA is deployed in a Common Criteria
EAL4+ mode of operation.
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If you are using an external CA in automated mode, you can synchronize the DocuSign SA
database and the external CA.
This option can be used when interfacing with the Comodo CA or Symantec CA.

Use this option when there are valid DocuSign SA users who are in the process of receiving an
external CA certificate, but have not yet received the certificate.

To synchronize DocuSign SA with the external CA:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
DocuSign Signature Appliance you wish to synchronize.

2. From the popup menu, select All Tasks > Synchronize - Sync with the CA.
Synchronization includes the following:

¢ Every certificate in the external CA that does not have a matching user in DocuSign
SA, is revoked.

+ For every user in DocuSign SA who does not have a certificate in the external CA, a
new certificate request is issued to the CA, and the resultant certificate is sent to
DocuSign SA.

Note: Users that no longer exist in DocuSign SA do not appear in Comodo’s CRL,
because some applications fail to validate signatures for revoked users who signed the
document when their certificate was valid. If the CRL were to include users that no
longer exist in DocuSign SA, their valid signatures might appear as invalid.

This option is not relevant when using the Symantec Automated External CA.

Refreshing Certificates

Note: This operation is not relevant when DocuSign SA is deployed in Common Criteria EAL4+
mode of operation.

This option instructs the DocusSign Signhature Appliance to generate new certificates for all the
signers. This option should be used in cases where a certain parameter that affects the content of
the certificate has changed (for example, the CRL Distribution point of the certificate), and you
want to generate new certificates containing the new value for all end-users.

This option can be used also when an automated external CA is configured.

To refresh all users’ certificates:

1. Inthe DocuSign Signature Appliance Management window (Figure 68), right-click the
DocuSign Signature Appliance.

2. From the popup menu, select All Tasks > Synchronize - Full User Certificate refresh.
3. Confirm the operation.
Following synchronization:

¢ A new certificate is generated for every end-user, based on the current parameters.

¢ If DocuSign SA interfaces an external CA in automated mode, a certificate renewal
procedure is run for every end user.
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Note: The Refresh Certificates option is relevant also when DocuSign SA interfaces an
external CA automatically. Keep in mind that this option will generate new certificates for
all users.

Clearing CA files

This option reduces the size of the files used by the DocuSign SA internal CA. This subsequently
reduces the size of a backup operation.

Note: This option is not relevant to DocuSign SA 4.5 and above.

Note: This operation is not relevant when DocuSign SA is deployed in Common Criteria EAL4+
mode of operation.

To clear the CA files:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
desired DocusSign Signature Appliance.

2. From the popup menu, select All Tasks > Clear CA Files.
At the end of the operation a success or failure message appears.

Downloading Log Files
There are three types of DocuSign SA log files that you can download:
¢+ DocuSign Signature Appliance Event log — Displays signing operations, major errors,
and administrative actions, such as performing backups.
DocuSign Signature Appliance Debug log — Displays internal debug information.

DocuSign Signature Appliance Install log — Displays internal debug information related
to the installation process.

You can view the Event, Debug, and Install logs. The Debug and Install logs are intended for
internal DocusSign use. When necessary, download them as instructed by DocuSign’s technical
support team and send them to DocuSign.

Starting from DocuSign SA version 8.0, the DocuSign SA Event Log is managed inside the
appliance database. Upon a request to retrieve the event log, a zipped .csv file is returned.

Each event may contain the following information:

¢ Technical Identity (Number)
¢ Event Creation Time (Date-Time Number format) — as seconds from 1970

¢ Log Level — The event level of severity, where 1 is the highest severity and 4 is the lowest
severity

Source — The DocuSign SA internal technical module that initiated the event
IP address — The IP address of the relevant client connecting to the appliance
AdminTechlID — The administrator’s internal Tech ID

AdminPrincipalName — The name of the relevant administrator

* & o o
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UserTechID — The user’s Internal Tech ID
UserPrincipalName — The name of the relevant user

EventID — An internal identification of the performed operation
Value — A textual description of the event

SignedData — In the case of a digital signature operation, this value is the hash
representation of the data to be signed.

* & & o o

To view the Event log:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
desired DocusSign Signature Appliance.

From the popup menu, select All Tasks > Download Logs > DocuSign SA Event Log.
Select a file and click OK.

Unzip the file to obtain a .CSV file.

Use an application such as Excel or Notepad to view the .csv file.

a > D

Note: You can also download DocuSign SA’s Event log by using the command line utility
GetEvt (refer to Using Command Line Utilities).

Shutting Down and Restarting DocuSign SA Services

You can stop and restart the DocuSign SA internal services within the DocuSign Signature
Appliance.

To stop and then restart the DocuSign SA services:

1. Inthe DocuSign Signature Appliance Management window (Figure 68), right-click the
desired DocuSign Signature Appliance.

2. From the popup menu, select All Tasks - Restart > Soft Restart.

Restarting the DocuSign Signature Appliance

There are several options for restarting or shutting down DocuSign SA services and the DocusSign
Signature Appliance:

+ Hardware Restart — Restarts the appliance from a remote location.
¢ Shutdown Appliance — Shuts down the DocuSign Signature Appliance.
To restart or shut down the DocuSign Signature Appliance:

1. Inthe DocuSign Signature Appliance Management window (Figure 68), right-click the
desired DocusSign Signature Appliance.

2. From the popup menu, select All Tasks > Restart > Hardware Restart/Shutdown
Appliance.
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High Availability

In a high availability site, one appliance is defined as the primary DocuSign Signature Appliance,
and the other DocuSign Signature Appliances in the site are defined as alternate DocuSign
Signature Appliances. The following high availability options are available to the appliance
administrator through the DocuSign SA Administration MMC:

¢ |Install Alternate — Install the alternate DocuSign Signature Appliance software. Refer to
Installing the Alternate DocuSign Signature Appliance Software.

¢ Subscribe Alternate to Primary — Re-subscribe an existing installed appliance to be an
alternate appliance of a selected primary appliance. Refer to Re-subscribing an Alternate
Appliance with a Primary Appliance.

¢ Set As Primary — Set an existing alternate appliance to be the primary appliance. Refer to
Setting an Alternate Appliance to be the Primary Appliance.

¢ Subscribe as Alternate — If the existing cluster of appliances has more than one primary
appliance due to recovery after failure, it is possible to set an appliance previously defined
as the primary appliance to be an alternate appliance. Refer to Setting a Previous Primary
Appliance to be an Alternate Appliance.

Renewing the Subordinate CA Certificate

Note: This operation is not relevant when DocuSign SA is deployed in a Common Criteria
EAL4+ mode of operation.

It is possible to install DocuSign SA so that DocuSign SA acts as a subordinate CA of another
ROOT CA in the organization’s environment. For more information on installing DocuSign SA as a
subordinate CA, refer to Installing DocuSign SA as a Subordinate CA.

If the DocuSign SA certificate from the ROOT CA has expired or been revoked, you need to
renew the DocusSign SA certificate. It is recommended to start the renewal process at least a
month before certificate expiration.

It is further recommended to adjust the renewal of the users’ certificates to after the subordinate
CA is renewed, but before it is expired, to avoid cases where an end-user’s certificate is valid, but
the CA certificate is not.

To renew the DocuSign SA certificate when the Appliance’s CA is acting as a subordinate
CA:

1. Inthe DocusSign Signature Appliance Management window (Figure 68), right-click the
relevant DocuSign Signature Appliance and select All Tasks - Subordinate CA >
Download Certificate Request.
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Figure 70 Subordinate CA Options

2. A File Selection dialog box appears, prompting you to supply the name of the file that will

contain the Certificate Request (CRQ) for DocuSign SA as a subordinate CA.
DocuSign SA will place the CRQ into this file.
Submit the certificate request to the ROOT CA by providing the CRQ file.

The files you will eventually receive back from the ROOT CA include a group of files that
constitute the complete chain of CA certificates, and the Certificate Reply file that contains
the new DocuSign SA subordinate CA certificate.

Note that if a ROOT CA certified DocuSign SA, the complete chain of CA certificates
includes only the ROOT CA certificate.

The DocuSign SA subordinate CA certificate can also be packaged in certificate format
(.cer) and not necessarily in a certificate reply format (.crp).

Note: Make sure that the certificate reply contains only the DocuSign SA certificate and
does not contain any of the certificates that are part of the certificate chain.
The certificates in the certificate chain are loaded separately.

Note: The file formats of the certificate and certificate chain must be ASN.1 (DER)
encoded. If the files are encoded in BASE64 format, they must be converted.

If the DocuSign SA subordinate CA certificate is encoded in BAES64 format, you can
use the Microsoft standard certificate information utility to browse to that BASE64
certificate, and use the copy to file option to save the certificate to a DER encoded
certificate.

4. For each file in the chain of CA certificates, perform the following:

¢ Right-click the relevant DocuSign Signature Appliance and select All Tasks >
Subordinate CA - Load ROOT Cert Chain.

A file selection window pops up.
¢ Specify the path and file name of the CA certificate.
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After each certificate is loaded, the following message appears: Uploading root
certificate chain finished successfully.

5. Right-click DocuSign Signature Appliances and select All Tasks & Subordinate CA >
Upload Certificate Reply.

A dialog box appears, prompting you to specify the Certificate Reply file, which contains
the new DocuSign SA subordinate CA certificate.

6. Specify the path and file name of the Certificate Reply.

Note: In case of an error when uploading the new certificate, DocuSign SA will continue
running using its old CA certificate until the certificate expires.
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Uploading an SSL Certificate

If DocuSign SA is used in Web Services mode or RESTful based Web Services mode, access to
Web Services is based on SSL security, that is, the SSL server must use a private key and a
certificate. However, the DocuSign Signature Appliance is installed with a default SSL Server
certificate pointing to an SSL Server with the name cosign or www.cosign.com, depending on the
Appliance’s version. This default certificate would require that the organization configure each
client as follows:

¢ Assign DocuSign SA’s IP address to the name cosign or www.cosign.com. (This can be
done by updating the hosts file, located in \windows\system32\drivers\etc oOrin
\etc\hosts).

¢ Trust the default certificate.

Instead, you can upload your own SSL Server Private Key and certificate which includes the DNS
identification of the DocuSign Signature Appliance.

To upload your own SSL Server Private Key and certificate:
1. Generate a private key and request a certificate from a well-known certificate authority.

2. Upload the Private Key and Certificates chain that are packaged in a .pfx file to the
DocuSign Signature Appliance.

When activating this option, a window pops up requesting you to supply the following:

PECSH1Z file [.pfe) | Browse...

File Pazzword |

Cancel |

Figure 71 Upload SSL Certificate

+ PKCS#12 file (.pfx) — Provide the file that includes the Private Key and Certificate
chain.

+ File Password — Provide the password that protects the Private Key in the PKCS#12
file.
This new Private Key and Certificate will replace the existing default Private Key and Certificate.
The SSL Server will now use the Private Key and certificate for providing SSL communication
based Web Services that match the organization network identities.
This operation will load the information to both a regular Web Services module and to a RESTful
Web Services module.
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Renewing the Symantec Authentication Key File

When using Symantec as the automatic external CA, the DocuSign Signature Appliance is
authenticated to the Symantec service using an authentication key and an authentication
certificate that are uploaded to DocuSign SA as part of the DocuSign SA installation process.

Close to the expiration date of the authentication key, you should logon to the Symantec portal
using your organizational account, and request to renew the authentication key. To do so, repeat
the exact process you following when installing the appliance. Refer to Using an External CA in
Automated Mode — Symantec.

By default, the Account Name and Account profile ID of the new Symantec key will be those
appearing in DocuSign SA’s authentication PFX file the last time it was uploaded.

To renew the Symantec authentication key file when using Symantec as the automatic
external CA:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
relevant DocuSign Signature Appliance and select All Tasks - Upload CA

PKCSH#12file (pe) | Browse...

File Pazsword |

Account Mame |??5243

Account profile 1D |2.1 E.840.1.113733.1.16.1.2.5.6.1

Figure 72 Upload CA Information Window populated with Symantec Account Name and Account Profile
ID
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Monitoring Performance Parameters of the DocuSign Signature
Appliance

You can monitor the performance of the appliance. Use this option if the appliance has a heavy
load and requires performance evaluation. Consult DocuSign support before activating this
option.

Activating Performance Monitoring
To monitor appliance performance parameters:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
relevant DocusSign Signature Appliance and select All Tasks = DocuSign SA
Performance Monitor - Start Monitor. The Setup Performance Monitor Parameters
window appeatrs.

Monitor period(in hours): | 56
Sampling frequency{in seconds): | 15

Cancel |

Figure 73 Setup Performance Monitor Parameters Window
2. Specify the following:
¢ Monitor period (in hours) — Specify the overall period of monitoring activity. When
the monitoring period ends, the monitor service will stop.

¢ Sampling frequency (in seconds) — Specify how often the monitoring service
samples technical parameters.

3. Click OK.

Monitoring begins. Monitoring will end at the end of the specified monitor period, or if you
manually stop it as described in Stopping Performance Monitoring.

Stopping Performance Monitoring
To stop monitoring of appliance performance parameters:

1. Inthe DocuSign Signature Appliance Management window (Eigure 68), right-click the
relevant DocuSign Signature Appliance and select All Tasks > DocuSign SA
Performance Monitor > Stop Monitor.
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Viewing Performance Parameters
To view the appliance performance parameters:

1. Inthe DocuSign Signature Appliance Management window (Figure 68), right-click the
relevant DocusSign Signhature Appliance and select All Tasks = DocuSign SA
Performance Monitor - Download Log.

The downloaded file contains values for all sampled parameters. You can display the values in
Excel. You can consult with DocuSign to evaluate whether the values are as expected.

Obtaining a New DocuSign SA License

You can obtain a new DocuSign SA license, while managing both the license request and the
license response via email. This option is possible only if you have an existing license token. A
new license is needed when you wish to change the number of end-users who may use the
DocuSign Signature Appliance.

Requesting a New License
To request a new license:

1. Make sure the license token is plugged into the USB slot in the DocuSign Signature
Appliance.

2. Inthe DocusSign Signature Appliance Management window (Eigure 68), right-click the
relevant DocusSign Signature Appliance and select All Tasks = License - Download
License Request.

File Action View Help

e | zd=H

& DocuSign Signature Appliance || Name
4 [ Signature Appliances DS}rstem parameters
All Tasks L Legin 3
.‘u’iew o Backup
Upload Software
Ret=t Synchronize 3
Export Lit.. Clear CA Files
Help Download Logs 4
Restart 3
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< >

Request for update license.

Figure 74 License Options
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You are requested to provide a file path for the License Minikey Request (.Imr) file.
3. Specify a location for the License Minikey Request (.Imr) file.

Email the License Minikey Request (.Imr) file to your contact at DocuSign, and specify the
requested number of signers.

Uploading the New License
DocuSign emails back a new license in the form of a License MiniKey Update (.Imu) file.
To upload the new license:
1. Save the new .Imu license file on your system.

2. In the DocuSign Signature Appliance Management window (Eigure 68), right-click the
relevant DocuSign Signature Appliance and select All Tasks > License - Upload
License Reply (Figure 74).

3. Specify the .Imu license file.
The new license file is uploaded to the license token.

A message appears, informing you whether license upload was successful.

Changing DocuSign SA System Parameters

You can easily change the various system parameters using the DocuSign SA Administration
MMC.

To change system parameters:

1. Inthe left pane of the DocuSign Signature Appliance Management window, click System
Parameters for a specific appliance. The parameters are classified according to the
context of the parameter. When you select a specific class of parameters, its parameters
are displayed in the right pane, as shown in Figure 75.
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Figure 75 DocuSign SA System Parameters

2. Double-click a parameter to change the parameter’s value. A popup dialog box appears
with the parameter’s current value.

3. Change the value and click OK.

Note: You must perform a soft restart of the DocuSign Signature Appliance for the new
parameter values to take effect (refer to Restarting the DocuSign Signature Appliance).

Note: In a High Availability configuration, you need to restart the alternate appliances as well.

The available parameters are listed below.

Users Directory Parameters

Note: This section is not relevant when DocuSign SA is deployed in a Common Criteria EAL4+
mode of operation.

¢ Group of DocuSign SA Users (AD) — The identification of the group in the Active
Directory that defines the scope of DocuSign SA users. This group is referred to as the
Signers Group.
This parameter is modifiable and defined during DocuSign SA installation.
This parameter should be provided in a Full Distinguished Name format, that is,
CN= CoSign Signers, CN = Users, DC= org, DC=com.

Note: Set this parameter with great care. All users who do not belong to the new Signers
group will be deleted, as well as all their user information.

¢ If DocuSign SA is installed in a multiple domain environment, the Group name should not
be entered in a Full Distinguished name format, but in a regular format as follows:
DocuSign SA Signers.
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¢ Automatic Deletion of Users — If this parameter is TRUE, DocuSign SA automatically
deletes a user from DocuSign SA when the user is removed from the Signers group, or
when the user’s group is removed from the Signers group. This can be a problem if the
administrator decides to temporarily remove the user from the Signers group.
It is recommended to set this parameter to FALSE.

Default value: FALSE.

+ Appliance Administrator Group — The name of the directory service’s user group that
identifies authorized DocuSign Signature Appliance administrators. Make sure that all
users who perform DocuSign Signature Appliance administrative tasks are assigned to
this group. You can choose any name for this group, under the following conditions:

+ In an Active Directory environment, provide the name of the administrative group
(.e.g., administrators).

+ Inan LDAP environment, provide this parameter in a Full Distinguish Name format,
that is, CN= Administrators, DC= org, DC=com.

Default value: administrators.

¢ Users Administrator Group — The name of the directory service’s user group that
identifies authorized DocuSign SA user administrators. Make sure that all users who
perform DocuSign SA user administrative tasks are assigned to this group. You can
choose any name for this group, under the following conditions:

¢ In an Active Directory environment, provide the name of the administrative group, for
example, administrators.

¢ In an LDAP environment, provide this parameter in a Full Distinguish Name format,
that is, CN= Administrators, DC= org, DC=com.
Default value: administrators.

+ Directory Synchronization Timer — How often (in seconds) the system should scan for
updates in the directory service’s user databases in order to generate keys and certificates
for new users, update user certificates due to changes such as email address changes, or
delete users.

Note: A low value (i.e., several seconds) increases DocuSign SA synchronization with
the directory service, but may decrease DocuSign SA performance levels.

Default value: 40 seconds.

+ Create Group Keys — Indicates whether a key and certificate are automatically generated
for every group in the directory service. If this option is activated, every end user can
digitally sign using his group certificates. If a user belongs to several groups, the user can
use the certificates of all the groups to which the user belongs.

Note: If an External CA is used, use the Groups . exe utility. This utility enables the end
user to define the current group. Any creation of keys and certificates by the end user will
be automatically assigned to the current group.
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Note: After updating this value and performing a soft restart of the DocuSign Signature
Appliance, you must manually perform synchronization with the directory for generating
keys and certificates for the directory groups.

Default value: False.

¢ Create Computer Keys — Indicates whether a key and certificate are automatically
created for each computer in the directory service. This option is relevant for computer-
based services that require signature operation. These services perform signature
operations using the workstation’s key.

Default value: False.

¢ Periodic Directory Sync Timer (LDAP and AD Multiple Domains environments) — How
often (in seconds) the system should perform a full users database synchronization
against the Directory’s user databases in order to generate keys and certificates for new
users, update user keys and certificates due to changes such as email address changes,
or delete users.
In the case of LDAP and AD Multiple Domains, synchronization only applies to user
updates and user deletion.

Note: A low value (i.e., several seconds) increases the frequency of DocuSign SA
synchronization with the directory, but may decrease DocuSign SA performance levels.

Default value: 1800 seconds.

¢ User Certificate Publishing (Active Directory) — Indicates whether to publish the end
user’s certificate to the user’s account in the domain. This functionality is not necessary
when certificates are used for signature operations.

Default value: False.

¢ Directory Server Search Base (relevant only for LDAP — This read-only field indicates
the base location in the directory for searching the accounts of the signing users in the
LDAP directory.

Default value: Empty.

¢ Built-in DocuSign SA Admin (relevant for all environments except Directory
Independent) — This Boolean parameter defines whether the only administrator of the
system is the built-in administrator. That is, that there are no DocuSign SA administrators
from the domain, and the only administrator of the system is the built-in administrator.
Setting this value to True improves the performance of any user login operation to the
appliance.

Default value: False.

Key Management Parameters

Note: This section is not relevant when DocuSign SA is deployed in a Common Criteria EAL4+
mode of operation.

¢ Extractable Keys — A read-only parameter. Specifies whether the generated keys of the
users can be extracted from DocuSign SA.
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Note: DocuSign SA cannot be configured to extract signature keys.

¢ The Users Key Length — The size in bytes of the users’ keys. This is relevant if the
DocuSign SA internal CA is used.
If this parameter is changed, user keys and their certificates will be regenerated right after
the appliance is restarted.

+ Regenerate user key — If this parameter is set to True, private keys will be automatically
regenerated upon certificate renewal.
If, upon certificate renewal, the new private key has a key size different from that of the
original private key, a new private key will be regenerated regardless of the value of this
parameter,

Default value: False

¢ Create user key mode — If this parameter is set to False, user keys will not be generated
as part of the user creation process; rather, the keys will be created upon a user’s first
attempt to login.

Default value: False

¢ Permit upload RSA keys — If this parameter is set to False, the user cannot upload RSA
keys into the DocuSign Signature Appliance and use them for signing data.
Note that if an external Certificate Authority is used, and during enroliment a key can be
generated inside the DocuSign Signature Appliance as part of the enrollment process,
then in this case the RSA key is generated inside the DocuSign Signature Appliance and
not imported to the DocuSign Signature Appliance.

Default value: False

¢ Maximum RSA key pool size — If this parameter is set to a value larger than 0, the RSA
key pool mechanism is activated.
In this mode, RSA keys are generated by the DocuSign Signature Appliance in advance
so that when a key generation operation is performed (for example, in the case of
generating a new account for a user), the operation will be performed instantly and an
RSA key from the pool will be used instead of generating a new key.
If an RSA key Pool mechanism is required, it is recommended to specify the value
200,000. This instructs DocuSign SA to prepare 200,000 RSA keys in advance.

This functionality is not supported for cases where DocuSign SA is installed in Common
Criteria EAL4+ mode.

Default value: 0

Certificate Management Parameters

Note: This section is not relevant when DocuSign SA is deployed in a Common Criteria EAL4+
mode of operation.

¢ Process Pending Request Timer — How often (in seconds) the system should process
pending CA-related requests. This parameter is relevant when using DocuSign SA in
automatic external CA mode.
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Default value: 60 seconds

+ Certificate Refresh Timer — How often (in seconds) the system should scan for
certificates that expire shortly, in order to refresh the certificates.

Default value: 86400 seconds (24 hours).

¢ Certificate Refresh Window — The number of days before the assigned refresh date
during which DocuSign SA may refresh the certificate.

For example, if a certificate was assigned a refresh date of January 20 (based on the
specified Certificate Expiration Variance), and the Certificate Refresh Window is 5 days,
the certificate may actually be refreshed anywhere between January 16 and January 20.

Default value: 7 days.

¢ Certificate Expiration Variance — The maximum number of days that may be subtracted
from the certificate’s expiration date for the purpose of refreshing the certificate. This
variance enables DocuSign SA to spread the refresh activity over a number of days.
For example, if 1000 users are added on the same day, their certificates all expire on the
same day as well. To avoid overloading the system on the expiration date, you might
specify a variance of 10 days. DocuSign SA would then assign a refresh date to each
certificate (for example, 100 certificates on January 20, 100 on January 21, etc.).

Default value: 1 day.

¢ CRL Publishing Frequency — How often (in days) the internal CA of DocuSign SA
publishes its Certificate Revocation List (CRL) into Microsoft Active Directory.

Note: The CRL contains information regarding revoked users.

Default value: 1 day.

¢ CRL Validity Period — Determine the time (in days) that the generated CRL is valid.

Default value: 1 day.

¢ AIA Publication Location — This parameter can be modified. This parameter specifies
the publication location of the AIA (Authority Information Access), which contains the
DocuSign SA Internal CA certificate.
This parameter is initially set during DocuSign SA installation (refer to Installing an Internal
Certificate Authority). If it is not set by the user, it retains its default value.
It is recommended to perform a Refresh Certificate operation (refer to Refreshing
Certificates) after setting this parameter in order to include the updated parameter value in
the generated certificate.

Note: Changing either the AIA Publication Location or the CRL Publication Location will
automatically set both Use CDP Location Settings and Use AIA Location Settings to
false. This means that if DocuSign SA published the AIA or CDP to the domain, it will not
continue and publish the certificate or CRL to the domain, and the administrator will need
to find another mechanism for publishing the certificate or CRL.

¢ CRL Publication Location — This parameter can be modified. This parameter specifies
the publication location of the CRL (Certificate Revocation List), which contains all the
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identifications of the revoked certificates of the DocuSign SA internal CA.

This parameter is initially set during DocuSign SA installation (refer to Installing an Internal
Certificate Authority). If it is not set by the user, it retains its default value.

It is recommended to perform a Refresh Certificate operation (refer to Refreshing
Certificates) after setting this parameter in order to include the updated parameter value in
the generated certificate.

Note: Changing either the AIA Publication Location or the CRL Publication Location will
automatically set both Use CDP Location Settings and Use AIA Location Settings to
FALSE. This means that if DocuSign SA published the AIA or CDP to the domain, it will
not continue and publish the certificate or CRL to the domain, and the administrator will
need to find another mechanism for publishing the certificate or CRL.

¢ Use CDP Location Settings — A read-only parameter. Specifies whether DocuSign SA
will attempt to publish the CRL in the specified location.

Default value: TRUE if the value of the CRL Publication Location parameter was not
changed during installation. In a Directory Independent environment, the value of this
parameter is always FALSE.

¢ Use AIA Location Settings — A read-only parameter. Specifies whether DocuSign SA will
attempt to publish the AlA in the specified location.

Default value: TRUE if the value of the AIA Publication Location parameter was not
changed during installation. In a Directory Independent environment, the value of this
parameter is always FALSE.

¢ Certificate Common Name — Defines how to set the value of the common name field in
the user certificate.
0 — According to the common name field of the user in the director

1 — According to the display name field of the user in the directory.
Default value: 0.

+ Certificate validity period — Defines the time in years that the end user’s certificate is
valid.

Default value: 1 year.

¢ CPS Object ID — Starting from DocuSign SA 5, you can attach a certificate policy attribute
to the certificate generated by the DocuSign SA internal CA. The Certificate Policy
Statement (CPS) contains a unique object ID (such as “2.16.840.1.113733.1.7.23.3”).
It is recommended to perform a Refresh Certificate operation (refer to Refreshing
Cetrtificates) after setting this parameter and the CPS URI parameter, to include the new
parameter values in the generated certificate.

Default value: empty.
This parameter is mandatory if it is required to attach a CPS attribute to newly generated
certificates.

¢ CPS URI - The URI of the location where the text of the CPS is published.
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Default value: empty.
This parameter is mandatory if it is required to attach a CPS attribute to newly generated
certificates.

¢ CA Account Name — The identification of the account as it is defined in the Symantec CA
Service. This parameter is defined during appliance installation and cannot be modified.
This parameter is relevant when using Symantec as the external CA.

¢ CA Service Connection Point — The URI of the location where the Symantec CA is
located. This parameter is defined during appliance installation and cannot be modified.
This parameter is relevant when using Symantec as the external CA.

+ DocuSign SA Certificate SN — The serial number of the authentication certificate used
by DocuSign SA to interface with the Symantec CA. This parameter is defined when the
PFX file is loaded to DocuSign SA and cannot be modified. A renewed PFX file has a new
SN. This parameter is relevant when using Symantec as the external CA.

+ External CA User Name — The user hame representing the organization that enables
DocuSign SA to interface with the Comodo CA. This parameter is relevant when using
Comodo as the external CA.

Change this value only in accordance with DocuSign support.

Default value: as defined during installation.

¢ External CA Password — The password corresponding to the External CA User Name.
This parameter is relevant when using Comodo as the external CA.
Change this value only in accordance with DocuSign support.

Default value: as defined during installation.

+ Add Certificate to CRL — Specifies whether to add certificates to CRLs when a user is
deleted or his/her user data is updated.

Default value: false.

¢ CA Cert Hash Algorithm — The hash algorithm used in the certificate generation process
by DocuSign SA’s internal CA.
A value of 1 means SHA-1. A value of 2 means SHA-256.

Default value: 2.

¢ Expired user action — This parameter is relevant when DocuSign SA is deployed in very
large user base scenarios (over 500,000 users). Please contact DocuSign before
modifying this value.
The possible values include:

+ 0 - automatically refresh user certificate when expired
When a user certificate expires it is automatically refreshed. The relevant signature
key can be refreshed as well depending on other system parameter values.

¢ 1 - Refresh user certificate at login
Upon expiration, the user certificate will not be refreshed automatically but only when
the user next logs in.

¢ 2 — Delete users with expired certificate
In order to reduce utilization of database resources, user accounts will be deleted
when their internal certificate is expired.
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Default value: 2.

¢ Key Usage Mask — This parameter expresses the Key Usage value in the user
certificate.
The values are as defined in the key usage section of the X.509 standard as defined in
RFC 5280.

Default value: 15.

¢ Enhanced Key Usage Enabled — Determines whether the user certificate includes an
enhanced key usage attribute.
Default value: True.

¢ Enhanced Key Usage Mask — This parameter expresses the Enhanced Key Usage
value in the user certificate.
Contact DocusSign support if you wish to modify this value.

Default value: 15.

+ Delete Expired users by window — This parameter is relevant when DocuSign SA is
deployed in a very large user base scenario (over 500,000 users). Contact DocuSign if
you wish to modify this value.

When this parameter is set to True, make sure that the Expired user action parameter is
set to the value of 2. In this case, it means that user accounts will be deleted when their
certificate is close to expiration (specifically, when it is X number of days away from
expiration, where X is the value of the Certificate Refresh Window parameter).

When this parameter is set to False and the Expired user action parameter is set to the
value of 2, it means the user account will be deleted when the user’s certificate expires.

Default value: False.

¢ The Locality name — Determines whether to display the locality field in each generated
user certificate. This value is supplied during appliance installation and cannot be
modified. This parameter is relevant when using Symantec as the external CA.

Client Security Setting Parameters

¢ Prompt for Logon — Indicates whether the user gets a logon prompt (as shown in
Figure 76) requiring entry of the user ID, password, and sometime their domain name,
when logging on to DocuSign SA.
If set to TRUE, the following dialog box appears once, for every user login session in
Windows.
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Figure 76 DocuSign SA Logon Prompt

Note: In LDAP and Directory Independent environments, the Prompt for Logon
parameter cannot be modified, and is automatically set to TRUE.

Note: If no input is entered into any of the logon dialog fields within the first 10 seconds,
a 10-seconds timer appears in the dialog. If no input is entered by the time this timer
expires, the logon dialog automatically disappears and the logon operation fails. This
parameter can be changed via the DocuSign SA Configuration Utility (refer to the
DocuSign SA Configuration Utility chapter in the DocuSign SA User Guide).

Default value: False.

¢ Prompt for Signhature — Indicates whether the user gets a prompt (as shown in Figure 76)
requiring entry of the user’s password before each digital-signature creation.
When using extended authentication, this parameter must be set to True.

Note: The User ID and the domain name (if required) are displayed in the popup dialog
box.

Note: In Common Criteria EAL4+ deployments this parameter is automatically set to
True and cannot be modified.

Default value: False.

¢ Enable Automatic User Logon — This parameter is relevant for all modes that prompt a
user to logon (i.e., Directory Independent, LDAP). If this parameter is True, then the user
is able to access his/her public information such as the user certificate, without requiring a
logon prompt. The logon prompt will appear only during a signature operation or a
management operation such as uploading a new graphical signature.
Using this option, you can reduce the number of logon pop-ups in applications that only
access the local store of users’ certificates.
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In the case of Active Directory installation when SSPI mode is used for authentication,
setting this parameter to False will improve logon performance.

Default Value: True.

User Activation— This parameter mandates user activation of his/her account prior to
using the account.

In Common Criteria EAL4+ mode this parameter value is always True and cannot be
modified.

Please consult with DocuSign support before modifying this value.

Default Value: False.

Auditing and Accounting Parameters

*

Report Signatures to Event Log — Indicates whether to report signature events to the
event log. Disable this option only if very high performance rates are required.

Note: In Common Criteria EAL4+ deployments this parameter cannot be modified.

Default value: True.

Enable User Counters — Indicates whether to enable user-based counters that
enumerate signature operations.

Default value: False.

Report Apps Names To Event Log — Indicates whether to record in the event log also
the name of the client application that performed the digital signature operation.

Default value: False.

Event Log Storage Period — Indicates the time in days that old events will be retained in
the DocusSign Signature Appliance event log.

Default value: 7

Alerts and Notifications Parameters

*

Mail Server Name — DNS name or IP address of the SMTP server used for sending email
notifications.

Default value: No mail server

Mail Server Port — The TCP/IP port number of the SMTP server used for sending email
notifications.

Default value: 25.

Email From Address — The source email address to be used for sending email
notifications.

Default value: none.

Syslog Server IP Address — The IP address of the syslog server. If the proper IP is set,

all major events are also reported to the syslog server. Without entering the IP address,
only events of system up or system down are reported to the syslog server.
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Default value: 0.0.0.0 (No IP defined).

Password Policy

The following parameters are relevant to a Directory Independent environment. These parameters
define a policy for the users’ passwords.

*

LDAP

Minimum Password Length — The minimal password length of a DocuSign SA user. The
minimal length cannot be set to less than 6 characters.

Default value: 6.

Maximum Password Validity — The maximal number of days the existing password is
valid. A value of 0 indicates that the validity is indefinite.

Default value: 0.

Minimum Password Validity — The minimal number of days the existing password is
valid. During this period the password cannot be changed. A value of 0 means that this
policy is not enforced.

Default value: O.

Maximum Repeats in password — The maximal number a character can be repeated in
a password. A value of 0 means that the policy is not enforced.

Default value: 0.

Maximum Sequence in password — The maximal number of ascending/descending
characters in a password. A value of 0 indicates that this policy is not enforced.

Default value: 0.

User Must Change Password — Whether the newly created user must change his/her
password.

In Common Criteria EAL4+ deployments, set this parameter to False. This causes the
user activation process to mandate that each user set his/her own fixed password.

Default value: False.

Max Password Failed Attempts — After the user failed to present his password several
times, the user is locked and only an administrator can release the user by setting a new
password.

This field indicates the maximal number of failed attempts.

A value of 0 indicates that this policy is not enforced.

Note: This section is not relevant when DocuSign SA is deployed in a Common Criteria EAL4+
mode of operation.

The following parameters are relevant to an LDAP based installation such as Sun-One, Tivoli, or
OID environments. These parameters enable DocuSign SA to properly communicate with the
LDAP server for the purpose of user authentication and users synchronization.
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¢ Primary LDAP server address — The DNS name or IP address of the primary LDAP
server.

Primary LDAP server port — The port number of the primary LDAP server.

Secondary LDAP server address — The DNS name or IP address of the secondary
LDAP server. This information enables DocuSign SA to work in a High Availability
directory environment.

Secondary LDAP server port — The port number of the secondary LDAP server.

LDAP Authentication Method — The method used to authenticate users in the LDAP
Server.

0 — Simple Authentication. The user and password are sent in clear format.

1 — The password is sent using Digest MD5 format. If you specify this option, set LDAP
Secure Mode to off.

Default value: 0.

¢ LDAP Server Realm name — The Realm name of the LDAP server, used when the
authentication method is Digest-MD5.
In a Sun One installation, this is the DNS name of the SUN One server.

¢ LDAP Secure mode — Whether secure LDAP is used or not. If this parameter is True,
then secure LDAP is used, that is, both the user ID and the password are sent encrypted
from DocuSign SA to the LDAP server.
Take care to also modify the LDAP Server port according to the secure LDAP port, which
is in most cases port 636.
To upload the Root Certificate of the SSL Server, use the Subordinate CA\Load Root Cert
Chain option, and specify the ROOT certificate.
If you specify LDAP secure mode, do not set LDAP Authentication Method to 1 (Digest-
MD5 format).

Default value: False.

¢ LDAP DocuSign SA user name — The full path distinguish name of a user who is allowed
to query information from the LDAP directory. In some environment, such as SUN One,
this definition is required by default.

For example, in Sun One, a parameter such as the following should be provided:
uid=administrator,ou=Administrators, ou=TopologyManagement, o=NetscapeRoot.

In other environments such as OID or Tivoli, this parameter can be left blank.

¢ LDAP DocuSign SA User Password — The password of the user who can query users
information in the LDAP server.

¢ Search Base in LDAP Server — The search base Distinguish Name for accessing
information in the LDAP server.

¢ LDAP Server UID attribute — The name of the User ID attribute field in the LDAP server.
If the value of this parameter is empty, this indicates that the default uid value is used.
Consult with DocuSign before changing the value of this parameter.
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Advanced Parameters

It is not recommended to modify any of the following parameters. Modify the parameters only if
instructed to do so by DocuSign support.

*

DocuSign SA Debug Level — Modify this parameter only when instructed to do so by
DocusSign’s technical support team.

Note: Running in debug mode (i.e., DocuSign SA Debug Level is greater than 2)

significantly decreases DocuSign SA performance levels.

Default value: 2.

Clients Inactivity Timeout — The time period after which DocuSign SA disconnects
inactive clients, in seconds.

Note: In environments with thousands of DocuSign SA clients, it is recommended to
decrease this value to several minutes. This reduces usage of appliance resources by
DocusSign SA clients.

Default value: 7200 seconds (2 hours).

Use SSL Proxy — Set this parameter to true if the DocuSign Signature Appliance can
connect to the Internet only through an SSL proxy.

This parameter is necessary if the DocuSign Signature Appliance must connect to an
External CA in automated mode to get users’ certificates.

Default value: false.

SSL Proxy IP — If DocuSign SA is installed in an organization which allows access to the
internet only through an HTTP proxy, DocuSign SA can be configured to use this proxy
when accessing external services such as the automatic external CA.

Indicates the IP address of the organization’s HTTP proxy.

Note that modifying this parameter requires a hardware restart of the DocuSign Signature
Appliance.
Default value: empty.

SSL Proxy Port — If DocuSign SA is installed in an organization which allows access to
the internet only through an HTTP proxy, DocuSign SA can be configured to use this
proxy when accessing external services such as the automatic external CA.

Indicates the port number of the organization’s HTTP proxy.

Note that modifying this parameter requires a hardware restart of the DocuSign Signature
Appliance.
Default value: empty.

SSL Proxy User Name — If the HTTP proxy through which the organization accesses the
internet requires authentication, this field indicates the valid user name of a user in the
organization.

Note that modifying this parameter requires a hardware restart of the DocuSign Signature
Appliance.

Default value: empty.
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¢ SSL Proxy Password — If the HTTP proxy through which the organization accesses the
internet requires authentication, this field indicates the password corresponding to the user
name of a user in the organization

Note that modifying this parameter requires a hardware restart of the DocuSign Signature
Appliance.

Default value: empty.

¢ Web Services Support — Indicates whether the DocuSign Signature Appliance provides a
Web Services interface. The Web Services interface runs on port 8080 of the DocuSign
Signature Appliance.

In Common Criteria EAL4+ mode or FIPS 140-2 level 3 mode, this interface should be
closed; that is, set this parameter to False.

Default value: true.

¢ RESTful Web Services Support — Indicates whether the DocuSign Signature Appliance
provides a RESTful Web Services interface.
This interface runs on port 8081 of the DocuSign Signature Appliance.

Default value: true.

¢ CORS domain for REST API — The DocuSign SA RESTful API can be called as part of
an HTTP session of another domain. For example, JavaScript code that is used as part of
a Web Session from another domain can interface with the DocuSign SA REST API.
In these cases, this system parameter can be set to enable interacting with the DocuSign
SA RESTful API from specific domains using a semicolon separated string. For example:
egl.com;eg2.com.

¢ Enforce FIPS Approved Algorithms — If this parameter is set to True, then only RSA
keys that are equal to or bigger than 2048 bits can be used, and only SHA2 algorithms
(SHA256, SHA384 or SHA512) can be used for the digital signature operation.

Set this parameter to True if you would like DocuSign SA to operate in FIPS mode.
When DocuSign SA is installed in a Common Criteria EAL4+ mode of operation, this
parameter is set to True and cannot be changed.

Default value: false.

¢ Case Sensitive Username — This parameter is relevant for a Directory Independent
installation. Prior to DocuSign SA version 6, login usernames were case sensitive. Starting
from version 6, by default login usernames are case insensitive. It is not possible to
change this value after the appliance is installed. If you wish to change the value, set it in
the Configuration Utility prior to installation (refer to Admin — Appliance Installation). Note
that when you perform an upgrade, the value of this parameter does not change because
all installations prior to version 6 are always case sensitive.

Default value: false (case insensitive).

¢+ Allow Get Backup anonymously — In this parameter an IP address can be specified to
enable downloading an automated backup of the DocuSign Signature Appliance without
supplying an administrator user ID and a password.
The backup process can be performed from the specified IP address.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 155

An IP address of 0.0.0.0 indicates that it is not possible to get the backup without
supplying a user ID and a password.

Default value: 0.0.0.0.

¢ Common Criteria Mode — This parameter indicates whether DocuSign SA is installed in
Common Criteria EAL4+ mode. If it is, the parameter has a value of True.

¢ Common Criteria Type — This parameter indicates the type of Common Criteria EAL4+
mode. It can have one of the following values:

¢ 0 - DocuSign SA is installed as a Signature Creation Device
¢ 1 -DocuSign SAis installed as a Seal Creation Device
This value cannot be changed after the appliance is installed.

+ Cloud Monitoring — This value indicates the type of monitoring used for sending
information to a Cloud Monitoring system. It can have the following values:

¢ 0 — Not activated

¢ 1 — Production based cloud monitoring. Should be used when the appliance is in the
production stage.

¢ 2 —Test based cloud monitoring. Should be used when the appliance is undergoing
testing.

Default value: 0

+ Cloud Site ID- a string identification value that should be configured if instructed to do so
by DocusSign Support.

Default value: empty

Extended Authentication

The following parameters are relevant in cases where the regular user authentication during
signature operation is extended to use one of the following mechanisms:

¢ One Time Password using a Radius Server — The end user enters a One Time
Password (OTP) using a special device. The One Time Password is checked against a
Radius Server, external to the DocuSign Signature Appliance.
The parameters described in Extended Authentication - Radius enable DocuSign SA to
communicate with the Radius Server.

¢ Smart Card Authentication — The user is requested to use a SmartCard as part of the
signature approval. As part of the digital signature operation, the DocuSign Signature
Appliance approves a Challenge that is signed by the SmartCard. The parameters
described in Extended Authentication — SmartCard enable DocuSign SA to communicate
with the SmartCard. To upload the Root Certificate of the authentication certificate of the
end user, use the Subordinate CA\Load Root Cert Chain option and specify the ROOT
certificate

¢ Biometric Authentication — An approval is sent to the DocuSign SA as part of the
biometric authentication. The parameters described in Extended Authentication - Biometric
enable DocuSign SA to communicate with the biometric device.
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Keep in mind that in extended authentication, the Prompt for Signature parameter must be set to
True (refer to Client Security Setting Parameters).

Extended Authentication - General

¢ Extended Authentication Method — Define the primary authentication method to be
used:
0 — Built in: No extended authentication method. DocuSign SA uses the regular password
verification mechanism.
1 — Radius based extended authentication.
2 — SmartCard based extended authentication.
3 — Biometric based extended authentication.

When DocusSign SA is installed in Common Criteria EAL4+ mode as a Qualified Signature
Creation Device, the value is always 1 and cannot be modified.

When DocuSign SA is installed in Common Criteria EAL4+ mode as a Qualified Seal
Creation Device, the value is always 0 and cannot be modified.

Default: 0.

+ Alternate Extended Auth mode — When defined, if there is a problem during extended
authentication, then the DocusSign Signature Appliance will try using an alternate method.
-1 — None: DocuSign SA rejects the authentication attempt.
0 — Built in: No extended authentication method. DocuSign SA uses the regular user
password.
1 — Radius based extended authentication.
2 — SmartCard authentication based extended authentication.
3 — Biometric based extended authentication.

Default: -1.
Note: this parameter is not implemented.

Extended Authentication - Biometric

¢ Biometric Authentication Window — For information contact DocuSign.
¢ Biometric Shared Secret — For information contact DocuSign.

Extended Authentication — SmartCard

Note: This section is not relevant when DocuSign SA is deployed in a Common Criteria EAL4+
mode of operation.

¢ SmartCard Authentication Window — The SmartCard authentication is based on a
challenge that is signed by the end user’s SmartCard. The challenge is based on time,
which is verified by the DocuSign Signature Appliance. The Authentication window is the
time in seconds that can elapse from the actual signature time.

Default: 120.
¢ Use SmartCard Auth for Logon — Determines whether the login will also be based on

SmartCard authentication. This option is relevant mostly for Active Directory deployments
that require only a SmartCard for login operation.
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0 —Login is not based on SmartCard authentication.
1 — Login is based on SmartCard authentication.

Default: 0.

Certificate Issuer Name — Validate users who are certified by the specified issue name. If
this parameter is empty then any ROOT certificate trusted by the DocuSign Signature
Appliance can certify users.

Enforce CRL Validation — Indicates that the DocuSign Signature Appliance will always
check the CRL. If there is any access problem to the CRL, the user authentication will fail.

CRL Retrieval — Assists the certificate validation mechanism of the SmartCard
authentication certificate.

When querying the CRL, this parameter indicates whether to retrieve the CRL from the
cache, or it indicates the timeout when retrieving the CRL from the network.

0 — Use the default timeout value for retrieving the CRL from the network.
1 — Retrieve the CRL from the CRL Cache.
Other — A timeout in milliseconds for retrieving the CRL.

Default: 0

Extended Authentication - Radius

*

Require Static Password — When this value is true, the end user must enter DocuSign
SA’s static password, followed immediately by the Radius password.

If the Radius server has an internal mechanism that combines a static password and a
dynamic password, it is advisable to set this parameter to False. In addition, do not get
confused between the static password assigned by the Radius server and the static
password required by the DocuSign Signature Appliance

In Common Criteria EAL4+ mode when DocuSign SA is installed as a Qualified Signature
Creation Device, this parameter is always True and cannot be modified.

Default: False.

Default Radius password length — If Require Static Password is set to True, this
parameter specifies the number of characters in the Radius password. This enables the
DocusSign Signature Appliance to separate the regular password from the Radius
password.

DocuSign SA will authenticate the user using the DocuSign SA static password, and then
send only the Radius password portion to the Radius server for authentication.

Default: 6.
Radius Server IP Address — The IP address of the Radius Server.

Radius Server port — The port number of the Radius Server.
Default: 1812.

Alternate Radius Server IP Address — This parameter is not applicable.
Alternate Radius Server Port — This parameter is not applicable.
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Default; 1812.

+ Radius Server Secret — The shared secret between the Radius Server and the DocusSign
Signature Appliance.

¢ Radius Server Timeout — The time in seconds to wait for the Radius server’s response.
Default: 5.

+ Radius Server Retries — The permitted number of retries when trying to validate the user
credentials against the Radius server.

Default: 2.

+ Enable the Radius AD attribute — If set to True, the user identification that is sent to be
approved by the Radius server is based on the value of the Radius customer AD attribute
parameter.

This parameter is only relevant when DocuSign SA is installed in an Active Directory
environment.

Default: False.

¢ Radius custom AD attribute — The name of the attribute in the Microsoft Active Directory
to be used as a user identity sent to the Radius server. For example,
physicalDeliveryOfficeName. If the content of the field is empty and the value of Enable
the Radius AD attribute is True, the user will be rejected.

This parameter is only relevant when DocuSign SA is installed in an Active Directory
environment.

¢ OTP validation method — This parameter defines the OTP device types that can be used.
The following types can be used:

¢ 1-OATH-HOTP — a standard OATH-based OTP device that is an event based OTP.
¢ 2-OATH-TOTP — a standard OATH-based OTP device that is a time-based OTP.
¢ 3-VASCO - An OTP devices manufactured by Vasco.

¢ OTP OATH validation window — This parameter is relevant when an OATH-HOTP
device is used (an event based OTP device). The validation window enables validating
several validation events for cases where the end user pressed the Event button several
time before using it for the current digital signature operation.

¢ Additional Radius IPs (CC Mode) — Relevant for the case where Radius Servers are
used in a High Availability configuration, and where a special switch is used to select
which Radius Server to use.
In Common Criteria (CC) Mode, the Radius callback can be called from a list that is
composed of the above Radius Server |IP Address and a list of semicolon-separated IP
addresses. For example: 10.0.0.1;20.0.0.1

¢ Login for Sign Window — The value is defined in seconds.
If this parameter is set to a value larger than 0, then several digital signatures can be
performed from the same application following successful authentication.
The only constraint is that the digital signature operations must occur within the defined
time window.
The maximum allowed value for the Sign Window is 600 seconds (10 minutes).
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A value of 0 indicates that authentication is required for every signature operation.
Default value: 0

SNMP
The SNMP protocol is used for sending SNMP traps or setting SNMP parameters for viewing the
activity and performance status of the appliance.

¢ SNMP Service — Defines whether the DocuSign SA SNMP service is on or off.

If the DocuSign SA SNMP Service is on, the DocuSign Signature Appliance can be used
by a monitoring server to inspect information.

The MIB identity of the DocuSign SA software is 1.3.6.1.4.1.2774.3.1, where the prefix
1.3.6.1.4.1.2774 specifies DocuSign as the vendor of the DocuSign Signature Appliance
product.

Default: False.

¢ SNMP Accepted community hame — Defines which community members can manage
the DocuSign SA’s SNMP agent. This parameter is concealed.
Default: Empty.

+ SNMP Manager 1 — An IP address of the first SNMP management system.
Default: Empty.

¢ SNMP Manager 2 — An IP address of the second SNMP management system.
Default: Empty.

+ Contact Name — The contact name of the SNMP agent residing in this DocuSign
Signature Appliance.
Default: Empty.

¢ Location — The location name of the SNMP agent residing in this DocuSign Signature
Appliance.
Default: Empty.

SAML

You can connect to DocuSign SA and present an SAML ticket provided by a trusted
organizational server.

Note: The following SAML parameters are not relevant when DocuSign SA is installed in
Common Criteria EAL4+ mode.

¢ SAML Working Method — The SAML authentication mode used for Logon operation. The
possible values include:

¢ 0 - Disabled — It is not possible to present an SAML token as part of the user login
process.

¢ 1 - All Users — All users can present an SAML token as part of their initial connection
to the DocuSign SA Service and in subsequent login operations.
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¢ 2 — User with group association — Only users who are associated with a DocuSign SA
group can present an SAML token as part of their initial connection to the DocuSign
SA Service and in subsequent login operations.

¢ Accepting Relying Parties Tickets — The name of the DocuSign SA Service as identified
by the relying parties that generate the SAML tickets. The DocuSign SA service can be
specified based on a regular expression. If there are several regular expressions they can
be separated by a semicolon.

¢ SAML Common Name — The name of the attribute in the SAML ticket that stores the end
user's common name.

Default: CommonName.

¢ SAML Email Address — The name of the attribute in the SAML ticket that stores the end
user’'s email address.
Default: emailaddress.

¢ SAML UPN - The name of the attribute in the SAML ticket that stores the end user’s
identity.
Default: upn.

¢ SAML Telephone Number — The name of the attribute in the SAML ticket that stores the
end user’s telephone number.
Default: telephoneNumber.

¢ SAML Display Name — The name of the attribute in the SAML ticket that stores the end
user’s Display Name.
Default: displayName.

¢ SAML Group Name — The name of the attribute in the SAML ticket that stands for the end

user’s Group. In order to utilize the Group functionality of DocuSign SA, the SAML group
name must match an existing group defined in the DocuSign Signature Appliance.

Default: Group.
¢ SAML Window — The grace period in minutes during which the SAML ticket is still valid
beyond the formal expiration time of the SAML ticket, as well as the time period in minutes

that the SAML ticket is valid before the formal starting time of the SAML ticket.
This parameter is intended to solve time synchronization issues.

Default: 5 minutes.
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Restoring the DocuSign Signature Appliance

The Restore operation enables you to restore the DocuSign Signature Appliance from a
previously generated backup file (refer to Backing up the DocuSign SA Data). You may wish to do
this if there has been data loss or corruption or if you want to set up a new DocuSign Signature
Appliance with the data from a previously installed appliance.

The Restore operation is similar to installation (refer to Installing the DocuSign Signature
Appliance Software). However, since a backup file is used for restoration, not all information
entered during installation needs to be reentered. In addition, the restore operation usually takes
less time than installation. The actual length of time depends on the number of users who were
created/deleted/updated after the date of the backup, and the selected key length.

The following sections provide instructions for restoring the DocuSign Signature Appliance in
Microsoft Active Directory, LDAP, and Directory Independent environments.

Restoring the DocuSign Signature Appliance in Microsoft Active Directory

Note: In order to run the restore operation, you must have permissions similar to those required
for installing the DocuSign Signature Appliance software. Refer to Installing the DocuSign
Signature Appliance Software for more information.

To restore the DocuSign Sighature Appliance:

1. Make sure the appliance is in Factory Settings mode. You can check whether the Install
state is Factory in the consoles’ Status menu (refer to Displaying DocuSign SA Status).
To restore DocuSign SA to its factory settings, refer to Restoring Factory Settings.

2. Inthe DocusSign Signature Appliance Management window (Eigure 68), right-click
DocuSign Signature Appliances and select All Tasks > Restore from the popup menu.
A standard file selection dialog box appears.

Browse to the backup file, and click Open.

Enter the IP address of the DocuSign Signature Appliance and click Next. The User setup
dialog box appears.

5. Click Next. Enter the built-in DocuSign SA administrative user. You must provide the
password of the built-in administrative user and confirm the password.

6. Enter the Admin user name and Admin password of an administrator who has
permission to join the DocuSign Signature Appliance to the domain.

Note: The Admin user name enables DocuSign SA to register computers as members
of the domain during restoration. DocuSign SA does not require these administrative
rights for regular use.

In the following pages, default settings from the original installation will appear disabled.
Click Next at every page.

7. Click Next. DocuSign SA restoration begins. A status bar displays the status of the restore
operation.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 162

9.

At the prompt, insert the backup MiniKey token that was used when first installing this
appliance. DocusSign SA reads the data from the MiniKey token. No writing to the MiniKey
token is performed at this stage.

At the prompt, insert the license MiniKey token.

When the operation is complete, the message Installation of DocuSign Signature
Appliance finished successfully appears above the status bar.

Note: It is highly recommended to restart the DocuSign Signature Appliance and synchronize
DocuSign SA with the Active Directory immediately after restoring the DocuSign Signature
Appliance. For more information, refer to Synchronizing DocuSign SA with the Directory Service.

Restoring the DocuSign Signature Appliance in an LDAP Environment

To restore the DocuSign Sighature Appliance:

1.

8.

Make sure the appliance is in Factory Settings mode. You can check whether the Install
state is Factory in the consoles’ Status menu (refer to Displaying DocuSign SA Status).
To restore DocuSign SA to its factory settings, refer to Restoring Factory Settings.

In the DocuSign Signature Appliance Management window (Eigure 68), right-click
DocuSign Signature Appliances and select All Tasks > Restore from the popup menu.
A standard file selection dialog box appears.

Browse to the backup file and click Next.
Enter the IP address of the DocuSign Signature Appliance.

Click Next. Enter the built-in DocuSign SA administrative user. You must provide the
password of the built-in administrative user and confirm the password.

In the following pages, default settings from the original installation will appear disabled.
Click Next at every page.

Click Next. DocuSign SA restoration begins. A status bar displays the status of the restore
operation.

At the prompt, insert the backup MiniKey token that was used when first installing this
appliance. DocusSign SA reads the data from the MiniKey token. No writing to the MiniKey
token is performed at this stage.

At the prompt, insert the license MiniKey token.

When the operation is complete, the message Installation of DocuSign Signature
Appliance finished successfully appears above the status bar.
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Restoring the DocuSign Signature Appliance in a Directory Independent Environment

To restore the DocuSign Signature Appliance:

1.

8.

Make sure the appliance is in Factory Settings mode. You can check whether the Install
state is Factory in the consoles’ Status menu (refer to Displaying DocuSign SA Status).
To restore DocuSign SA to its factory settings, refer to Restoring Factory Settings.

In the DocuSign Signature Appliance Management window (Figure 68), right-click
DocuSign Signature Appliances and select All Tasks > Restore from the popup menu.
A standard file selection dialog box appears.

Browse to the backup file and click Next.

Enter the IP address of the DocuSign Signature Appliance and click Next. The User setup
dialog box appears.

Click Next. Enter the built-in DocuSign SA administrative user. You must provide the
password of the built-in administrative user and confirm the password.

In the following pages, default settings from the original installation will appear disabled.
Click Next at every page.

Click Next. DocuSign SA restoration begins. A status bar displays the status of the
restore operation

At the prompt, insert the backup MiniKey token that was used when first installing this
appliance. DocusSign SA reads the data from the MiniKey token. No writing to the MiniKey
token is performed at this stage.

At the prompt, insert the license MiniKey token.

When the operation is complete, the message Installation of DocuSign Signature
Appliance finished successfully appears above the status bar.

Using the Users Management Utility

The Users Management utility provides user management operations in cases where DocuSign
SA is installed in a Directory Independent environment as well as the ability to view and perform
some actions upon users when DocuSign SA is installed in Active Directory /LDAP environments.

The Users Management utility enables an administrator to perform the following:

Add a new user (only in a DI environment).
Delete an existing user (in an LDAP, Multiple AD Domains, and DI environment).

Change the password of an existing user (only in a DI environment). Note that this
operation is not allowed when DocuSign SA is installed in Common Criteria EAL4+ mode.

Enable a user to log in to DocuSign SA or disable a user from logging in to DocuSign SA.
View users’ information.
Reset global and user-based signature counters.

You can also define groups of users. A user can be assigned to one group at most. The group’s
settings affect all users who are members of that group; for example, if a group is disabled, all
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users who belong to the group cannot login to DocuSign SA.

The groups mechanism is available only in Directory Independent installations.

An organization can use the groups mechanism to define multiple user communities that are
served by a single DocuSign Signature Appliance. Each group’s settings specify the rules and
parameters for managing that group of users.

It is also possible to manage Active Directory users in DocuSign SA groups by assigning each
user to a group after the user is copied from the Active Directory to DocuSign SA.

When SAML is used, a user that initially connects to the DocuSign Signature Appliance by
presenting a SAML ticket is automatically assigned to a group if the SAML ticket contains a Group
attribute.

Group management is not enabled when DocuSign SA is installed in a Common Criteria EAL4+
mode of operation.

The Users Management utility enables the administrator to perform the following group-related
actions:

Add a new group

Delete an existing group

Update an existing group

View a group’s settings

Assign a user to a group or unassign a user from a group.

* & o o

Note: All these operations can be performed using a DocuSign SA API called Signhature
Local User Management API. For more information on DocuSign SA Signature APIs,
refer to the DocuSign SA Signature APIs Developer’s Guide.

Note: If the DocuSign SA REST interface will be used, you must make sure that the User
Logon is based only on alphanumerical characters and the following characters: _ or -
(underscore or hyphen). Any other characters such as /A cannot be used.

Activating the Users Management Utility

The Users Management utility is installed as part of the DocuSign Signature Appliance
Admin client component.

To activate the Users Management utility:

1. Open the Start menu and select Programs > DocuSign - Signature Appliance >
Signature Appliance Control Panel. The DocuSign SA Control Panel appears.

2. Inthe DocuSign SA control panel activate the Users Management utility.
The Users Management main window appears.

3. Use the Login or Login built-in user option to enable the administrator to login to
DocuSign SA.

4. Click Login and enter your user-name and password.
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The user-name and password is verified by the DocuSign Signature Appliance. Also, the
DocusSign Signature Appliance checks that the connecting user has user administration
access rights.

Users Management Main Window

The main window of the Users Management utility displays existing users in the DocuSign SA
database. Management operations can be performed using the drop-down menus, the toolbar, or
the right click menu that appears when a user is selected.

File Manage View Help
& gRBE 0V

Username Email Commaon Name

€7 John Miller IMiller@domain.com John Miller

€ csnadm csnadm
userl userl@domain. .com user1
user2@dormain.com
el users user3@domain.com userd | |

Ready NUM SCRL Display: 5 Total: 5 License: 33 Signatures: 27; 27; 27

Figure 77 Directory Independent Users Management Utility - Main Window
The following user details can be displayed:

User Name — The login name of the user.

¢ Email = The email address of the user.
¢ Common Name — The common name of the user.
¢ Type — The type of user: User, Computer, Group. The Computer and Group types are

relevant when working with Computer Keys or Group Keys (refer to Users Directory
Parameters).

¢ Rights — The access rights of the user. The following rights are possible:
+ Regular user.
+ Appliances admin.
¢ Users admin.
+ Group admin.

Note: Only a Users admin can create new users and assign roles to a user. This means
that only a Users admin can create an Appliances admin.

The Appliances admin cannot add permissions to existing users.

When DocuSign SA is deployed in Common Criteria mode, you cannot create a user
who has both administrative privileges and signatory/user privileges.

Last Update Time — The date and time when the user was last updated.
User Status — The current status of the user. The possible values are:
¢ Enabled.

+ Disabled. In the case of an Active Directory environment, this indicates that the user
was removed from the Signers group in Microsoft Active Directory. The user still exists
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in the DocusSign SA users database, but is not able to sign.
In the case of a Directory Independent environment, this indicates that the user cannot
login to DocuSign SA.

¢ Signature Counter — Counts how many signatures the user performed. The counter is
effective only if the Enable User Counters system parameter is set to True.

Enrollment Status — The enrollment status of the user’s certificate.
Enrollment reason — Reason for certificate enrollment.

Users Management Window Status Bar
The status bar of the Users Management window displays the following information:
¢ Display — The number of users currently in the display. If a filter is used, the number will
include only the users that matched the filter and appear on screen.
Total — The number of users in the DocuSign SA database.
License — The number of users in the license token of the DocuSign Signature Appliance.

Signatures — The number of digital signatures that were performed using the DocuSign
Signature Appliance. Three signature counters are displayed. The second and third
counters can be reset by the administrator. The first counter cannot be reset and displays
the overall number of digital signature operations performed by the appliance since it was
installed.

Users Management Menus

The following sections describe the menu options available from the Users Management drop-
down menus: File, User, View and Help.

File Menu
The following options are available from the File drop-down menu.

Reset System Signature Counter

Enables the administrator to reset the second and third system signature counters. Each of these
counters displays the number of signatures performed using DocuSign SA since the counter was
last reset.

Generate Users report

Enables generating a report for all DocuSign SA users. This report contains all the important
DocuSign SA user record fields. The report is output in a format that can be displayed in Microsoft
Excel.

Login

Enables the administrator to login to DocuSign SA. The administrator is prompted for his/her user
ID and password. If DocuSign SA is installed in an MS Active Directory and the mode of operation
is SSPI, the administrator is logged on based on the existing PC login session.
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Login built in user

Enables login using the built in administrator. The administrator is prompted to provide a user ID
and password.

Logout

Enables the administrator to logoff DocuSign SA.
Exit

Closes the Users Management application.

Manage Menu

The following options are available from the Manage drop-down menu. The options are activated
upon a selected user.

Reset User signature counter
Enables resetting the first and second signature counters of the user.
Reset User Password Counter

If a user’s password is locked due to presenting a wrong password in multiple login attempts, an
administrator can unlock the user account so that the user can try logging in again.

Note that this option merely resets to zero the number of actual failed login attempts.
New User

This option is relevant only when DocuSign SA operates in a Directory Independent environment.
This option enables adding a new user to DocuSign SA. When this option is selected, the New
User dialog box appears.
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Figure 78 Users Management Utility — New User Dialog Box
Enter the following user parameters:

¢ User Name — The identification of the new user.

¢ Common Name — The Common Name of the user as it will appear in the user’s
certificate.

Email — The email address of the user, as it will appear in the user’s certificate.
Permissions — The user’s authorizations. Select one or more of the following:
¢ User — A regular DocuSign SA user.

+ Appliances Management — Permission to perform administrator activities, such as
downloading the event log and backing up the database.

Users Management — Permission to manage DocuSign SA users.
Group Management — Permission to manage users in the group to which this user
belongs.

¢ When DocusSign SA is installed in Common Criteria EAL4+ mode, a user cannot be
both an administrator (of either type) and a regular user.

Password — The password of the user.

Confirm Password — Confirmation of the user’s password.

Group — The group to which the user is assigned. If you click Select, the Manage Groups
dialog box appears, enabling you assign a user to any group, or to none.
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Figure 79 Manage Groups Dialog Box

Delete User

Enables deleting a user from the DocuSign Signature Appliance. When this option is selected, a

confirmation message appears, requiring confirmation for the deletion operation.

Set User Password

Enables updating a user’s password. When this option is selected, the Set new password dialog

box appears. Enter and confirm the new password.

Note that this dialog box also enables the administrator to update the permissions of the user.

Note that setting a password is not possible when DocuSign SA is installed in Common Criteria

EAL4+ mode.
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User Properties

Enables displaying existing information for a selected user. When this option is selected, the User

Data dialog box appears.
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Common Mame :

Ernail :
Type:

Permizzions

Last Update Time :
Status :

General Signatures Counter ;

Perzonal Signature Counter 1 :
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Group:
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[ zer
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Wwed Aug 17 120155 2016
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0
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0

Select...
Certificate iz OFK

Figure 80 Users Management Utility — User Data Dialog Box

Note that almost all properties can be viewed in the main window of the users Management utility.
The Personal Signatures Counter 1 and Personal Signature Counter 2 displayed in this dialog box
indicate the number of digital signature performed by this user since the last time these counters
were reset for the user. These counters are active only if the Enable User Counters system

parameter is set to True.

Manage Groups

EAL4+ mode of operation.

Note: This operation is not relevant when DocuSign SA is deployed in a Common Criteria

This option displays the Manage Groups dialog box. Using this dialog box you can manage all

groups inside DocusSign SA.
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The dialog box lists all existing groups inside DocuSign SA and their status (Enabled or Disabled).
When a group is Disabled, all users who are members of the group cannot login to DocuSign SA.

MName Status

Management Enabled
Marketing Enabled
Sales Enabled
Support Enabled

Mew group

Figure 81 Users Management Utility — Manage Groups Dialog Box

You can perform the following operations:

¢ New Group — Add a new group to DocuSign SA. When you click New Group, the Group
Settings dialog box appears:
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Figure 82 Users Management Utility — Group Settings Dialog Box
You can define the following parameters for a group:
¢ Name — The group name. The name must be unique. This is the only mandatory field
in the dialog box.
Phone — A phone number for this group.
Domain Name — The domain name for this group.

Organization — The organization associated with this group. In all certificates of users
that belong to this group, the organization parameter will include this Organization
value. If this parameter is not empty, then when a user is assigned to a group, the
user’s certificate is regenerated in order to update it with this parameter value.

+ Organization unit — A descriptive name for the organizational unit of the group (Sales,
Marketing, etc.)

Address — The address of the group.
Country — The country of the group.

Key size — The key size (in bits) of all the users who are group members. If you select
Default, the key size of group members remains unchanged. However, if you specify a
key size, then when a user with a different key size is assigned to the group, that
user’s key and certificate are regenerated in accordance with the key size you
specified.
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¢ CPS URI - The Certificate Policy URI for all the users in the group. The certificate of
all the users in the group will contain this CPS URI. An empty URI means that the
default system CPS URI is used.

¢ CPS object ID — The Certificate Policy object ID for all the users in the group. The
certificate of all the users in the group will contain this CPS Object ID. An empty Object
ID means that the default system CPS Object ID is used.

¢ Group capacity — The maximum number of users in the group. A value of 0 means
that the number of users in the group is not limited and the only restriction is the
number of users permitted by the license.

+ Enforce prompt for sign — If the system parameter Prompt For Signature is not
selected, you can override the setting, so that each group member is prompted to
supply a password before every digital signature operation.

¢ Enabled — Whether the group is Enabled or Disabled. If a group is Disabled, no group
member can login to DocuSign SA.

¢ Update — Update the selected group. When you click Update, the Group Settings dialog
box appears (Figure 82), displaying the current settings of the group. You can change any
of the settings.

Delete — Delete the selected group from the system.

Double clicking a group in the list displays the Group Settings dialog box (Figure 82). You
can view and modify any of the settings.

New Group

Note: This operation is not relevant when DocuSign SA is deployed in a Common Criteria
EAL4+ mode of operation.

Creates a new group. When you select this option, the Group Settings dialog box (Figure 82)
appears. For explanations, refer to the explanations following (Figure 82).
View Menu
Toolbar
Enables toggling the view of the toolbar.
Status Bar
Enables toggling the view of the status bar.
Filter

Enables the administrator to filter the user display in the main window. When this option is
selected, the Users filter definitions dialog box appears.
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Figure 83 Users Management Utility — Users Filter Definitions Dialog Box
You can filter the users display as follows:
¢ Maximum number of users in display — Set this number to limit the number of users
displayed in the main window. Default: 50.
+ Filtering Criteria — You can specify any of the following filtering criteria:
¢ Field — Enter a Name, Common Name, or Email,

+ Greater or equal to — Enter a string. The greater or equal calculation is based on
comparing the string with the value you entered in Field.

¢ Group Name — Check the option and select a group.

The filtering criteria you specify is logically ANDed. Thus for example, if you enter filtering
criteria in all three fields, the users list will display only the users belonging to the specified
group, whose Name/Common Name/Email is greater than or equal to the given string.

Refresh
Enables re-applying the filter on the users list. The users list refreshes and displays a users list
according to the filter criteria.
List lcon Details
Enables defining the display of users in the main window as follows:
+ List — Only user names are displayed.
¢ Icon — User names are displayed with a big icon.
¢ Details — Each user is displayed together with some user information. Use the Select
Columns option to specify which information will appear.
Select Columns

When this option is selected, the Select Columns dialog box appears. Use the dialog box to
define which fields are displayed in the main window when it is defined to display user details.
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Figure 84 Users Management Utility — Select Columns Dialog Box

Help

Displays the About window that specifies the Users Management version and provides a link to
the DocusSign site.

Users Management Toolbar

The Users Management toolbar contains shortcut buttons to the following options, available
also from the drop-down menus:

Button Task

= Login

&5 Built-in Login

i Logout

g5 New User

A Delete User

5 Set User Password
View user properties
Refresh Users list
' Filter

% About window
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Right-click User Menu

To activate the User right-click menu, right-click a user in the main window. The options Reset
user signature counters, Reset User Password Counter, Delete, Set Password, Properties
and Assign Group (included in New) are available also in the User drop down menu option of
the Users Management utility and are described in Manage Menu. The Change Status option is
available only through the user’s right-click menu. The Change Status and Assign Group
options are described below.

File Manage View Help
=& P ABY BT ®

Username Email

Commeon Name

ﬂ IMiller IMiller@domain.com Jehn Miller
csnadm

csnadm

€ user2 u Reset user signature counters 3

user2

£ user3 u Reset user password counter user?

Delete Ctrl+D
Set Password Ctrl+5
Properties Ctrl+P

Change Status 3
Assign Group

Figure 85 Users Management Utility — Right-click Menu
Change Status

Enables setting the status of a user to either Disabled or Enabled. A Disabled user cannot sign,

even if the user belongs to a group that is Enabled. This option is relevant only for a Directory
Independent environment.

File Manage View Help
m s RBE AV 7

Username Email Common Name

ﬁ IMiller IMiller@domain.com John Miller
ﬁ csnadm csnadm
userl@domain.com
€ user? Reset user signature counters > user2@domain.com user2
ﬁ user3 Reset user password counter user3@domain.com user3
Delete Ctrl+D
Set Password Ctrl+5
Properties Ctri+P
| Change Status 3 Enable
Assign Group Disable

Figure 86 Users Management Utility — Change Status Option
Assign Group

Enables assigning a user to a group, or unassigning a user from a group. When you select this

option, the Manage groups dialog box appears (Figure 79), with options for assigning/unassigning
a user.

Using Command Line Utilities

The following command line utilities can be executed from the administration station, and can be
used as part of an overall batch script that is periodically activated:
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GetBackup — Backs up a DocuSign Signature Appliance.

GetEvt — Retrieves the event log of the DocuSign Signature Appliance.
SetSCP — Sets the working state of the DocuSign Signature Appliance.
RestartServer.exe — Restarts a DocuSign SA Server.

* & & o o

Switch2Prim.exe — Perform a Switch-to-Prime operation for a given alternate
appliance.

¢ Groups — A Windows utility that enables end users to set their current group. This
enables the end user to use group keys. This utility cannot be executed in batch mode.

The GetBackup, GetEvt and SetSCP utilities are installed as part of the DocuSign
Signature Appliance Admin component and located under Program files\ARX\ARX
DocuSign SA Admin Client. The Groups utility is installed as part of the DocuSign
Signature Appliance Client component, and its files are located under Program
Files\ARX\ARX DocuSign SA Client.

Note: To display the required parameters for a command, execute the command without any
parameters.

GetBackup

The GetBackup command enables you to back up the DocuSign Signature Appliance to a file
located on the local network.

You can have a dedicated machine in the organizational network that can automatically call the
GetBackup command without specifying a user ID and a password.

Note: This command provides the same functionality as the All Tasks > Backup option in the
DocuSign SA Administration MMC (refer to Backing up the DocuSign SA Data).

The following table describes the available parameters for GetBackup:

Parameter Description

-F <Output File Output file name of the backup file.

name>

-IP <IP Address> IP address of the DocuSign Signature Appliance.

If this value is omitted, it will be taken from the SCP or from the
client configuration.

-A <1,2,3,4> Prompt For Logon value:

1-SSPI

2 — Server Side Authentication (AD, LDAP)
3 — SSPI User/Password Client (AD)

4 — User Password. Directory Independent

If this value is omitted, it will be taken from the SCP or from the
client configuration.
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Parameter

Description

-PN <DocuSign SA
Principal Name>

Principal name of the DocuSign Signature Appliance. This is the
name of the DocuSign Signature Appliance in the directory service
(i.e., csn000001). This parameter is mandatory in Microsoft Active
Directory environments.

If this value is omitted, it will be taken from the SCP or from the
client configuration.

-U <User Name>

DocusSign SA administrator user name.

-P <User Password>

Password of the DocuSign SA administrator user.

-D <Domain Name>

Name of the domain or context.

GetEvt

The GetEvt command enables you to retrieve an event log from the DocuSign Signature

Appliance.

Files).

Note: This command provides the same functionality as the All Tasks - Download Logs >
DocuSign SA Event option in the DocuSign SA Administration MMC (refer to Downloading Log

The following table describes the available parameters for GetEvt:

Parameter

Description

-F <Output File
name>

Output file name of the event log file.

-IP<IP Address>

IP address of the DocuSign Signature Appliance.
If this value is omitted, it will be taken from the SCP or from the
client configuration.

-A <1,2,3,4>

Prompt For Logon value:

1-SSPI

2 — Server Side Authentication (AD, LDAP)
3 — SSPI User/Password Client (AD)

4 — User Password. Directory Independent

If this value is omitted, it will be taken from the SCP or from the
client configuration.

-PN <DocuSign SA
Principal Name>

Principal name of the DocuSign Signature Appliance. This is the
name of the DocuSign Signature Appliance in the directory service
(i.e., csn000001). This parameter is mandatory in Microsoft Active
Directory environments.

If this value is omitted, it will be taken from the SCP or from the
client configuration.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.




DocuSign Signature Appliance Administrator Guide 179

Parameter Description

-U <User Name> DocuSign SA administrator user name.

-P <User Password> | Password of the DocuSign SA administrator user.

-D <Domain Name> Name of the domain or context.

restartServer.exe
The restartServer.exe utility restarts a DocuSign SA Server. It has the following syntax:

restartServer [-IP <IP address>] -U <User name> —-P <Password> [-D <Domain
name>] -RK <Restart operation type>

The following table describes the available parameters for RestartServer.exe:

Parameter Description

-IP <IP address> IP address or DNS name of the DocuSign Signature Appliance.
This parameter is optional

-U <User name> User name for authentication based on user name and password.

-P <Password> Password for authentication based on user name and password.

-D <Domain name> Domain name for authentication based on user name and
password.

This parameters is optional.

-RK <Restart Type of restart operation:
ti t > _ . .

cperation type 1 - Reboot the DocuSign Signature Appliance

2 - Shut down the DocuSign Signature Appliance

3 - Restart all services.
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Switch2Prim.exe

The switch2Prim.exe utility performs a Switch-to-Prime operation for a given alternate
appliance. It has the following syntax:

Switch2Prim.exe -F <File name> [-IP <IP address>] [—-A <Authentication
kind>] [-PN <Principal name>)] [-U <User name>] [-P <Password>] [-D <Domain
name>)]

The following table describes the available parameters for Switch2Prim.exe:

Parameter Description

-F <File name> A log file for messages produced as part of the Switch2Prime
process

-IP <IP address> IP address or DNS name of the DocuSign Signature Appliance.

This parameter is optional

-A The type of authentication to use when accessing the alternate
<Authentication appliance:
kind>

1 - SSPI

2 - Server side authentication
3 - SSPI User Password client side

4 - Push authentication

-PN <Principal The DocuSign SA principal name for SSPI authentication.

name> . . .
This parameter is optional

-U <User name> The user name for authentication based on user name and
password.

This parameter is optional

-P <Password> The password for authentication based on user name and
password.

This parameter is optional

-D <Domain name> The domain name for authentication based on user name and
password.

This parameter is optional
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SetSCP

The setsSCP command enables you to define in the directory whether the appliance is up or
down. This enables or disables the appliance, and thus allows DocuSign SA clients to
immediately determine whether or not the DocuSign Signature Appliance is active.

Note: In an Active Directory environment you must be joined to the parent domain to activate
the SetSCP utility. The utility will not work if the client is joined to the child domain.

Note: This utility is not relevant for a Directory Independent or LDAP environment.

The following table describes the available parameters for SetSCP:

Parameter

Description

-D <Domain Name>

Name of the domain or context.

-N <Appliance
Name>

Principal name of the DocuSign Signature Appliance. This is the
name of the DocuSign SA workstation in the directory.

-K <Directory
Kind>

Type of directory service. Possible values:

[1 A — Microsoft Active Directory.

-S <Working State>

Working state of the DocuSign Signature Appliance. Possible

Groups

Groups is a Windows utility that enables end users to set their current group. Any keys and
certificates that are created by communicating with an external CA are directed to the specified

group.

Note: You must set the Create Group Keys system parameter in order to use group keys. Refer
to Changing DocuSign SA System Parameters.

Note: This utility is not relevant for a Directory Independent environment since there is no
definition of a group in that type of environment.

To set the current group:

1. Run the Groups utility. The DocuSign SA Client Default Group Selection dialog box

appears.

Select a group from the list in the dialog box.

Click OK. Any subsequent enroliment to an external CA (or any other activity that creates
keys or certificates) will be directed to this selected group.

Note: All users that belong to this group can use the certificates.
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Chapter 6: Using the DocuSign SA Consoles

This chapter describes how to connect to and use the DocuSign SA consoles to manage
DocuSign SA. The consoles enable operations that cannot be performed using the DocuSign SA
Administration MMC.

There are several types of DocuSign SA consoles, depending on the DocuSign Signature
Appliance hardware type and the DocusSign Signature Appliance hardware version.

Console Types
There are two main types of DocuSign SA Consoles:

¢ Web-based Console for DocuSign SA hardware versions 8.0
¢ Built-in Console for DocuSign SA hardware versions prior to 8.0

Overview of the Web-based Console for Hardware v8.0

The DocuSign SA FIPS hardware version 8.0 and DocuSign SA Enterprise appliance version 8.0
offer a web-based console as well as a built-in touch screen console. The touch screen console is
for display purposes only.

To access the web-based console, you must connect the administrative PC or laptop to the
dedicated LAN interface and use a web browser to connect to http://10.0.0.2:8088.

Overview of the Built-in Console for Hardware versions prior to v8.0

For DocuSign SA hardware versions prior to 8.0, a built-in console is provided. Access to the
console depends on the appliance type:

¢ Built-in Console: In the DocuSign SA FIPS model or FIPS model in a Common Criteria
EAL4+ mode, a built-in console is provided as part of the appliance.

¢ Configuring aterminal as a built-in Console: In the DocuSign SA Enterprise model, the
console functionality is provided by connecting the administrative PC through the
serial/USB port and running the console application on the administrative PC. For more
information see Configuring a Terminal as a built-in Console in Hardware versions prior to
v8.0 and Using the USB to Serial Adaptor.

Configuring a Terminal as a built-in Console in Hardware versions prior to v8.0

Note: This section applies to the DocuSign SA Enterprise model.

In order to use the DocuSign SA console, you must first configure the console terminal.
To configure the terminal:
1. Start DocuSign SA by turning the power switch on.

Note: DocuSign SA does not need to be installed at this stage.
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2. Using the supplied 9-pin crossed serial cable, connect a PC to DocuSign SA.
3. Onthe PC, run a terminal emulation application, such as HyperTerminal.

Note: HyperTerminal is supplied as part of the standard Microsoft 2003 installation and
can be found under Start > Programs 2> Accessories > Communications.

4. Configure the terminal application with the following parameters:

¢ COM port — The local serial port on the PC to which you connected the cable.
Baud rate (bits per second) — 9600.

Data bits — 8.

Parity — None.

Stop bits — 1.

¢ Flow Control — None.

* & o o

5. The main console screen appears on the terminal display. The main console screen
displays the main menu.

->Status Reset tamper Set Time
Use DHCP  Factorv restore HNetlare

IP addr Shutdown
up down select

Figure 87 Main Console Menu

Using the USB to Serial Adaptor

If your PC does not have a serial port, you can use a special USB to Serial adaptor provided with
the DocuSign SA Enterprise package.

To use the adaptor:

1. Attach the adapter to the USB port of your PC and connect the serial side of the adaptor to
the DocusSign Signature Appliance.

2. When prompted to provide a driver, put the supplied CD into the CDROM drive, and
specify the CDROM drive. The PC will find the driver on the CD and install it.

3. Configure the terminal application as above. The new adaptor will add a new COM port
such as COM3. Use this port as part of the configuration.
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Using the Built-in Console —Hardware versions prior to 8.0

The console is constantly running within all DocuSign SA models.
¢ To operate the built-in console in a FIPS appliance, use the four buttons (numbered 1, 2,
3, and 4 from left to right) located on the FIPS appliance’s front panel below the display.
+ To operate the external console terminal for an Enterprise appliance, use the keyboard
keys 1, 2, 3, and 4.
1 and 2 are usually used for moving up and down to locate the desired function, while 3 is usually
used for selecting.

Note: The bottom line in the display always shows the current function of each key.

DocuSign SA Enterprise refreshes the terminal display every 10 seconds. Therefore, when you
first open the console, it may take up to 10 seconds to view the display. To view the display
immediately, press any key.

The DocuSign SA FIPS model has a screen saver feature that displays the DocuSign logo if the
console is left idle for more than 10 minutes. Press any button to display the main menu.

The bottom right side of the main menu may contain a flashing message. This indicates a state
that requires user intervention. The possible messages are: [TAMPER!], [IP Addr], and
[License]. Refer to Console Problems for more information.
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Displaying DocuSign SA Status

From the main menu, select Status. The DocuSign Signature Appliance information appears
(Figure 88). Press 1 and 2 to scroll up and down.

1Ser# SIGAB201 Mar 24 2008 06:48:26 -0800]
iVersion SW4 .4 HWA.O ET 00:16:76:3e:77:27]
iService Running Addr 2.3.0.4 i

douwn back refreshi

2 3 4

Figure 88 DocuSign Signature Appliance Information

The following table describes the DocuSign Signature Appliance information parameters:

Parameter Description
Ser # The appliance’s serial number. This is also the appliance’s domain
computer name.
Note: The DocuSign SA FIPS appliance is prefixed csN, and
the DocuSign SA Enterprise appliance is prefixed sig.
Date The current appliance date and time (PDT time zone).
SW Version The DocusSign Signature Appliance software version.
HW Version The DocuSign SA appliance hardware version.
ET The Ethernet MAC address of the DocuSign Signature Appliance.
Service The status of the DocuSign SA service.
Possible values: Running, Starting, Stopped, Stopping.
Install The installation status of the DocuSign Signature Appliance.
Possible values: Installed, Factory, CRP Wait, REPL Wait.
Note: If a number is displayed for this parameter, installation is in
progress. The number indicates the installation phase.
Addr IP address of the DocuSign Signature Appliance.
Mask Subnet mask of the DocuSign Signature Appliance.
GW IP address of the default gateway.
DNS IP address of the DNS server.
DNS2 IP address of an alternate DNS server.
DHCP Indicates whether DHCP is enabled.

Possible values: Enabled, Disabled.

Disabled means that the IP address should be entered manually.
Enabled means that the IP address is taken from the DHCP server.
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Parameter

Description

State

The DocuSign SA service state.

Possible values: OK, TAMPER!, No IP Address, License Error.
Refer to Console Problems in Chapter 9: Troubleshooting for more
information.

Link

The network connectivity state.
Possible values: 10Mb, 100Mb, 1Gb.

DB size

The size of the DocuSign SA database files.

FIPS Mode

Indicates whether the appliance is operating in FIPS mode. Possible
values:

ON (appliance operating in FIPS mode).

Off (appliance not operating in FIPS mode).

Note: For DocuSign SA to operate in FIPS mode, make sure the
following system parameters are set as follows:

- Web Services Support is set to False.

- Enforce FIPS Approved Algorithms is set to True.

Admin group

The name of the directory users group whose members are allowed
to manage DocuSign SA via the DocuSign SA Administration MMC.

Role

The appliance’s role in the High Availability configuration. Possible
values: Primary, Alternate, Standalone.

Signers group

Relevant only to Active Directory environment. Indicates the name of
the Signers group in Active Directory.

WWYV Certs Information that relates to DocuSign SA when users’ certificates are
(Comodo) automatically issued by the Comodo CA.
The parameters are displayed in the following format:
UUU/VVV Pend W/X, where:
UUU is the number of current users in DB.
VVV is the maximal number of certificates that can be published for
the organization.
W is the number of pending certificate requests that were not yet
sent to Comodo.
X is the number of pending approval certificate requests. These are
the certificates requests that were not approved yet by Comodo.
Any parameters that are persistently non-zero indicate a problem,
such as a networking problem. If the problem persists, contact
DocusSign support.
Expired Displays expiration information.

If there is no expiration, the word Infinite is displayed. Otherwise,
the expiration date is displayed.
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Note: The console’s display is not automatically refreshed with new data. For example, if the
DocuSign SA Service is in the process of stopping, the Status continues to be displayed as
Running. In order to view updated information, return to the main menu and reselect Display
status. Use the Refresh option to get updated values.

Enabling DHCP

DHCP is enabled by default. If you are currently using a static IP address, you can use this option
to switch back to DHCP.

To enable DHCP:
1. From the main menu, select Use DHCP. The following message appears:
Setting DHCP mode, please wait.
The IP address of the DocuSign Signature Appliance is retrieved from the DHCP server.

2. You can view the value of the current IP address by selecting Display status from the
main menu.

Note: The DNS server’s address will also be retrieved from the DHCP server after selecting this
option.

Using a Static IP Address
To use a static IP address instead of DHCP:

1. From the main menu, select Set IP address. The current IP address information appears.

“& CoSign - HyperTerminal

File Edit Wiew Call Transfer Help
{Addr 002.005.000.028 GY 002.005.000.001 |
{Hask 255.250.250.000 DNS 002.005.000.001 |
EDNS2 000.000.000.000 SPD Auto Exiti
< - * - i
1 2 3 b
< » .
Connected 0:00:55 Auto detect 9600 &-M-1 TLIM

Figure 89 IP Address Information

2. Enter the IP address, network mask, default gateway, and DNS servers’ information. For
each parameter, use <— and —> (buttons 1 and 2) to move between digits, and use + and —
(buttons 3 and 4) to select the desired digit.
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3. Select Exit. When prompted, choose whether to Save (button 3) or Discard (button 4) the
newly set addresses.

4. The following message appears when you choose Save:
Setting IP address, please wait.
After the IP is set, the following message appears:
DONE

Note: If only the DNS fields are modified, the appliance will continue to use DHCP for
getting the IP address, subnet mask, and default gateway address.

Resetting the Tamper Mechanism (DocuSign SA Enterprise Only)

If the cover of the DocuSign SA Enterprise appliance is opened, the secret key used to protect the
DocuSign SA database is erased and the power is turned off. The next time DocuSign SA is
started, the Tamper LED flashes on and off, the Appliance has been tampered with
message is displayed, and the flashing [TAMPER! ] message is displayed in the main menu. The
tamper mechanism must be reset before DocuSign SA can be used.

To reset the tamper mechanism:
1. From the main menu, select Reset tamper.
2. At the prompt, insert one of the backup MiniKey tokens. The following message appears:

Please insert a backup Minikey that was created during
installation

3. After the backup MiniKey is inserted, the following message appears:

Resetting tamper, please wait ..
Done.

4. Remove the backup MiniKey token and insert the license MiniKey token.

Note: If you insert the incorrect backup MiniKey token, the Failed, press any key to
continue message is displayed and the tamper LED continues to flash. Perform the procedure
again using the correct backup MiniKey token.

Note: It is recommended to activate the Sync with Directory option after resetting the tamper
mechanism. For more information, refer to Synchronizing DocuSign SA with the Directory

Service.
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Restoring Factory Settings

The console enables you to restore DocuSign SA to its factory settings. You may want to do this
in any of the following circumstances:

*

DocuSign SA was installed for demo, pilot, or development purposes, and you now want
to reinstall the DocuSign SA software for production purposes.

You want to reinstall the DocuSign SA software with different parameters.

Installation failed or was stopped, and the DocuSign SA software cannot be reinstalled
again without restoring factory settings.

Restoring factory settings performs the following functions:

L4
L4

Deletes all data from the database, including all users, keys, and certificates.
Uninstalls the CA located within DocuSign SA.

Unregisters DocuSign SA from the domain.

Resets all DocuSign SA installation parameters to the default values.

Resets the DocuSign Signature Appliance.

Note: In Active Directory environments, unregistering the DocuSign Signature Appliance
removes the appliance from the domain, but does not remove the DocuSign SA computer from
the Active Directory. To fully unregister the DocuSign Signature Appliance, manually remove the
DocuSign SA computer from the Active Directory.

Note: If the DocuSign Signature Appliance was configured to receive certificates from a WWV
external CA automatically, the operator will be asked whether to revoke the existing certificates
in the external CA.

You may want to keep the existing certificates if you are intending to perform a restoration
operation right after the Reset to factory settings operation. If you choose to keep existing
certificates, old certificates will not be revoked and the user can continue using the existing
certificates.

To restore factory settings:

1.
2.

From the main menu, select Factory restore.

Enter yes to confirm the operation.

Shutting Down

To shut down DocuSign SA:

1.
2.

From the main menu, select Shutdown.

Enter yes to confirm the operation.
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Setting Time

This option enables the operator to update the DocuSign SA clock. This parameter is very
important since it affects the effective start date of a user certificate generated by DocuSign SA,
as well as affecting Active Directory user authentication.

You can modify the DocuSign SA time by either modifying the contents of DocuSign SA’s date
and time fields, or by specifying that DocuSign SA time will be constantly updated by the time of
an NTP server.

To set the DocuSign SA time:
1. From the main menu, select Set Time.

The current time is displayed.

iDate Sep 01 2004 Time 12:59:00 -0800 |

iNTP Server 000.000.000.000 i

i Exit]

L« - . -
1 2 3 b

Figure 90 Setting DocuSign SA Time

2. To modify the date and time fields, use the arrows to specify the field you wish to modify.
Use the + and — buttons to modify the content of the field.
Repeat for every field you wish to modify.

3. Alternatively, you can specify an NTP server IP address. This option constantly updates
the DocuSign SA Server time according to the NTP server time.

Notes:

If you modify the Date or Time fields, any value entered in the NTP server field is ignored
and set to all zeros.

If you wish to stop being updated by the NTP server, change the NTP Server field to all
zeros.

By default, in an Active Directory environment, the clock is automatically synchronized
with a Domain Controller. In this case, the text “AD Sync” will appear next to the NTP
Server field.

The time zone offset (“-0800” in Figure 90) cannot be updated and is displayed for
informational purposes only.

4. Use the arrows to navigate to Exit. When prompted, choose whether to Save (button 3) or
Discard (button 4) the new settings.
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Re-synchronizing with Active Directory

If you modify the time, synchronization with Active Directory is lost. To re-synchronize with Active
Directory:

1. Change the NTP server address from 0.0.0.0 to 10.0.0.1 (that is, not a real NTP server)
and press Save.

2. Change the NTP server address from 10.0.0.1 back to 0.0.0.0 and press Save again.
DocuSign SA is now synchronized with Active Directory.

Using the DocuSign SA Web-based Console

Starting from DocuSign SA hardware version 8, both the DocuSign SA FIPS model and the
DocuSign SA Enterprise model have a web-based console.

To access the web-based console, the appliance administrator must connect a PC or laptop to
the dedicated LAN interface, and use a web browser to connect to http://10.0.0.2:8088.

The main window appears.

Docugfgn? Signature Appliance Console Contact Us | Documentation

Status Network Time & Date Copy Backup MiniKey

Appliance Info

Installation Status Installed

DB Status Running

Service Status Running

Role Primary

Time & Date Aug 17 2016 02-32:53

Software Version 8.2

Hardware Version 8.0

FIPS Mode Off o

Figure 91 Web-based Console — Main Window
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The functionality of the web-based console is very similar to the functionality offered by the built-in
console. You can either view information (such as the IP address of the appliance) or perform an
administrative action such as setting the IP address of the appliance.

Whenever an action is performed, the administrator is required to:

1. Confirm the action. This results in appliance shutdown.

CONFIRM CHANGES

The appliance will shutdown

Confirm Abort

Figure 92 Web-based Console — Confirm Changes

2. Commit the changes by removing and re-inserting the license token in order to prove
physical access to the appliance.
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Dncu% Signature Appliance Consale Contact Us | Documentation

Status Network Time & Date Copy Backup MiniKey

Commit Changes

UsBe

=
m

Please ramove and re-mount the USE License MinlKey to conflrm changes

seconds remaining

"Timeout will abort the ocperation

Figure 93 Web-based Console — Commit Changes

Setting the Appliance IP Address
To set the DocuSign SA IP address:

1. In the main window, select the Network tab.
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DOCUS%!]/_ Signature Appliance Console e L

Status Network Time & Date Copy Backup MiniKey

Network Settings

® DHCP IPv4 IPv6
O IP Address IP Address IP Address _
IP Mask Subnet Prefix Length 0
IP GW IP GW —
DNS IP DNS IP _
DNS2 IP DNS2 IP v
< >

Figure 94 Web-based Console — Network tab
Specify whether the address will be supplied in IPv4 or IPv6 format.
3. Specify one of the following:

¢ DHCP - The system will use DHCP to obtain the IP address, network mask, default
gateway, and DNS servers’ information. If you select DHCP you cannot manually enter
any of the information.

¢ |IP Address — The system will use the information you enter manually. Enter the IP
address, network mask, default gateway, and DNS servers’ information

Note that only the operational LAN interface IP address can be updated. The
administrative LAN interface is the fixed IP address of 10.0.0.2.

Setting Time

This option enables the operator to update the DocuSign SA clock. This parameter is very
important since it affects the effective start date of a user certificate generated by DocuSign SA,
as well as affecting Active Directory user authentication.

You can modify the DocuSign SA time by either modifying the contents of DocuSign SA’s date
and time fields, or by specifying that DocuSign SA time will be constantly updated by the time of
an NTP server.
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To set the DocuSign SA time:
1. Inthe main window, select the Time & Date tab.
The current time is displayed.

DOCI.I,QY‘%H/T Signature Appliance Console Contact Us | Documentation

Status Network Time & Date Copy Backup MiniKey

Time & Date Settings

® Time & Date Aug 17 2016 02:36:28
Time Zone -0700
O NTP Server IPv4 \ IPV6

Figure 95 Web-based Console — Time & Date tab

2. To modify the date and time fields, select Time & Date and modify the values in the
following window that appears.

Note that the time zone offset of -0800 (i.e., Pacific Time zone) cannot be updated
and is displayed for informational purposes only.
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March 2016

Su Mo Tu We Th Fr Sa

1 2 3 4 5

6 7 8 9 10 1m 12

13 14 15 6 17 18 19

20 21 22 23 24 25 26
27 28 29 30 3

Time 09|v]: 57|v|: 57 |v|
Done

Figure 96 Setting DocuSign SA Time

Alternatively, you can specify an NTP server IP address. This option constantly updates the
DocuSign SA Server time according to the NTP server time. The NTP server IP address can be
specified in either IPv4 or IPv6 format.

Shutting Down
To shut down DocuSign SA:

1. Inthe main window, select the Shutdown & Restart tab.
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DOCUS%&T Signature Appliance Console Contact Us | Documentation

Status Network Time & Date Copy Backup MiniKey

Shutdown & Restart

Shutdown & Reset

Shutdown

Restart

Reset Tamper

Factory Reset

Figure 97 Web-based Console — Shutdown & Restart tab
In the Shutdown & Reset menu, select Shutdown.

Enter yes to confirm the operation.

Restarting the Appliance
To restart the appliance:
1. Inthe main window, select the Shutdown & Restart tab (Figure 97).
2. In the Shutdown & Reset menu, select Restart.
3. Enter yes to confirm the operation.

Resetting the Tamper Mechanism
To reset the tamper mechanism:

1. Inthe main window, select the Shutdown & Restart tab (Figure 97).
2. Inthe Shutdown & Reset menu, select Reset tamper.

3. Atthe prompt, insert one of the backup MiniKey tokens. The following message appears:

Please insert a backup Minikey that was created during
installation
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4. After the backup MiniKey is inserted, the following message appears:

Resetting tamper, please wait ..
Done.

5. Remove the backup MiniKey token and insert the license MiniKey token.

Note: If you insert the incorrect backup MiniKey token, the Failed, press any key to
continue message is displayed and the tamper LED continues to flash. Perform the procedure
again using the correct backup MiniKey token.

Note: It is recommended to activate the Sync with Directory option after resetting the tamper
mechanism. For more information, refer to Synchronizing DocuSign SA with the Directory
Service.

Restoring Factory Settings

The console enables you to restore DocuSign SA to its factory settings. You may want to do this
in any of the following circumstances:

+ DocuSign SA was installed for demo, pilot, or development purposes, and you now want
to reinstall the DocuSign SA software for production purposes.
You want to reinstall the DocuSign SA software with different parameters.

Installation failed or was stopped, and the DocuSign SA software cannot be reinstalled
again without restoring factory settings.

Restoring factory settings performs the following functions:
¢ Deletes all data from the database, including all users, keys, and certificates.
¢ Uninstalls the CA located within DocuSign SA.
¢ Unregisters DocuSign SA from the domain.
+ Resets all DocuSign SA installation parameters to the default values.
+ Resets the DocuSign Signature Appliance.

Note: In Active Directory environments, unregistering the DocuSign Signature Appliance
removes the appliance from the domain, but does not remove the DocuSign SA computer from
the Active Directory. To fully unregister the DocuSign Signature Appliance, manually remove the
DocuSign SA computer from the Active Directory.
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Note: If the DocuSign Signature Appliance was configured to receive certificates from a WWV
external CA automatically, the operator will be asked whether to revoke the existing certificates
in the external CA only in the case of Comodo CA.

You may want to keep the existing certificates if you are intending to perform a restoration
operation right after the Reset to factory settings operation. If you choose to keep existing
certificates, old certificates will not be revoked and the user can continue using the existing
certificates.

In the case of Symantec CA, the certificates are not revoked upon Reset to Factory Settings,
enabling users who are re-defined after reinstallation or restoration to reuse their Symantec
account, and a new certificate will be generated by the Symantec CA for these users.

To restore factory settings:
1. Inthe main window, select the Shutdown & Restart tab (Figure 97).
2. Inthe Shutdown & Reset menu, select Factory Reset.

3. Enter yes to confirm the operation.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 200

Displaying DocuSign Signature Appliance Status
To display DocuSign Signature Appliance status:
1. In the main window, select the Status tab.

Appliance Info

Installation Status Installed
DB Status Runining
Service Status Running
Role Primiary
Time & Date Aug 17 2016 02:37-29
Software Version 8.2
Haroware Version 8.0

APS Mode Off
Users 6,/33
Transactions 0/33
Licensa expiration date Infinite
DB Size 44MB

Aomin Grouvp Name
Signers Group Name
WWV Certs Pend

Serial Number

Administrators

CSNO2016
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IP Address 10.65.48.37

IP Mask 255.255.255.0
P GW 10.65.48.1
DMS IP 10.65.4.10
DM52 IP 10.64.4.10

IPve Address

Link Local IPvG feBi0::9122:6b59:b8ab:933cC
Subnet Prefix Length 0

IPvE GW

DMNS IPve

DM52 IPvE

DHCP True

MAC 00-1e:67-e6:cf:ed

Link [spaad) 1Gbps

Figure 98 Web-based Console — Status tab
The following table describes the DocuSign Signature Appliance status information parameters:

Parameter Description

Installation Status | The installation status of the DocuSign Signature Appliance.
Possible values: Installed, Factory, CRP Wait, REPL Wait.

Note: If a number is displayed for this parameter, installation is in
progress. The number indicates the installation phase.

DB Status The status of the DocuSign SA database.
Possible values: Running, Starting, Stopped, Stopping.

Service Status The status of the DocuSign SA service.
Possible values: Running, Starting, Stopped, Stopping.

Role The appliance’s role in the High Availability configuration. Possible
values: Primary, Alternate, Standalone.

Time & Date The current appliance date and time (PDT time zone).

Software Version The DocuSign Signature Appliance software version.
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Parameter

Description

Hardware Version

The DocuSign SA appliance hardware version.

FIPS Mode

Indicates whether the appliance is operating in FIPS mode. Possible
values:

ON (appliance operating in FIPS mode).

Off (appliance not operating in FIPS mode).

Note: For DocuSign SA to operate in FIPS mode, make sure the
following system parameters are set as follows:

- Web Services Support is set to False.

- Enforce FIPS Approved Algorithms is set to True.

Users

The amount of actual users in the database and the maximum
amount of users in the license.

Transactions

The number of actual transactions performed so far and the
maximum number of transaction allowed by the license.

License expiration
date

Displays expiration information.

If there is no expiration, the word Infinite is displayed. Otherwise, the
expiration date is displayed.

DB size The size of the DocuSign SA database files.
Admin group The name of the directory users group whose members are allowed
Name to manage DocuSign SA via the DocuSign SA Administration MMC.

Signers group
Name

The name of the directory users group whose members are users of
DocuSign SA when DocuSign SA is installed in AD mode.

Signers WWV Cert
Pend

The number of pending certificate requests when DocuSign SA
interfaces with an External CA in Automated mode

Serial Number

The serial number of the DocuSign Signature Appliance.

IP Address IP address of the DocuSign Signature Appliance, in IPv4 format.
IP Mask Subnet mask of the DocuSign Signature Appliance, in IPv4 format.
IP GW IP address of the default gateway, in IPv4 format.

DNS IP IP address of the DNS server, in IPv4 format.

DNS2 IP IP address of an alternate DNS server, in IPv4 format.

IPv6 Address IPv6-related information.

Link Local IPv6

IPv6-related information.

Subnet Prefix
Length

IPv6-related information

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 203

Parameter Description
IPv6 GW IPv6-related information.
DNS IPv6 IPv6-related information.
DNS2 IPv6 IPv6-related information.
DHCP Indicates whether DHCP is enabled.
Possible values: Enabled, Disabled.
Disabled means that the IP address should be entered manually.
Enabled means that the IP address is taken from the DHCP server.
MAC The Ethernet MAC address of the DocuSign Signature Appliance.

Link (speed)

The network connectivity state.
Possible values: 10Mb, 100Mb, 1Gb.

Using the Touch Screen of a DocuSign SA v8.0 Appliance

The touch screen of the DocuSign Signature Appliance shows the main appliance status
information. The touch screen is view only, and no operations can be performed.

Signature Appliance Console

Serial Number CSMN02016 - Primary

Critical Alerts Nane

Installation Statu Installed

Service Status Running

Version SW-8.2 HW:80

IP Address 10.65.48.37

IPvE Address

MAC

00:1e:67:eb:cf:ed

Figure 99 Appliance Touch Screen

Errors such as tamper or license problems are displayed in the Critical Alerts line.
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Restoring the DocuSign Signature Appliance After an Internal Hard
Disk Failure

In Appliance Hardware V7.0 or Appliance Hardware v8.0 Enterprise model

The appliance provides a mechanism for full appliance recovery and return to factory settings in a
case where there is a critical failure in the internal hard disk that prevents the DocuSign SA
software from booting and running normally.

This option should be used only if the DocuSign SA console does not reach the regular operating
Menu and instead displays DocuSign SA is now starting, please wait, or displays no message at
all even though the appliance is powered.

Note: It is highly recommended to consult with DocuSign technical support before performing a
comprehensive factory restore.

To perform a comprehensive factory restore:

1.
2.

Restart the appliance.

When the appliance starts, the following message appears for two seconds:
Press the service key to enter the service console.

Press button 1.

The Service menu is activated.

A please select message appears, prompting you to select between Quit and Restore.
Select Restore.

Note: If you select Quit, the DocuSign Signature Appliance continues to boot in the
normal fashion.

A final caution message appears: Restoring will erase all existing data. Are you sure?

Select Yes.

Note: If you select Mo, the DocuSign Signature Appliance continues to boot in the
normal fashion.

The Comprehensive Restore operation begins. The entire content of the DocuSign SA
firmware, including the data, is restored using a disk image that was created by DocuSign
during DocuSign SA manufacturing.

You can now perform a restore operation using an existing backup file, or perform a new
installation.

In DocuSign SA Hardware V8.0 — Appliance FIPS model

The appliance provides a mechanism for full appliance recovery and return to factory settings in a
case where there is a critical failure in the internal hard disk that prevents the DocuSign SA
software from booting and running normally.
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This option should be used only if the DocuSign SA console does not reach the regular operating
Menu and instead displays DocuSign SA is now starting, please wait, or displays no message at
all even though the appliance is powered.

Note: It is highly recommended to consult with DocuSign technical support before performing a
comprehensive factory restore.

To perform a comprehensive factory restore:

1.

Restart the appliance and connect a keyboard to the USB port.
In the case of a DocuSign SA Enterprise appliance, connect a monitor as well.

When the appliance starts, the following message appears for two seconds:
Press S to start the service console.

Press the S keyboard key.
The Service menu is activated.

A please select message appears, prompting you to select between quit(Q) and
restore(R).

Select Restore.

Note: If you select quit(Q), the DocuSign Signature Appliance continues to boot in the
normal fashion.

A final caution message appears: Restoring will erase all existing data. Are you sure
YIN?

Select Yes(Y).

Note: If you select No(N), the DocuSign Signature Appliance continues to boot in the
normal fashion.

The Comprehensive Restore operation begins. The entire content of the DocuSign
SA firmware, including the data, is restored using a disk image that was created
by DocusSign during DocuSign SA manufacturing.

You can now perform a restore operation using an existing backup file, or perform a new
installation.
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Chapter 7: Configuring High Availability

The high availability configuration enables an organization to setup several DocuSign Signature
Appliances to provide the following:

+ Redundancy — If a DocusSign Signature Appliance is not available, the other DocuSign
Signature Appliances in the network continue to provide the essential digital signature
functionality to the client.

¢ Load Balancing — When the organization requires large volumes of digital signature
operations, several DocuSign Signature Appliances can be used in parallel to improve
performance.

This chapter provides an overview of the DocuSign SA high availability configuration, followed by
a detailed description of how to set up the DocuSign SA system for high availability functionality.

Overview of High Availability

To enable a DocuSign SA high availability site, several DocuSign Signature Appliances are
installed. All the DocuSign Signature Appliances are connected to the organizational network and
are provided with either static IP address or dynamic IP address. One of the DocuSign Signature
Appliances is defined as the primary DocuSign Signature Appliance, and the other DocuSign
Signature Appliances in the site are defined as alternate DocuSign Signature Appliances. The
group consisting of the primary appliance and the alternate appliances is referred to as a high
availability cluster. Information is replicated securely from the primary to the alternate appliances.

The primary DocuSign Signature Appliance:

+ Contains the internal DocuSign SA CA, and serves as the master database of the
DocuSign Signature Appliances site.

+ Performs all administrative operations such as synchronizing with the Directory’s users
database and generating keys and certificates for all the relevant users.

¢ When using an External Automatic CA, the primary DocuSign Signature Appliance
communicates with the External CA to obtain end user certificates.

The administrative operations can only be performed in the primary DocuSign Signature

Appliance, therefore if the primary DocuSign Signature Appliance is down, none of these
operations can be performed until the primary appliance is up again

Note: Even in high availability configuration, you still need to periodically perform a backup of
the primary appliance (using the DocuSign SA Administration MMC or the GetBackup utility), in
order to be able to re-install the primary appliance if it fails.

An alternate DocuSign Signature Appliance is more limited in operations compared to the
primary DocuSign Signature Appliance, but it provides all digital signature operations. Thus it can
provide the necessary Redundancy requirement if the primary DocuSign Signature Appliance is
not available, and the necessary Load Balancing requirement for large volumes of digital
signature operations.
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Information Replication: To enable proper operation of the alternate DocuSign Signhature
Appliances, the information that exists inside the primary DocuSign Signature Appliance is
replicated to the alternate appliances. The replication is performed through the network using
secure mechanisms, which disable eavesdropping on the secret data transferred between the
DocuSign SA primary appliance and the alternate appliances.

By default, the replication occurs every minute and sends all changes that occurred during the
last minute. If a replication attempt fails, retries occur in one-minute intervals. The replication
process stops after 10 failed retry attempts.

Note: During information replication, data is transferred using the standard IPSEC protocol, with
authentication based on a shared secret. The shared secret is based on a key that is diversified
from the Server Master Key that is located in the Backup MiniKey.

Client behavior in a high availability configuration:

In a high availability configuration, the DocuSign SA client retrieves the IP addresses of all the
DocuSign Signature Appliances from the SCP (in Active Directory and NDS environments), or
from the local machine setting (in LDAP and Directory Independent environments). It then
randomly selects an available DocuSign Signature Appliance when a digital signature operation is
required.

For information about the SCP, refer to Distributing DocuSign SA Information through the SCP.

For information about configuring the appliance in the client settings, refer to the Client —
Appliances section in the DocuSign SA Configuration Utility chapter of the DocuSign SA User
Guide.

However, when running an administrative client that performs administrative tasks such as
inserting a new user to the system, the client will only use the primary DocuSign Signature
Appliance.

Deployment in Common Criteria mode:

When DocuSign SA is deployed in Common Criteria mode (either as a Signature Creation Device
or as a Seal Creation Device), only the Primary Appliance can be accessed by clients. The
Alternate Appliance(s) are deployed for the purpose of replication.

In the case of a temporary fatal error at the Primary Appliance (perhaps as the result of an
electrical problem, or a local networking problem), it is possible to define, in advanced, a specific
alternate appliance that will provide the digital signature service to users until the Primary
DocusSign Signature Appliance is analyzed and is back in service.

Special networking infrastructure such as special routers can be deployed for the purpose of
monitoring the Primary Appliance and determining when it is in a temporary fatal error.

In such case, the networking based requests will be forwarded to the selected alternate
appliance.
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Installing DocuSign Signature Appliances in a High Availability
Configuration
In a high availability configuration, the order of installation is as follows:

1. Install the primary DocuSign Signature Appliance.

2. Install the alternate DocuSign Signature Appliances.

The following sections describe the installation process.

Note: Both the Primary Appliance and the Alternate Appliances in a cluster must have the same
hardware version and software version.

Please make sure that all hardware versions and software versions of DocuSign Signature
Appliances you receive from DocuSign and are intended to be deployed in the same cluster are
the same.

Whenever it is required to upgrade the software version of the Primary Appliance, please make
sure that you upgrade the software versions of all Alternate Appliances as well.

Installing the Primary DocuSign Signature Appliance

Installing a primary appliance is identical to installing a stand-alone DocuSign Signature
Appliance (refer to Installing the DocuSign Signature Appliance Hardware version 7.0, Installing
the DocuSign Signature Appliance Hardware version 8.0 and Installing the DocuSign Signature
Appliance Software). During software installation, the administrator specifies the user
management environment (i.e., Active Directory or Directory Independent).

Installing an Alternate DocuSign Signature Appliance

The following sections describe the hardware and software installation of an alternate DocuSign
Signature Appliance.

Installing the Alternate DocuSign Signature Appliance Hardware

Prepare the alternate DocuSign Signature Appliance for installation, and perform the hardware
installation of the appliance, as described in Installing the DocuSign Signature Appliance
Hardware version 7.0 and Installing the DocuSign Signature Appliance Hardware version 8.0.

Installing the Alternate DocuSign Signature Appliance Software

Note: For proper installation of an alternate DocuSign Signature Appliance in an Active
Directory environment, you must have the same permissions as the installer of the primary
DocuSign SA. Refer to Installing DocuSign SA in a Microsoft Active Directory Environment.

To install the alternate DocuSign Signature Appliance software:

1. Open the DocuSign SA Control Panel as follows: Open the Start menu and select
Programs > DocuSign > Signature Appliance > Signature Appliance Control Panel.
The DocuSign SA Control Panel appears.
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2. Click the DocusSign Signature Appliances Management icon. The DocuSign Signature
Appliance Management window appears.

3. Login to the DocusSign Signature Appliance using either the built-in administrator or
another admin account.

4. Right-click the primary DocuSign Signature Appliance, select All Tasks, and then select
High Availability > Install Alternate.

5. The Network setup dialog box appears.

Signature Appliance IF address:

Figure 100 Network Setup Dialog Box

Enter the IP address of the alternate DocuSign Signature Appliance. This parameter is
necessary for enabling basic communication to and from the DocuSign Signature
Appliance.

Note: For information on setting up the IP address of the DocuSign Signature Appliance,
refer to Using a Static IP_ Address and Enabling DHCP.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 211

It is highly recommended to use a static IP address for the alternate appliances. If a
dynamic (DHCP based) address is used, and the appliance’s address changes after the
installation, the replication process will fail and a manual re-initialization will be required.

6. Inthe case of an Active Directory installation, enter the user name and password of an
administrative account with permission to join the alternate DocuSign Signature Appliance

to the domain.

Eniter the name and pazsword of an account with permizszion to join the appliance to the
dornain.

Uzer name: Iadministratnr

Pazgwiord: Ixxxxxxxxx

Darnair : I-:Iu:umain.u:u:um

Figure 101 Active Directory Admin Account Dialog Box
7. Click Next. DocuSign SA installation begins. A status bar displays the status of the
installation operation.

During the installation, status messages appear on both the console display and the
DocuSign SA Administration MMC display.

At the Please insert a backup Minikey prompt, insert one of the backup MiniKey
tokens that were created during the installation of the primary DocuSign Signature
Appliance.
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It is very important to insert the correct backup MiniKey token since the token contains a
set of Triple-DES Master Key of the primary Device, which are used to decrypt the keys
database and check the integrity of the users database.

Inserting an improper key will lead to improper authentication of the communication
between the primary DocuSign Signature Appliance and the alternate DocuSign Signature
Appliance, which will cause the replication to fail.

8. Atthe Please insert your License Minikey prompt, insert the license MiniKey token.

Take care to insert the license MiniKey that is dedicated to this alternate DocuSign
Signature Appliance. For example, if four DocuSign Signature Appliances are installed in
the same site, each of the DocuSign Signature Appliances should have its own license
MiniKey, which means there will be four license MiniKeys in the site.

The progress bar continues to display the progress of the operation. The primary
DocusSign Signature Appliance database is copied over the network to the alternate
DocusSign Signature Appliance.

9. At the end of the installation, the following message appears:

The first phase of alternate appliance installation completed successfully.
Please wait for the initial replication from the primary to the alternate to finish,
then restart the alternate appliance.

You can monitor the progress of the replication using the 'Subscribed alternates'
section under the primary appliance.

Figure 102 Initial Replication Message

Data replication between the primary DocuSign Signature Appliance and the alternate
DocusSign Signature Appliance continues after DocuSign SA alternate installation ends.

10. Click OK.

Note: If the first stage of installation was unsuccessful, the DocuSign Signature
Appliance returns to its factory settings. This enables you to rerun the installation. In this
case, the status bar displays that installation was unsuccessful, and you can click the
Back buttons to modify settings before rerunning the installation.

If the installation was unsuccessful and you are unable to rerun the installation, restore
DocuSign SA to factory settings and then try again. For more information about restoring
factory settings, refer to Restoring Factory Settings.
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11. In the DocuSign Signature Appliance Management window, right-click DocuSign
Signature Appliances and select Refresh from the popup menu. The window refreshes
and displays the newly installed alternate appliance.

File Action View Help

= zlc= H

':S' DocuSign Signature Appliance Snap-in Address Version Serial Number Status Reole
a ( Signature Appliances [C010.65.48.37 82 CSNO2016 Running Prirary

. (1 10.65.48.37

(3 212.25.66.193 [C3212.25.66.193 8.2 CSNDDDBS Mot logged in - Alternate

Figure 103 DocusSign Signature Appliance Management Window — Displaying Primary and Alternate
Appliances
12. Verify that all data was indeed replicated to the alternate DocuSign Signature Appliance
(refer to Managing Data Replication in the Alternate DocuSign Signature Appliance). The
replication state should be OK (refer to Viewing Replication Status of an Alternate
DocuSign Signature Appliance).

13. Perform a hard restart of the alternate DocuSign Signature Appliance. The restart ensures
that the alternate DocuSign Signhature Appliance starts using replicated data, such as
system parameters; otherwise, unexpected results may occur.

The alternate DocuSign Signature Appliance is ready for use.

Managing the Alternate DocuSign Signhature Appliance

Some management operations are disabled for an alternate DocuSign Signature Appliance.
The management operations that can be performed on an alternate appliance include:
Login.

Uploading software.

Downloading all types of log files.

Restarting and shutting down the DocuSign SA service or the DocuSign Signature
Appliance.

Setting as a primary appliance.

Uploading an SSL certificate for Web Services operation in the alternate appliance. This
operation uploads the SSL certificate also for a RESTful based Web Services interface.

+ Monitoring the performance of the appliance.

* & o o

Note: You can also optionally set an alternate appliance as the primary appliance. For more
information refer to Setting an Alternate Appliance to be the Primary Appliance.
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These management operations are available from the DocuSign Signature Appliance
Management window of the DocuSign SA Administration MMC (refer to Chapter 5: Managing the
DocuSign Signature Appliance).

Note: An alternate appliance cannot be backed up. If the appliance fails, it should be re-installed
as specified in Installing an Alternate DocuSign Signature Appliance.

Note: If the primary DocuSign Signature Appliance fails and is later re-installed from backup, all
alternate appliances must be re-installed as well.

Managing Data Replication in the Alternate DocuSign Signhature
Appliance

You can view and manage data replication using the DocuSign SA Administration MMC. The
information can be expanded from the primary appliance information. It is important to view the
replication status after the conclusion of alternate DocuSign Signature Appliance installation,
since the replication procedure continues after installation is complete.

To view and manage data replication, select Subscribed Alternates under the primary DocuSign
Signature Appliance.

The Subscribed Alternates window that appears lists the alternate DocuSign Signature
Appliances.

File Action View Help
€= zd= B
@ DocuSign Signature Appliance Snap-in Serial Number Address Status  Time Comments

@ E‘i";i;:;j‘:‘i"a”‘“ (CCSNODDES  212.25.66.193 oK 2016-09-25 07:32:01-0700  Merge completed after processing 1 data change(s) (0 insert(s), 1 updlate(s], 0 delete(s), 0 c...
4 .03.40.51
» [ Syster parameters
23 Subscribed alternates
(0 212.25.66.193

Figure 104 Subscribed Alternates Window
For every alternate appliance in the Subscribed Alternates window, you can:

+ View replication status, in addition to other information about the alternate appliance.
+ Re-initialize the alternate appliance, i.e., force a replication operation.

¢ Unsubscribe an alternate appliance. This removes the alternate appliance from the list of
subscribed alternates.

Viewing Replication Status of an Alternate DocuSign Signature Appliance
The Subscribed Alternates window (Figure 104) in the DocuSign SA Administration MMC displays
the time of the last replication activity accompanied by descriptive text. It also displays the
following information about each alternate DocuSign Signature Appliance: the DocuSign SA
Serial Number, the IP Address and the Status.
The possible statuses include:

¢ OK — No data needs updating in the alternate DocuSign Signature Appliance.
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¢ Running — The alternate DocuSign Signature Appliance is currently synchronizing with
the database of the primary DocuSign Signature Appliance.

¢ Retrying — The primary DocuSign Signature Appliance is trying to communicate with the
alternate DocuSign Signature Appliance, but cannot reach it due to network problems or
because the alternate DocuSign Signature Appliance is not installed.

¢ Failed — Replication has failed. This occurs after several failed retry attempts.

Re-initializing an Alternate DocuSign Signature Appliance

The Subscribed Alternates window in the DocuSign SA Administration MMC enables re-initializing
an alternate DocusSign Signature Appliance. This forces a replication operation in which all the
relevant data of the primary DocuSign Signature Appliance is copied to the alternate DocuSign
Signature Appliance.

Re-initialization can be used in cases where replication failed due to transient network problems.
To re-initialize an alternate DocuSign Signature Appliance:

1. Inthe Subscribed Alternates window (Figure 104), right-click the DocuSign Signature
Appliance you wish to re-initialize.

2. From the popup menu, select All Tasks > Re-initialize.

Unsubscribing an Alternate DocuSign Signature Appliance

The Subscribed Alternates window in the DocuSign SA Administration MMC enables
unsubscribing an alternate DocuSign Signature Appliance. This removes the alternate DocuSign
Signature Appliance from the list of Subscribed Alternates. Use this option when an alternate
appliance is no longer relevant in the site of the primary DocuSign Signature Appliance, or before
re-installing the alternate appliance.

To unsubscribe an alternate DocuSign Signature Appliance:

1. Inthe Subscribed Alternates window (Figure 104), right-click the DocuSign Signature
Appliance you wish to unsubscribe.
From the popup menu, select All Tasks > Unsubscribe.

At the prompt, confirm the operation.

Managing Primary Appliance Failure and Recovery

In cases of severe hardware failure in a primary appliance, you can set one of the alternate
appliances to be the primary appliance. The selected appliance is now the primary appliance of
the cluster. It can replicate its data to all the alternate appliances in the high availability cluster.
The previous primary appliance is no longer a member of the high availability cluster. When the
failed primary appliance recovers, you can re-define it as an alternate appliance in the cluster.
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Setting an Alternate Appliance to be the Primary Appliance

In the case of severe hardware failure in a primary appliance, you should define an existing
alternate appliance as the primary appliance.

There are several reasons why it is advisable to have an up and running primary appliance
available in a high availability cluster. These include:

¢ In a Directory Independent environment, you can add or update users only via the primary
appliance.

¢ In an Active Directory or LDAP environment, you can synchronize with the domain only via
the primary appliance.
You can interface with the automated external CA only via the primary appliance.
You can perform administrative operations only via the primary appliance. When the
primary appliance is down, no administrative activity such as downloading a backup file is
possible.

Before setting the alternate appliance as a primary appliance, you must ensure that all
configuration settings that were defined in the environment of the primary appliance are also
defined in the environment of the alternate appliance. For example, if the system is configured to
use an automatic external CA, the primary appliance was given network access to the external
CA. You should make sure that the alternate appliance is also able to access the automatic

external CA.
To set an alternate appliance to be the primary appliance:

A Caution: Make sure that there are no network disconnections or power failures
during the following procedure.

1. Inthe DocuSign Signature Appliance Management window (Figure 103), right-click the
alternate DocuSign Signature Appliance you wish to set as primary.

2. From the popup menu, select All Tasks > High Availability > Set as Primary.

The Set as Primary window appears. The Cluster status section displays the current
configuration of the cluster.
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"Set as Primary’ is a sensitive operation, before starting this operation please verfy that all
appliances in the clustrer are connected and operating.

During the operation do not close the Signature Appliance Admin Snap-In and do not
disconnect or shutdown any appliance in the cluster.

MNext primany appliance: SNO2016

Cluster status:

Appliance CSMNODDES, IP 10.65.48.63, role primany.. 0K
Appliance CSN02016, 1P 10.65 48.37, role attemate.. QK

Figure 105 Set as Primary — Cluster Status
3. Click Next and confirm the operation.

A progress window appears, and the operation of switching the role of primary to the
alternate appliance begins.
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Figure 106 Set as Primary — Start installing the alternate as a primary

At the end of the operation a report is displayed, describing the performed actions. If you
suspect any failure in the operation, contact DocuSign support.

4. Click Finish.

The selected appliance is now the primary appliance of the cluster. It can replicate its data to all
the alternate appliances in the high availability cluster.

Note: There can only be one primary appliance in a cluster. If the previous primary appliance
becomes operational again, you can define it as an alternate appliance (refer to Setting a
Previous Primary Appliance to be an Alternate Appliance).

Setting a Previous Primary Appliance to be an Alternate Appliance

You can set a previous primary appliance to be an alternate appliance. This is useful for cases
where a previously-defined primary appliance that failed becomes operational again, and you
wish to add it the cluster as an alternate appliance.
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To set a previous primary appliance to be an alternate appliance:

1. In the DocusSign Signature Appliance Management window (Figure 103), right-click the
previous primary DocuSign Signature Appliance that you wish to designate as an
alternate.

2. From the popup menu, select All Tasks > High Availability > Subscribe as Alternate.
After you confirm the operation, the previous primary appliance will become an alternate
appliance.

Re-subscribing an Alternate Appliance with a Primary Appliance

There are cases where an alternate appliance is unsubscribed from a primary appliance, and you
wish to re-subscribe it with the primary appliance. For example, the alternate appliance is being
upgraded.

Note that you can resubscribe an alternate appliance to the primary appliance, without having to
re-install the alternate appliance.

To subscribe an alternate appliance with a primary appliance:

1. Inthe DocuSign Signature Appliance Management window (Figure 103), right-click the
primary DocuSign Signature Appliance to which you wish to subscribe an alternate
appliance.

2. From the popup menu, select All Tasks = High Availability > Subscribe Alternate to
Primary.

You are prompted to supply the IP address of the alternate appliance.
3. Enter the IP address of the alternate appliance.
4. Confirm the operation.
After several seconds the operation is completed and the specified appliance is added to the
alternates list of the primary appliance.

Upgrading Appliances Participating in a High Availability Cluster

Note: All appliances participating in a high availability cluster must run the same version of
DocuSign SA.

To upgrade appliances in a high availability cluster:

1. Unsubscribe all alternate appliances from the primary appliance (refer to Unsubscribing an
Alternate ).

2. Inthe Subscribed Alternates window (Figure 104), make sure that no alternate appliances
are listed for the primary appliance.

Upgrade the primary appliance (refer to Upgrading ). Wait until the upgrade is complete.
Upgrade all the alternate appliances to the same version as the primary appliance.
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In each alternate appliance, verify that the upgrade has completed successfully and that
the DocuSign SA console shows the updated version number.

5. Subscribe each alternate appliance to the primary appliance (refer to Re-subscribing an
Alternate Appliance with a Primary Appliance).

The high availability cluster is now upgraded and ready for operation.
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Chapter 8: DocuSign SA Configuration Utility

The DocuSign SA client behavior in general and each DocuSign SA component in particular have
several modes of operation that are suitable for different kinds of usage and customer needs.
These different modes of operation can be set by the user, or can be set and then distributed by
the organization’s administrator.

The DocuSign SA Configuration Utility enables both the user and the administrator to set the
configuration of any parameter in any of the DocuSign SA client components both for a single
machine and for a group of machines.

User related functionality is described in the DocuSign SA User Guide.

Overview

The DocuSign SA Configuration Utility is a GUI application that enables a user or administrator to
set any of the DocuSign SA client components’ configurable parameters easily and intuitively.

The DocuSign SA configuration Utility can run in either of two modes:

+ Admin mode is run by an administrator to build a certain setting for distribution. It can be a
registry file or a group policy that can be distributed to different clients by the Active
Directory group policy mechanism, using login scripts or manually.

¢ End User mode allows a user (or administrator) to view or configure the DocuSign SA
client behavior on the machine on which the utility is running.

The utility displays a components tree, in which you can select the component whose
configuration values you wish to set. Each component includes several independent groups of
parameters, which can be independently set.

The utility can also be used on a specific machine to view or update the current configuration.
This may be useful for debugging purposes or when the client behavior deviates from the
expected.

Note: The DocuSign SA Configuration utility is not the only method for changing the DocuSign
SA client’s behavior. Some of the components have their own GUI for setting their own
configuration (such as the DocuSign SA Legacy Word Add-in plug-in, Prepare & Sign, and
others), but while the components' GUI changes the setting of the current user, the DocuSign
SA Configuration utility changes the configuration of the local machine.

You can also use the DocuSign SA Configuration Utility to retrieve the DocuSign SA internal CA
certificate and the DocuSign SA CA CRL (Certificate Revocation List).

Using the DocuSign SA Configuration Utility

The DocuSign SA Configuration Utility enables you to view and edit all the configurable
parameters of the DocuSign SA client components. In End User mode, only the installed
components are displayed, while in Admin mode you can view and change the settings of all the
DocusSign SA client components. Refer to Running the DocuSign SA Configuration Utility in
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Admin Mode and Running the DocuSign SA Configuration Utility in End User Mode for more
information about the two modes.

To run the DocuSign SA Configuration Utility:

¢ Torunin Admin mode, select Start > Programs > DocuSign > Signature Appliance >
Signature Appliance Control Panel. The DocuSign SA Control Panel appears
(Figure 51). Select the Client Configuration Management item. The DocuSign SA
configuration utility main window appears.

¢ Torunin End User mode, select Start > Programs > DocuSign > Signature Appliance
-> Signature Appliance Control Panel. The DocuSign SA Control panel appears

(Figure 51). Select the Client Configuration item. The DocuSign SA configuration utility
main window appears.

File CA Help

EE-—1 Client
{;} Sighature API The client configuration containg parameters related to connectivity and authentication
l] Microsaft Dffice with the Slgnqture .-ﬁ-.ppllanc_e. The Signature .:'f-.ppllance Client iz a core companent,

: X therefore all Signature Appliance related applications are affected by the client's
-8B Prepare & Sign
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Client configuration is composed of the fallowing groups:;

Appliances - in thiz group you can manually define the addreszes of the
Signature Appliances and their authentication mechanizm.

Login dialog - in this group pou can set all the parameters relating to the
login dialog for the environments in which such a dialog pops up.

Timeouts - in thiz group you can set the warious imeauts relating to
communication between the Signature Appliance Client and the Signature
Appliance.

Mizcellaneous - in thiz group you can zet logging parameters among other
mizcellaneous parameters.
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Figure 107 DocuSign SA Configuration Utility — Main Window
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The left pane of the DocuSign SA Configuration Utility displays a components tree. Each node in
the highest level of the tree is a configurable client component. Each component has one or more
sub-nodes, with each sub-node being a group of parameters. These sub-nodes group parameters
by category, except for the Miscellaneous sub-node, which includes all the parameters that are
not included in any of the other groups.

To edit a parameter:

1. Double-click the component to which this parameter belongs, or click # to the left of the
component. The component’s sub-nodes are displayed.

2. Select the sub-node that contains the parameter. The right pane displays all the
configurable parameters for the sub-node.

The right pane of each sub-node (except Miscellaneous) displays all the configurable
parameters, with a triplet of radio buttons on top. Since the Miscellaneous group is a
collection of various unrelated parameters, it may display several triplets, one for each
logical set of parameters.

3. Select one of the radio button options:

+ Not Configured — When this option is selected, the local machine definition of this
sub-node’s parameters remains unchanged when the configuration is applied to the
local machine.

When this option is selected, the parameters are greyed out and you cannot edit them.

+ Use Defaults — When this option is selected, registry entries for all this sub-node’s
parameters are removed when the configuration is applied to the local machine, and
the DocuSign SA defaults are used.

When this option is selected, the parameters are greyed out and you cannot edit them.

¢ Set <Sub-node Name>Parameters — When this option is selected, the sub-node’s
parameters become editable and display values where applicable (either the default
value or a value taken from the local machine definition). When the configuration is
applied to the local machine, all the parameters of this group are written to the registry.
New registry keys and values will be created if necessary, and the old values, if
defined, are overwritten.

You can configure parameters for the following DocuSign SA components:

+ Client. For explanations about the configurable parameters, refer to the DocuSign
SA Configuration Utility chapter in the DocuSign SA User Guide.

+ Signature API. For explanations about the configurable parameters, refer to the
DocuSign SA Configuration Utility chapter in the DocuSign SA User Guide.

+ Microsoft Office. For explanations about the configurable parameters, refer to the
DocuSign SA Configuration Utility chapter in the DocuSign SA User Guide.

¢ DocuSign SA Prepare & Sign. For explanations about the configurable parameters,
refer to the DocuSign SA Configuration Utility chapter in the DocuSign SA User
Guide.

+ Admin. For explanations about the configurable parameters, refer to Setting Admin
Configuration.
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DocuSign SA Configuration Utility Menus

The following sections describe the menu options available from the DocuSign SA Configuration
Utility: File, CA, and Help. Note that the File menu differs for Admin mode and End User mode.

File Menu — Admin Mode

The following options are available in Admin mode from the File drop-down menu:

Note: For a detailed explanation of configuration file operations and group policy operations,
refer to Configuration File Operations and Group Policies Operations.

New Configuration
Enables creating a new configuration file.
Open

Enables opening and importing a configuration file. All the settings defined in the file are displayed
in the relevant components’ dialogs. The components and values that are not defined in the file
appear with the Not configured option selected.

You can import either from a file or from a Group Policy.

Save

Enables saving a configuration file.

Save configuration file as

Enables saving a configuration file as a new configuration file.
Export to configuration file

Enables exporting to a configuration file only when working on Group Policy settings. You must
specify the desired file name and location.

Exporting allows the administrator to distribute a specific configuration manually, or via login
scripts or other distribution mechanisms that allow working with . reg files.

You can generate a file that is suitable either for a 32 bit Windows System or for a 64 bit Windows
System.

Export to group policy

Enables exporting the configuration file to an existing Group Policy. Select the Group Policy to
which the settings should apply.

You can generate a file that is suitable either for a 32 bit Windows System or for a 64 bit Windows
System.

CA Menu
The following options are available from the CA drop-down menu:

Install DocuSign SA CA Certificate

Enables installing DocuSign SA’s ROOT certificate into the current user’s PC. Refer to
Chapter 4: Deploying the DocuSign SA Client for information relating to DocuSign SA’s ROOT
certificate.
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Download DocuSign SA CA Certificate

This option is very similar to the Install DocuSign SA CA Certificate option. The difference is
that in this case the DocuSign SA ROOT CA certificate is output to a selected file. The
downloaded file can be placed in the AlA location according to the AlA field defined in the users’
certificates.

Download DocuSign SA CA CRL

Enables downloading the DocuSign SA CRL (Certificate Revocation List) to a file. The
downloaded file can be placed in the CDP (CRL Distribution Point) location according to the CDP
field defined in the users’ certificates.

Help Menu
The following options are available from the Help drop-down menu:

About

Displays the version of the DocuSign SA configuration utility as well as a link to the DocuSign web
site.

Contents

Displays the content of this chapter in on-line help format.

Create report

Enables generating a report listing information on both the DocuSign SA Client installation and
the DocusSign Signature Appliance installation. Click Save to save the report to a file. The file can
be sent to DocuSign support for problem analysis.

The report includes three parts:
+ DocusSign SA Client installation files — Includes all the files of the DocuSign SA installation,
their dates, sizes and version information.

+ DocuSign SA Client and Server parameters — Includes DocuSign SA Client and Server
parameters. The parameters also include information that is displayed in the DocuSign SA
console.

+ Environmental information — Displays information about the PC in which the DocuSign SA
client is installed, the version of the installed MS Office application, and other parameters
that can be valuable to DocuSign support for problem analysis.

Running the DocuSign SA Configuration Utility in Admin Mode

Note: To run the DocuSign SA Configuration Utility in Admin mode, you must first install the
DocuSign SA admin client. Refer to Installing DocuSign SA in a Directory Independent
Environment.

To run the DocuSign SA Configuration Utility in Admin mode:

1. Select Start > Programs > DocuSign - Signature Appliance > Signature Appliance
Control Panel. The DocuSign SA Control Panel appears. Select the Client Configuration
Management item.
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Figure 108 DocuSign SA Client Configuration Utility — Admin Mode
2. Edit the parameters as described in Using the DocuSign SA Configuration Utility.

When running in Admin mode, all the DocuSign SA client configurable components are
displayed in the left pane, regardless of the DocuSign SA components installed on the
machine you are working on.

The application starts with a new configuration file whose components are all non-
configured. You can either edit this new configuration or you can open an existing
configuration from a file or from Group Policy.

The Admin mode of the DocuSign SA Configuration Utility enables administrators to
create and edit configuration files and to add and edit DocuSign SA client configuration to
an existing Active Directory Group Policy.

The configuration files are actually valid registry files that can either be imported to an end
user machine (by double-clicking them or from regedit), or can later be used as input to
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the configuration utility (in Admin mode) for further editing or for exporting to Group Policy,
or can be imported by the Configuration Utility (in End User mode) for configuring a single
machine’s settings.

You can perform the following when running the DocuSign SA Configuration Utility in
Admin mode:
Edit and save a configuration file.

Edit/view a configuration file and export the DocuSign SA client settings to an existing
Active Directory Group Policy.

+ Edit/view the DocuSign SA settings of a Group Policy and save them in the same Group
Policy or export them to another Group Policy.

+ Edit/view the DocuSign SA settings of a Group Policy and export them to a configuration
file.

+ Install/Download the DocuSign SA CA certificate. Refer to Install DocuSign SA CA
Certificate and Download DocuSign SA CA Certificate.

+ Download the DocuSign SA CA CRL (Certificate Revocation List). Refer to Download
DocuSign SA CA CRL.

The following sections describe basic Configuration File and Group Policy operations.

Configuration File Operations
The following sections describe basic configuration file operations.

Creating a New Configuration File
A new configuration file can be created in either of two ways:
+ When the application starts it always starts with a new configuration file.
¢ By selecting File > New configuration.
After changing all desired parameters, you must either:

¢ Save the configuration file — select either File > Save or File > Save configuration file
as.

+ Export the configuration file to an existing Group Policy (refer to Exporting to a Group
Policy).

Opening a Configuration File
A configuration file is typically opened for one of two reasons:

¢ For editing and saving.
+ For viewing and exporting to an existing Group Policy.

To open a configuration file, select File > Open. All the settings defined in the file are displayed in
the relevant components’ dialogs. The components and values that are not defined in the file
appear with the Not configured option selected.
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Exporting to a Configuration File

When in Admin mode, you can export to a configuration file only when working on Group Policy
settings. Exporting allows the administrator to distribute a specific configuration manually, or via
login scripts or other distribution mechanisms that allow working with . reg files.

To export a Group Policy setting to a configuration file, select File > Export to configuration file,
and browse for the desired file name and location.

Group Policies Operations

When opening and exporting group policies, a list of the available policies is displayed according
to the current user’s credentials and the domain to which the current machine is joined. This list
contains all the domain’s group policies which the user may view/edit, as well as all the group
policies defined for the local machine which the user may view/edit.

The DocuSign SA Configuration Utility enables you to view and edit DocuSign SA related
parameters in a Group Policy.

Opening a Group Policy

The DocuSign SA Configuration Utility can be used to open and edit the DocuSign SA setting in
an existing Group Policy. Note that only the DocuSign SA specific settings are retrieved from the
Group Policy and thus only these settings can be edited or viewed.

To open a Group Policy for editing, select File > Open group policy. A list of all the available
group policies is displayed. Select a group policy, and all its defined settings are displayed in the
relevant components’ dialogs. The components and values that are not defined in the policy
appear with the Not configured option selected. Specifically, if you open a Group Policy that
never contained DocuSign SA definitions, all values of all components appear with the Not
configured option selected.

After setting (or viewing) the desired values, you can either save the settings to the Group Policy,
or export the values to a configuration file or to another Group Policy. Refer to Exporting to a
Group Policy and Exporting to a Configuration File, respectively, for how to export the
configuration values.

Exporting to a Group Policy
Exporting to a Group Policy is typically performed in either of two situations:

+ When you work on a Group Policy’s settings and wish to apply the settings to another
Policy.
¢ When you work on a configuration file and wish to apply the settings to a Group Policy.

To export configuration settings to a Group Policy, select File > Export to group policy, and
select the Group Policy to which the settings should apply.

Note: After exporting the settings to a Group Policy, additional changes are saved to the original
file or policy and not to the one to which the settings were exported.
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Running the DocuSign SA Configuration Utility in End User Mode

The DocuSign SA Configuration Utility can also be used for editing and viewing a specific
machine’s settings. When the application runs in End User mode, it looks for all the DocuSign SA
components that are installed, and for each component reads its settings and displays them in the
relevant dialog. For more information, refer to the DocuSign SA User Guide.

Distributing the DocuSign SA Client Configuration

The DocuSign SA client consists of several components, which can be operated in different
modes according to organizational needs. These modes can be controlled by the component’s
parameters.

While in some organizations there is a policy of how things should work and look like, and
therefore all users must have the same configuration, there are some other organizations where
there is more than one such policy for the different organizational units, and others where there is
no policy at all and every user can determine his/her own configuration.

All DocuSign SA components are installed with a default behavior that should fit most users.
Some components have their own GUI for changing the default configuration, and the client
configuration can also be centrally set using a configuration file or Group Policy. Following is a list
of the common ways to set and distribute DocuSign SA client configurations:

¢ Use DocuSign SA defaults — Do nothing except install the DocuSign SA client from the
DocuSign SA CD. All users will have the same default behavior.

+ Use the components’ GUI — For each configured machine, use the DocuSign SA
components’ GUI to configure each component (Office Signature plug-in, DocuSign SA
Prepare & Sign) as desired. Refer to the chapters describing the component’s GUI for an
explanation of the various parameters and how to configure them.

¢ Use the DocuSign SA Configuration Utility in End User mode — Run the DocuSign SA
Configuration Utility on each machine you wish to configure and set the parameters as
desired.

¢ Use Configuration files — Use configuration files that are created by the DocuSign SA
Configuration Utility. Refer to Distributing the DocuSign SA Configuration Using
Configuration Files below.

¢ Use Group Policy — In an Active Directory environment you can use Group Policies for
distributing different configurations to different groups of machines. Refer to Distributing
the DocuSign SA Configuration Using Group Policy.

Distributing the DocuSign SA Configuration Using Configuration Files

The configuration files created by the DocuSign SA Configuration Utility are actually valid . reg files.
You can create these files in Admin mode (refer to Creating a New Configuration File), or by
exporting a certain machine’s setting.

Once the configuration file is created you can distribute it in any of the following ways:

+ Manually — Refer to Distributing the DocuSign SA Configuration Manually.

¢ Using Login Scripts or other distributing software — Refer to Distributing the DocuSign SA
Configuration via Login Scripts or any Distributing Software.
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Distributing the DocuSign SA Configuration Manually

Note: You must have administrative rights on the machine in order to apply the configuration
values.

To distribute the DocuSign SA configuration manually:
1. Copy the appropriate . reg file to the machine for which you want these settings to apply.

2. Double-click the file. A message pops up, requesting confirmation to apply the new
registry values.

3. Click Yes, and wait for the message confirming that the operation was completed
successfully.

Registry Editor

\14) Information in CiyDocuments and SettingsiezeriDeskioplcosign.reg has been successfully entered inko the registry,

4. Click OK.

Note: Some DocuSign SA components must be restarted in order for the new configuration to
take effect, or else they will keep working with the old settings. It is recommended to restart the
machine after manually installing a new configuration.

Distributing the DocuSign SA Configuration via Login Scripts or any Distributing Software

Since the configuration file is a . reg file that changes some settings in HKLM, any software or
tool that is able to apply . reg files and has the appropriate access rights on the target machine
can be used to distribute the DocuSign SA configuration files.

Distributing the DocuSign SA Configuration Using Group Policy

In an Active Directory environment, you can distribute the DocuSign SA configuration using a
Group Policy. You can use one Group Policy for all your users, or you can have several policies
for several organizational units.

DocuSign SA configuration values do not require a proprietary Group Policy, but are integrated in
existing policies.

When opening a Group Policy in the DocuSign SA Configuration Utility, the application retrieves
only the DocuSign SA-related parameters and displays them in the relevant dialogs. When saving
the configuration, or when exporting it to a specific Group Policy, the application removes all the
DocuSign SA-related definitions from the existing policy, and replaces them with the new settings.
All non-DocuSign SA-related definitions are not affected by the saving/exporting action.
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Both the opening and the saving operations show the user all existing Group Policies available to
the user according to the user’s credentials; you cannot use the DocuSign SA Configuration Utility
to create a new policy.

Setting Admin Configuration

Admin configuration enables you to set parameters relating to the DocuSign Signhature Appliance
installation. Some of these parameters affect the appliance itself, while others configure the
administrator’s machine installation capabilities.

Admin — Appliance Installation

This group enables you to set parameters that relate to the DocuSign Signature Appliance
installation. You can set the log level and the administrators group defined within the appliance,
as well as the administrator's machine installation capabilities, such as in which types of
directories you can install DocuSign SA, and whether you may set AIA and CDP in the internal
CA setup.
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Figure 109 Configuring Admin — Appliance Installation Parameters
In the Appliance Installation group you can set the following Admin parameters:
DocusSign Signature Appliance related settings:

¢ Cluster ID (0 means use default) — Do not change this value unless instructed to do so by
DocuSign technical support.

¢ Appliance installation log level — Specify the reporting level of the appliance to the log
while installation is in progress. It is recommended not to change this setting.

¢ Certificate common name origin — Directs DocuSign SA how to define the Common Name
field in the created user certificate. The origin can be either the common name of the user
in the directory or the display hame of the user in the directory.

This parameter is identical to the Certificate Common Name parameter in the DocuSign
SA system parameters.
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& Administrator’s group name — Specify the name of the directory service’s user group that

identifies authorized DocuSign SA administrators. You can select any name for this group.
Make sure that all users who perform DocuSign SA administrative tasks are assigned to
this group.

Default value: administrators.

Certificate expiration variance — The maximum number of days that may be subtracted
from the certificate’s expiration date for the purpose of refreshing the certificate.

This parameter is identical to the Certificate Expiration Variance parameter in the
DocuSign SA system parameters

Username case sensitive — Check this option if you wish the login username to be case
sensitive. The new setting takes effect after the upcoming installation. The default value is
case insensitive. This parameter is relevant for a DocuSign SA installation in a Directory
Independent environment.

Administrator’'s machine related settings:

*

Allow AD install — Check this option to enable the administrator to install DocuSign
Signature Appliance in an Active Directory environment.

Allow Directory Independent install — Check this option to enable the administrator to
install DocuSign Signature Appliance in a Directory independent environment.

Allow extended install types — This option should always remain unchecked.

Allow AIA/CDP entry — Check this option to enable the administrator to change the AIA
and CDP fields in the CA setup dialog.
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Admin — Performance Monitoring

Change the settings only if instructed to do so by DocuSign.
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Figure 110 Configuring Admin — Performance Monitoring Parameters
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Chapter 9: Troubleshooting

This chapter offers solutions to various problems you may encounter while installing or running
DocuSign SA.

If you are unable to identify or solve a problem, try the DocuSign support web site at
https://support.docusign.com/en/home

DocuSign Support information

Support web site https://support.docusign.com

DocuSign Contact information

DocusSign web site: http://www.docusign.com
DocusSign 221 Main St.
Headquarters: Suite 1000

San Francisco, CA 94105

Installation Problems

This section describes various problems and error messages you may encounter during the
installation process, and provides possible solutions to these problems.

DocuSign SA IP Address is Invalid

Problem: During DocuSign SA software installation, this message appears after you enter the
DocuSign SA address and click Next.

Solution: This message indicates that DocuSign SA is not accessible. Perform the following:
+ Verify that the IP address you entered is correct.

¢ Verify that DocuSign SA is operational.
¢ Check for networking problems.

Error When Setting the DocuSign SA IP Address Via the Console Interface

Problem: When setting the DocuSign SA IP address through the console, one of the following
error messages appear: failed error 51, failed error 52, or failed error 54.

Solution: Check the following:

+ Verify that DocuSign SA is properly connected to the network. Verify there are no switch
problems, cable problems, etc.

+ Verify that the IP address you entered is not being used by another machine in the
network. One way to check this is to ping the IP address; if you receive an answer, it
means that the IP address is being used by another machine in the network.
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¢ If the problem is none of the above and the network has a DHCP server installed, perform
the following:

a. Choose the Use DHCP option in the DocuSign SA Console main screen.
b. Restart the DocuSign Signature Appliance.

c. Select Ip Addr in the DocuSign SA Console main screen to view the IP address that
was allocated by the DHCP server.

d. Perform Save. The Appliance saves as static IP the address that was allocated by the
DHCP server.

e. Remove this IP address from the IP addresses pool of the DHCP server.

Default Values Do Not Appear in the Directory Setup Dialog Box

Problem: During DocusSign SA software installation, the Directory Setup dialog box appears
without any default values.

Solution: DNS configuration may be problematic, causing an installation failure. For more
information, refer to Installation Failed.

The Appliance is Not in Factory Settings Mode

Problem: During DocusSign SA software installation, this message appears after you enter the
DocuSign SA address and click Next.

Solution: This message indicates that a DocuSign Signature Appliance with the IP address
entered is already installed. Perform one of the following options:
¢ Enter a different IP address.

+ Return DocuSign SA to factory settings using the console, and then rerun the installation
process.

Note: Since this message indicates that DocuSign SA is already installed, you may want to
cancel the installation process to prevent the accidental reinstallation of DocuSign SA.

Installation Failed
Problem: The DocuSign SA software installation process fails.
Solution: Verify the following:

¢ DNS supports dynamic updates. This information is included in the DNS server properties.

¢ The user running the DocuSign SA Administration MMC has the necessary privileges. The
user must be a member of both the domain admins and enterprise admins groups.

If you have verified all of the above, and the installation process still fails, download the Install log.
For information on downloading the Install log, refer to Downloading Log Files.
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The Install log may include one of the following errors:
¢ Failed to join the domain — If this error appears in the Install log, verify the
following:
¢ The domain controller is up.
¢ The domain name was entered correctly.

¢ The administrator user has the necessary privileges to register computers to the
domain.

¢ Failed to remove http URLs for CDP and AIA — This error usually indicates a
failure in CA installation. Send the Install log file to DocuSign technical support.

Progress Bar Stops Advancing

Problem: During DocuSign SA software installation, the progress bar stops advancing at the
user’s keys and certificate generation stage, and only one user is defined in DocuSign SA.

Solution: There may be a DNS configuration problem (in either DHCP or static IP mode).
Perform the following:
+ Do not close the DocuSign SA installation wizard.

¢ Modify the DNS Server IP address from the console. The progress bar will continue
advancing until the installation is completed.

DocuSign Signature Appliance Installation Issues

Problem: In an MS Active Directory environment, right after the installation starts, the following
error appears: "Installation failed in step 93 with reason: failed to join the domain, error code is
1231". Sometimes the error code is 1355.

Cause: The DocuSign Signature Appliance failed to join the domain due to network configuration
problems.

Solution: Check for network setting such as DNS IP on the DocuSign SA console. Make sure to
restart the appliance after any changes to the IP or DNS even if the change was successful.

To be sure that your network configuration is OK try to ping with the DocuSign Signature
Appliance IP using the -a option. You should get a reply with the appliance full DNS name.

High Availability/Load Balancing — Alternate Installation

Problem: After completing the installation of an alternate DocuSign SA, the following message
appears in the subscribed alternate: "The snapshot for this publication has become obsolete".

Cause: You did not restart the primary DocuSign Signature Appliance before starting the
alternate installation.

Solution:
1. Unsubscribe the alternate appliance.

2. Restore the alternate to factory settings.
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3. Restart the primary appliance (hardware restart).

4. Re-install the alternate appliance.

DocuSign Signature Appliance Problems

DocusSign Signature Appliance Does Not Start

Problem 1: Even though power is on, the appliance shows no sign of being on. The power LED is
off.

¢ Solution 1: Check that the power cables are indeed connected to the power supply.

Problem 2: The power LED is on. The Console does not stop displaying the message: DocuSign
SA is now starting, please wait. Even after restarting DocuSign SA several times the same
message continues to display.

¢ Solution 2: Follow the instructions in Restoring the DocuSign Signature Appliance After
an Internal Hard Disk Failure. It is recommended to consult with DocuSign technical
support before carrying out the instructions.

Console Problems

The console provides messages and alerts for the following problems (refer to DocuSign SA Does
Not Respond for more information):

¢ [Tamper] — A tamper event occurred.
¢ [License] — There is a problem with the license MiniKey.
¢ [IP Addr] — The appliance does not have an IP address.
Following are licensing issue messages that can also appear in the console:
¢ Passed 90% of DocuSign SA license limit — Contact DocuSign to obtain a
larger license.

¢ DocuSign Signature Appliance license is not present, please insert
your license MiniKey. Warning <num> of 5, system will shutdown! —
The license MiniKey is not inserted. Insert the MiniKey immediately.

¢ The amount of users in the DocuSign Signature Appliance has passed
the license limit. Warning <num> of 5, system will shutdown! — Either
obtain a new license MiniKey from DocuSign, or remove users from the scope of
DocusSign SA users.

¢ An improper license Minikey is inserted(<error-code>). Warning
<num> of 5, system will shutdown! — Inserta proper license MiniKey.

For more information on licensing issues, refer to New Users Do Not Receive Certificates.
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Client-Related Problems

This section describes various problems and error messages you may encounter while running the
DocusSign SA Client, and provides possible solutions to these problems.

Cannot Enable the “Add Digital Signature to Outgoing Messages” Checkbox in
Outlook

Problem: In Microsoft Outlook, the Add digital signature to outgoing messages checkbox is
disabled.

Solution: In order to send signed emails, you must first define security settings. Refer to Signing
Outlook Emails in the DocuSign SA User Guide.

Cannot See Any Certificates in Store
Problem: You cannot see any certificates in your Microsoft Personal certificates store.
Solution: Perform the following:
1. Restart the machine and try again.
2. Verify the following:
¢ You are logged in to the same domain as DocuSign SA. You should not be logged in

to any other domain, and you should not be logged in to the current machine.

+ Your DNS definitions are correctly configured on the PC. These definitions should be
the same as the domain’s DNS.

+ You receive a response when you ping the DocuSign SA IP address or try to connect
to DocuSign SA using telnet to port 443.

¢ Your user account is defined in the directory that was defined as the AD users
container during DocuSign SA installation (refer to Figure 13).

+ If you are using a Directory Independent environment, you did not omit to set
configuration parameters for the client machine. Use the DocuSign SA Configuration
Utility to setup the DocuSign Signature Appliance IP address (refer to the Client —
Appliances section in the DocuSign SA Configuration Utility chapter of the DocuSign
SA User Guide).

Administrative Problems

This section describes various problems and error messages you may encounter while managing
DocuSign SA, and provides possible solutions to these problems.

DocuSign SA System Parameters Do Not Appear in the DocuSign SA Administration
MMC

Problem: You do not see any DocuSign SA system parameters in the DocuSign SA
Administration MMC.
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Solution: In order to perform administrative operations using the DocuSign SA Administration
MMC, you must be a member of the DocuSign SA Administrators group. This group is defined in
the Administrator Group system parameter, and its default value is Administrators. The
Administrator Group parameter is displayed in the DocuSign SA Console (refer to

Chapter 6: Using the DocuSign SA Consoles).

All DocuSign SA Administration MMC Operations Fail
Problem: Any operation you attempt to perform in the DocuSign SA Administration MMC falils.

Solution: Refer to DocuSign SA System Parameters Do Not Appear in the DocuSign SA
Administration MMC.

DocuSign SA Does Not Respond

Problem: You cannot access DocuSign SA through the DocuSign SA Administration MMC or
perform digital signature operations.

Solution: Check the appliance status. The cause may be one of the following:

+ A correct license MiniKey token is not inserted, causing DocuSign SA to turn itself off after
two hours. Insert the correct license MiniKey and restart DocuSign SA.

+ Atamper event occurred, and the Tamper LED is blinking. Reset the Tamper mechanism
from the console (refer to Resetting the Tamper Mechanism).

+ DocusSign SA failed to receive an IP address, and the Tamper LED is lit. Check the cable
and DHCP server. Once the network problem is resolved, the LED turns off and DocuSign
SA begins working.

¢ The DocuSign SA users OU was modified. Verify that the DocuSign SA users OU was not
modified, and it is the same as was entered during DocuSign SA installation.

If none of the above is applicable, run the console and enter 1 from the main menu (refer to
Displaying DocuSign SA Status). Check the appliance information for the DocuSign SA Service
State parameter, as follows:

+ If the DocuSign SA Service State is Running, check for a network problem between
DocuSign SA and the clients.

+ If the DocuSign SA Service State is Stopped, restart DocuSign SA and then recheck the
DocuSign SA Service State. If the DocuSign SA Service State is still Stopped, contact
DocuSign technical support.

+ If the DocuSign SA Service State is neither Running nor Stopped, first check to see
whether there is a networking problem (ping the DocuSign SA IP address). If this is not the
problem, contact DocuSign technical support.
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New Users Do Not Receive Certificates

Problem: When you add new users to the system, DocuSign SA does not assign the users
certificates.

Solution: Verify that the number of users does not exceed the DocuSign SA license. To do this,
check the number of users currently defined in the database and the number of users allowed by
the license MiniKey token. Both numbers appear on the Display status page in the console (refer
to Displaying DocuSign SA Status).

If there are too many users defined in the Users OU, perform one of the following actions:

¢ Request a new license from DocuSign.
¢ Delete unnecessary users.
+ Move some of the users to another OU.

Then perform Sync with Directory from the DocuSign SA Administration MMC (refer to
Synchronizing DocuSign SA with the Directory Service).

If the number of users in the Users OU does not exceed the license, there may still be too many
users defined in the DocuSign SA database. Download the Event log. If this is the problem, the
message DocuSign Signature Appliance reach license limit, please upgrade
your DocuSign SA license appears. In this case, perform Sync with Active Directory from
the DocuSign SA Administration MMC.

Note: All users defined in the OU are counted toward the total number of users, including
special users such as IUSR*, guest, etc.

Another cause may be that a user tried to log in immediately after being added to the system,
before DocuSign SA updated its database. In this case, the user should log off and then log in
again.

Restore Appliance Fails

Problem: When you attempt to restore the appliance (refer to Restoring the DocuSign Signature
Appliance), the operation fails immediately after inserting the backup MiniKey token. In this case,
the failed to parse the backup header message appears in the Install log.

Solution: You may have inserted the wrong MiniKey token. Make sure that the MiniKey token
you insert is the same MiniKey token that was used during the installation process.

If the correct MiniKey token was inserted and the Restore Appliance operation still fails due to
MiniKey token hardware problems, try again using the second MiniKey token of the pair.
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Backup DocuSign SA Operation Fails

Problem: When attempting to back up the DocuSign Signature Appliance using the
getbackup.exe utility or the DocuSign Signature Appliance management console, the backup
process fails. The administrator has full administrative privileges on the MS Active Directory.

Cause 1: DocuSign SA administrative tasks can be performed only by a user who is himself a
member of the DocuSign SA administrators group (and not a member of a group that is member
of the DocuSign SA administrators group).

Solution 1: Check the name of the DocuSign SA administrators group on the DocuSign
Signature Appliance console and make sure you are yourself a member of that group.
It is also possible to use the DocuSign SA built-in administrator.

Cause 2: On the debug log you will see that the backup failed because it failed to copy the
DocuSign SA internal CA CRL file.

Solution 2: Perform a hardware restart.
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Appendix A: DocuSign SA Installation with
Reduced Privileges

This appendix describes how to perform DocuSign SA installation in an Active Directory
environment with reduced permissions.

Overview

When the DocuSign Signature Appliance is installed in an Active Directory environment, you must
login with an admin account and provide the installation wizard with both an admin account and a
password, to enable both the appliance installation and the appliance operation in the MS Active
Directory environment.

During installation, the administrative permissions enable the creation of new objects in the MS
Active Directory and updating of existing objects. Access to the administrative account is limited
to the installation phase, and is not required for the ongoing operation of DocuSign SA.

DocusSign Signature Appliance installation is performed using the DocuSign Signature Appliance
Management utility and is described in detail in Chapter 3: Installing DocuSign SA.

There are cases where the DocuSign Signature Appliance is installed in environments that do not
have global administrative permissions, for example, a department of a big organization.

In this type of organization, there are several administrators for the organization’s Active
Directory, with each administrator responsible for maintaining a department that is defined as a
specific OU (Organizational Unit) in the organization’s Active Directory. These administrators
have permissions only to manipulate objects in their department’s OU, but do not have permission
to update any objects outside that scope.

DocuSign SA Client enables administrators with restricted permissions to install the DocuSign
Signature Appliance. Additional operations must be performed in addition to the actual
installation, to provide a functionality similar to that of a privileged administrator performing an
installation.

Note: In some cases, an installation with reduced privileges reduces the functionality of
DocuSign SA.

This appendix describes the differences between a regular DocuSign SA installation and a
DocuSign SA installation with reduced privileges. It includes the following sections:

¢ Regqular DocuSign SA Installation — This section describes a regular DocuSign Signature
Appliance installation, with a focus on the Active Directory operations performed by the
installation, and the functional purpose of each Active Directory operation.

¢ DocuSign SA Installation with Reduced Privileges — This section describes the reduced
DocuSign Signature Appliance installation. It details the activities that must be carried out
to enable the functionality provided by the regular installation procedure.
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Note: You can switch to another administrative account if the current administrator fails
to perform an operation which accesses the Domain. The failed administrator is
prompted to supply an alternate administrator account.

This ability may resolve issues of reduced privileges.

For more information about this functionality, refer to Permission Considerations.

Regular DocuSign SA Installation

The following sections list all the operations carried out during DocuSign Signature Appliance
installation that require Enterprise admins or Domain admins permissions.

Creating a New Computer Account for the DocuSign Signature Appliance

The installation creates a new computer account for the DocuSign Signature Appliance if an
account does not yet exist. The installation also grants this account membership to Cert
publishers and to Pre-Windows 2000 Compatible Access.

Joining the DocuSign Signature Appliance to MS Domain

In order to install DocuSign SA in an Active Directory environment, the installation requires an
administration machine joined to the domain and logged in with a user who is a member of the
Enterprise admins and Domain admins groups.

Creating a Services Connection Point (SCP)

The installation creates an SCP object, which contains information (such as the DocuSign SA IP
address) that enables the DocuSign SA Clients to connect to the DocuSign Signature Appliance.
This object is located in Active Directory Sites and Services > Services > Net Services.

The DocuSign Signature Appliance computer account is granted read and write access rights so
that the DocuSign Signature Appliance can update SCP information.

DocuSign SA User Synchronization

During normal operation, the DocuSign Signature Appliance synchronizes periodically with the
domain by querying for new, updated, or deleted user objects. It may also update the user
certificate attribute of users for whom it had issued a certificate (refer to Updating the
userCertificate Attribute for Users below). To enable proper synchronization of users, read access
rights to the Deleted Objects container are granted to the DocuSign Signature Appliance to
enable querying the deleted user objects.

Updating the userCertificate Attribute for Users
DocuSign SA does not update the certificate attribute of a user by default.

If you wish to update the certificate attribute of a user in Active Directory with the certificate
content, you must grant write access rights to the userCertificate attribute for all users objects in
the users OU. This is achieved by assigning the DocuSign SA Computer to the Cert Publishers
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group as part of the installation procedure. To complete the process, you must change the value
of the User Certificate Publishing system parameter to True and perform a soft restart of the
DocuSign Signature Appliance.

DocuSign SA CA Root Certificate Information

AlA (Authority Information Access) and CA obijects that contain the DocuSign SA published
Certificate Authority root certificate are updated by the DocuSign Signature Appliance during
installation. This information automatically updates all machines in the domain, thereby providing
proper signature verification. The objects are located in Active Directory Sites and Services >
Services 2 Public Key Services 2> AlA, and Active Directory Sites and Services 2>
Services - Public Key Services > CA.

Read and write access rights are granted to the DocuSign Signature Appliance computer account
so that the appliance can publish and update CA objects.

DocuSign SA CA CDP (Certificate Distribution Point)

The DocuSign SA CA CDP (CRL Distribution Point) contains the updated DocuSign SA’s
published CRL (Certificate Revocation List). This object is located in Active Directory Sites and
Services > Services 2 Public Key Services - CDP.

Read and write access rights are granted to the DocuSign Signature Appliance computer account
so that the appliance can publish and update new CRLs.

DocuSign SA Installation with Reduced Privileges

During the DocuSign SA installation procedure, both the login administrative user and the
provided administrator account can have fewer privileges than domain admins and enterprise
admins. However, at the end of the data collection stage, a warning appears listing the operations
that failed during the creation of Active Directory objects, due to insufficient privileges. To restore
the reduced functionality, perform the following steps, as described in the following sections:

+ Add the DocuSign SA computer to the domain as a preliminary action to be taken before
installing with reduced privileges.
Install DocuSign SA in a reduced-privileges environment.

Complement the DocusSign SA installation with the DocuSign SA capabilities that were
described in Reqular DocuSign SA Installation.

Preliminary Action — Adding the DocuSign SA Computer to the Domain

Prior to running the DocuSign SA installation, add the DocuSign SA computer to the domain, as
follows:

+ Add a computer account to the Active Directory and set the name of the user who can join
this computer to the domain. The computer name field should be set according to the
DocuSign SA serial number (refer to Displaying DocuSign SA Status). For example,
CSNO00041.

¢ Set the user or group to a user or group that can join this computer to the domain.
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Note: The admin user provided during DocuSign SA installation should be the above
user or a user who is a member of the assigned group.

New Object - Computer 5[

HL Createin:  cosign3.com/Computers

Camputer name:
IcsnEIEIEI41

Computer name [pre-windows 2000]:
|cswnnn41

The following uzer or group can join thiz computer ta a domain,

Uzer or group:

IcasignS.camr’U sers/Domain Users

[~ dllow pre-windows 2000 computers to use this account

(1]8 Cancel

Figure 111 Adding the DocuSign SA Computer to the Domain

Installing DocuSign SA in a Reduced Privileges Environment

After adding the DocuSign SA computer to the domain, activate the DocuSign Signature
Appliance Management and install the DocuSign Signature Appliance according to the following
guidelines:

1. Inthe User Setup window provide the username and password for an account with
permission to join the DocuSign SA machine to the domain.

2. Inthe Directory Setup window set the DocuSign SA Container field with the full OU (or
container) path of the DocuSign SA computer account that was generated in the
preliminary stage.

3. Click Finish. A message appears listing the operations that failed during the creation of
Active Directory objects.

Note: The list of failed operations depends on the extent of the user’s privileges.
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Figure 112 Installation Failure Message
4. Click Yes to continue with the installation.

The installation will try to create/update objects in the Active Directory. Any object listed in the
above warning message will not be generated or updated.

Complementing the DocuSign SA Installation with Missing Capabilities

Once installation with reduced privileges is complete, you can complement it with the missing
capabilities. This section describes how to restore the DocuSign SA capabilities after installing
with reduced privileges.

Note: After you update any of the objects in the Active Directory, restart the DocuSign
Signature Appliance.

Joining the DocuSign Signature Appliance to the MS Domain

For DocuSign SA to work, it is mandatory that the user specified in the User Setup window has
permission to join the DocuSign Signature Appliance to the Domain.

Administrating DocuSign SA after the installation

To administrate DocuSign SA after the installation, use the DocuSign SA Configuration Utility
(described in Chapter 8: DocuSign SA Configuration Utility) to set the value of Admin—>
Administrator’s Group Name to the administrators groups of the division. For example, set the
value to be Division Admin Users. Alternatively, you can administrate DocuSign SA using the
DocuSign SA built-in administrator.
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Figure 113 Setting the Administrator’s Group Name

Creating a Services Connection Point (SCP)
Failure to create an SCP prevents the DocuSign Signature Appliance from publishing its binding

information, thus preventing DocuSign SA clients from locating the DocuSign Signature

Appliance. Once the DocuSign SA computer is granted access rights to the SCP, this functionality

is enabled.

If it is a problem to enable such access, it is still possible to manually set this information through

the DocuSign SA Client Configuration utility (refer to Distributing DocuSign SA Information
through the SCP). However, this option is limited for the following reasons:

+ The client is never updated with the current status of the DocuSign Signature Appliance
activity. This causes long delays when attempting to connect to an inactive appliance.

+ Any update of information, such as the DocuSign Signature Appliance’s IP address,

involves a manual update of all DocuSign SA clients.
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DocuSign SA User Synchronization

Failure to set read access rights to the Deleted Objects container causes synchronization
problems of deleted users from the Active Directory. Since deleted users are not recorded as
deleted, you can reach the DocuSign SA license limitation when the actual number of users is
well under the limitation.

You can take the following action:

¢ After any deletion of users from the Active Directory, perform a manual full synchronization
of the DocuSign Signature Appliance (refer to Synchronizing DocuSign SA with the
Directory Service).

Updating the userCertificate Attribute for Users

Failure to assign the DocuSign SA computer as a member of the Cert Publishers group causes
problems in setting the user’s certificate in the Active Directory. You can take any of the following
actions:

*

Manually assign the DocuSign SA computer as a member of the Cert Publishers group.
¢ Grant the DocuSign SA computer write access to the relevant users.

+ Publish the user certificate manually, or refrain from publishing users’ certificates.

+ Note that DocuSign SA does not update the certificate attribute of the user by default.

Appliance’s CA Root Certificate Information

Failure to create the AIA prevents the DocuSign SA server from automatically publishing its
ROOT certificate. Since the DocuSign SA ROOT CA must be part of the trusted Certificate
Authorities, you can take any of the following actions:

+ Distribute the root certificate manually or automatically using administrator tools. Refer to
Chapter 4: Deploying the DocuSign SA Client for more information.

¢ During the installation of the DocuSign Signature Appliance, you can define a different AIA
location (such as an HTTP location), or not specify any AlA location.

+ Create the AIA object in the Active Directory after the installation, and publish the root
certificate manually.

Appliance’s CA CDP (Certificate Distribution Point)

Failure to create a CDP prevents the DocuSign Signature Appliance from publishing its updated
CRL. This may cause signature or verification problems or delays since the updated CRL is not
located in its designated location. You can take any of the following actions:

¢ The DocuSign SA CRL expiration time can be set to expire several years in the future. By
setting the CRL once in the CDP, all applications that require CRLs will work properly.
Distribute the CRL manually or automatically using administrator tools.

During DocusSign Signature Appliance installation, you can define a different CDP location
(such as an HTTP based location), or specify that the CRL is not required.

+ Create this object in the Active Directory after the installation, and then either publish the
CRL manually, or grant the DocuSign Signature Appliance the proper rights to update this
object.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 250

Appendix B: Centralized DocuSign SA Client Installation

The DocuSign SA client can be centrally deployed in any environment, using various methods. Some
of the methods can be based on Microsoft Active Directory or alternative Microsoft tools or on third
party tools. It is essential to use such utilities in the case of large deployments.

This appendix describes one of the ways of deploying the DocuSign SA client in a large scale
organization using Microsoft SCCM (System Center Configuration Management).

Automatic Client Deployment using Microsoft SCCM

Microsoft SCCM (System Center Configuration Management) enables you to automatically perform
remote software installations. Using this feature, you can install the DocuSign SA client on all relevant
workstations without user intervention, resulting in a smooth deployment of the DocuSign SA system
in a large-scale organization.

For more information refer to the Microsoft documentation at http://www.microsoft.com/en-us/server-
cloud/products/system-center-2012-r2-configuration-manager/.

Automatic deployment in a Microsoft Active Directory can be performed as follows:

1. Place the contents of the DocuSign SA CD in a specific shared location in the domain, such as
a shared disk drive of the domain server or any other Microsoft-based file server in the
domain.

2. Define a Task Sequence in Microsoft SCCM. When the task sequence is advertised, the
relevant workstations will install the DocuSign SA client software.
For more information, refer to Defining and Advertising a DocuSign SA Client Task Sequence.

DocuSign SA Installation Components

The following table lists the components of the DocuSign SA Client installation, and their location in
the DocuSign SA CD. These files are used to define which DocuSign SA Client software packages
SCCM will install.

Some of the files differ depending on the intended operating system (32-bit or 64-bit).

Table 2 DocuSign SA Client Installation Components

Installation Files for 32-bit Installation Files for 64-bit Location
Operating Systems Operating Systems

ARX CoSign Client.msi ARX CoSign Client64.msi CDRom\MSI
ARX CryptoKit Basic.msi ARX CryptoKit Basic64.msi CDRom\CryptoKit
ARX Signature APl.msi ARX Signature AP164.msi CDRom\MSI

ARX CoSign Printer.exe(Optional) ARX CoSign Printer.exe(Optional) | CDRom\MSI

ARX Office Signatures.msi ARX Office Signatures64.msi CDRom\MSI
(Optional) (Optional)
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Defining and Advertising a DocuSign SA Client Task Sequence

This section describes in detail how to define a Microsoft SCCM Task Sequence for DocuSign SA
client installation, and how to advertise the Task Sequence so it performs automatic mass DocuSign
SA client installation in large scale DocuSign SA client deployments.

Step 1: Define DocuSign SA Packages
To define DocuSign SA packages:
1. Open the SCCM Configuration Manager Console.
2. Navigate to Software Library > Overview > Application Management > Packages.

3. Select Home > Create Package from Definition to add as software packages each of the
following software components (.MSI files) that you had placed in the shared location:
¢ ARX CoSign Client.msi
+ ARX Cryptokit Basic.msi
¢ ARX Signature APl.msi
+ ARX Office Signatures.msi (if required)
The full list of packages will look similar to the following:

(18] Folder Taols System Center Configuration Manager (Connected to 201 - techlab4)
- Home Folder
3 -] Y ~
|, - |l l‘ ! N ' 1
Create Create Package Import Saved
Package from Definition Searches ~
Create Search
(— v | |\ » Softwarelibrary » OCverview » Application Management » Packages » CoSign
Software Library < CoSign 3 items
4 :‘ﬁ Overview Search
4 || Application Management lcon Name Programs Manufacturer Wersion Language Package ID
=] Applications &l ARX CoSign Client ] Algorithmic Res... 80 English (Unite.. 20100007
4 [ Packages o] ARX CryptoKit 6 Algarithmic Res... 504 English (Unite... 20100009
"""" EoSigﬂ r_ﬂ ARX Signature API 6 Algarithmic Res... 80 English (Unite... 20100008

o Approval Requests
[ Global Conditions

#4 App-V Virtual Environments

Figure 114 Defining the DocuSign SA Packages
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Step 2: Create a Task Sequence
To create a task sequence:
1. Navigate to Software > Overview > Operating Systems > Task Sequences.

&' Folder Toals System Center Configuration Manager (Connected to 201 - techlab4)

_ Home Folder
ol T a » ™
34 B ¥ @2

Create Task  Create Task  Import Task Saved
Sequence Sequence Media Sequence Searches -
Create Search
(- — | % ¢ Softwarelibrary » Overview » Operating Systems »  Task Sequences
Software Library ¢ | Task Sequences 1 items
4 :,-ﬁ Overview Search
) v
4 || Application Management lcon Mame Description Package ID Cate Created
[&7] Applications E CoSign Client 8.0 20100004 8/2/2016 11:48 PM
- Packages
~| CaSign

Ig Approval Requests

[ Global Conditions
Figure 115 Task Sequences Window
2. Select Home > New custom task sequence. The New Task Sequence Wizard is launched.
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1]

Create Task Sequence Wizard

Create Mew Task Sequence

SELNDMERSESTRIE  Create a new task sequence

Task Sequence Informati

Summary
Progress

Completion

Atask sequence performs multiple steps or actions on a client computer at the command-ine level
without requiring user intervention. Select the type of task sequence to create. You can use the
task sequence editor to add steps to yourtask sequence.

Select a new task sequence to be created.
() Install an existing image package
() Build and capture a reference opersting system image

(® Create a new custom task sequence

Mext = || Summary || Cancel

Figure 116 New Task Sequence Wizard

Select Create a new custom task sequence.

Give the new task sequence a nhame. It is recommended to give it the same name as the

installed DocuSign SA Client version.
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Software Library ¢ Task Sequences 1 items
I ﬁ{)verview | Search
4[] Application Management lcan Name N Description Package ID Date Created
[£5] Applications ] CobSign Client 8.0 20100004 8/2/2016 11:48 PM
4 [l Packages
[ CoSign

Approval Requests
[ Global Conditions

Figure 117 Name of Task Sequence

5. Right-click the newly created Task Sequence and select Edit. The Task Sequence Editor
window appears.

Add - | Bemove |

Figure 118 Task Sequence Editor window
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6. Install the DocuSign SA Client as follows:

a. Select Add > Software > Install Package.

Add ~|| Remowve

MNew Group

General

CoSign Client8.0 Task Sequence Editor

| Software

Disks
User State
Images
Drivers

Settings

Install Application

Install Package

Install Software Updates

oK

b. Inthe Name field, enter a meaningful name for the software.

Figure 119 Selecting to Install Software

c. Click Browse to select the relevant package.

d. Verify that Per-system unattended is selected in the Program field.
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CoSign Client8.0 Task Sequence Editor [=[al x|

Add = | Remove Properties | Options
¥ Install Package Cliert Type: |In5ta|| Package |
Mame: ||nsta|| Package Cliert |
Description: -~
® Inztall 2 single software package
Select the software package to install
Package: | Algorithmic: Research Ltd. ARX CoSign Client 80 | Browse...
Program: | Per-system unattended W |
() Install software packages according to dynamic variable list
The ligt of software packages to install consists of a seres of task sequence variables with
a common base name plug a numeric suffic starting at 001. Each variable must contain a
package 1D and program name separated by a colon.
Base variable name:
ok || cancel || Aoy
Figure 120 Installing a Package as Software
e. Click Apply.

7. Install DocuSign CryptoKit as follows:

a.
b.

Navigate to Add > Software > Install Package.

In the Name field, enter a meaningful name for the software.
Click Browse to select the relevant package.

Verify that Per-system unattended is selected in the Program field
Click Apply.
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8. Install the DocuSign SA Signature API as follows:
a. Select Add > Software > Install Package.
b. Inthe Name field, enter a meaningful name for the software.
c. Click Browse to select the relevant package.
d. Verify that Per-system unattended is selected in the Program field.
e. Click Apply.
9. Optionally install the DocuSign SA Office Signatures as follows:
a. Select Add > Software > Install Package.
b. Inthe Name field, enter a meaningful name for the software.
c. Click Browse to select the relevant package.
d. Verify that Per-system unattended is selected in the Program field.
e. Click Apply.
10. Optionally install the DocuSign SA Printer as follows

a. Navigate to Add > General > Run Command Line.

221 Main Street, Suite 1000, San Francisco, CA 94105 | Tel. 866.219.4318 | www.docusign.com | © DocuSign, Inc.



DocuSign Signature Appliance Administrator Guide 258

CoSign Client 8.0 Task Sequence Editor = |0 -
Add -~ | Rernove 3 Properties | Options

ﬁ- Install Package Client Type: |H|.|n Tr—r |
¥ Install Package Ckit
;ﬁ- Install Package SAPI MName: |Hun Command Line PDF |
,ﬁ. Run Command Line PDF L
Description: ~
L

Command line:

“de-245MS_2071\Cosign* AR Cosign Printer exe /REGFle="%\dc- ~
25MS_201\Cosign " ARX¥CosignPrinter.reg”
JCOMPOMEMTS="program ghostscript images 2pdf helpfiles helpfiles®.

english languages languages*english” /DIR="C:Program Files"ARX*PDFCreator”
/Forcelnstall /VERYSILENT /NOICONS /NORESTART /Frintemame="ARX CaSign”

[ ] Disable E4-bit file system redirection

Start in: | | Browse. .

[ Package:

[] Time-out {minutes): 15

L4 by

[] Run this step as the following account

Agcount: |COSIGNTES T\Administrator

oK H — || Roply

Figure 121 Installing the DocuSign SA Printer
b. Inthe Name field, enter a meaningful name for the software.
c. Click Browse to select the relevant package.

d. Editthe file \\ {share}\ARXCosignPrinter.reg, where {share} is the location of
the shared disk. Save the edited file with a different name, such as
ARXCoSignPrinterl. regq.

e. Add the following three lines to the newly saved file:

"RunProgramAfterSavingProgramname"="C:\\Program Files\\ARX\\ARX
Signature API\\OmniSign.exe
"RunProgramAfterSavingProgramParameters"="\"<OutputFilename>\" /p"
"RunProgramAfterSaving"="1"
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Where the value of RunProgramAfterSavingProgramname is the actual location of the
OmniSign.exe executable.

f. Inthe Command line field enter the following text:

\\{share}\ARXCosignPrinter.exe
/REGFile="\\{share}\ARXCosignPrinter.reg"

/COMPONENTS="program, ghostscript, images2pdf, helpfiles, helpfiles\eng
lish, languages, languages\english" /DIR="C:\Program
Files\ARX\PDFCreator" /ForceInstall /VERYSILENT /NOICONS /NORESTART
/Printername="ARX CoSign" /LANG=english /TASKS=
/RESTARTEXITCODE=999

where {share} is the location of the shared disk.
g. Click Apply.
11. Click OK.

Step 3: Advertise the Task Sequence
To advertise the task sequence:
1. Navigate to Software > Overview > Operating Systems > Task Sequences.

2. Select the DocuSign SA Client task sequence and click the Deploy button from the home
menu.
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E# Deploy Software Wizard

gﬂ General

_General | Specify general information for this deployment

Deployment Settings
Scheduling

User Experience

Alerts Task sequence: |C05ign Cliert8.0 | | Browse... |

Distribution Points Collection: | |Q | Browse. .. |

Sumrmnary
Progress

Completion

Comments (optional):

e

Figure 122 New Advertisement Wizard

3. Give the new task advertisement a name. It is recommended to give it the same name as the
task.

Click Browse adjacent to the Task Sequence field to select the task sequence

Click Browse adjacent to the Collection field to specify on which workstations to install the
packages in the task sequence.

Click Next, and in the Schedule window set the date and time of the installation.

Click Next in all subsequent wizard windows, and click Finish in the final window.
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